
 

Oracle® Insurance Performance Application 
Pack
Installation Guide 

Release  8.0.0.0.0 

E59672-01

February 2015



Installation Guide, Release  8.0.0.0.0

E59672-01

Copyright © 2014, Oracle and/or its affiliates. All rights reserved.

Primary Author: Snigdha Thakuria

Contributing Author:  Mausumi Sahu, Bhanu Prashanthi Murthy, Usharani Shetty, Inayath Shariff, and Abhilash 
Sugunan

This software and related documentation are provided under a license agreement containing restrictions on use and 
disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or 
allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, 
perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or 
decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find 
any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of 
the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any 
programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial 
computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental 
regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any 
operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject 
to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not 
developed or intended for use in any inherently dangerous applications, including applications that may create a risk of 
personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all 
appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its 
affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their 
respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used 
under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, 
and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered 
trademark of The Open Group.

This software or hardware and documentation may provide access to or information on content, products, and services 
from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of 
any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be 
responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or 
services.



                                                                              iii 

Contents

Preface ................................................................................................................................................................    xiii

Summary .....................................................................................................................................................     xiii

Audience......................................................................................................................................................     xiii

Documentation Accessibility ......................................................................................................................     xiv

Related Documents .....................................................................................................................................     xiv

Conventions.................................................................................................................................................     xiv

Abbreviations ...............................................................................................................................................     xv

1 About OIPA Application Pack

About Oracle Financial Services Analytical Applications (OFSAA) ....................................................    1-1

About Oracle Financial Services Analytical Applications (OFSAA) Application Packs ....................    1-1

Introduction to OIPA Application............................................................................................................    1-2

About Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) .........................    1-2

Components of OFSAAI.......................................................................................................................    1-3

OFSAA Infrastructure High Availability..............................................................................................    1-3

2 Understanding OIPA Pack Installation

Installation Overview ................................................................................................................................    2-5

Logical Deployment Architecture.............................................................................................................    2-7

Hardware and Software Requirements....................................................................................................    2-7

Configurations supported for Java 7 .....................................................................................................    2-8

Configurations supported for Java 8 ...................................................................................................    2-10

Verifying the System Environment ........................................................................................................    2-12

Understanding the Installation Mode.....................................................................................................    2-12

GUI Mode ...........................................................................................................................................    2-12

Silent Mode .........................................................................................................................................    2-12

3 Preparing for Installation

Installer and Installation Prerequisites ..................................................................................................    3-13

Obtaining the software.............................................................................................................................    3-15

Common Installation Tasks.....................................................................................................................    3-15

Identifying the Installation Directory..................................................................................................    3-16

Configuration for GUI Mode Installation ...........................................................................................    3-16

Copying and Extracting the Software .................................................................................................    3-16

Setting Up the Web Application Server..............................................................................................    3-17



iv                                                                            

4 Installing OIPA Pack

Schema creator utility ..............................................................................................................................    4-19

Configuring and Executing the Schema Creator Utility ......................................................................    4-20

Prerequisites ........................................................................................................................................    4-20

Configuring the Schema Creator Utility .............................................................................................    4-21

Executing the Schema Creator Utility ...............................................................................................    4-25

Executing the Schema Creator Utility in Online Mode ...............................................................    4-26

Executing the Schema Creator Utility in Offline Mode ..............................................................    4-27

Executing the Schema Creator Utility in Silent Mode ................................................................    4-29

Executing the Schema Creator Utility while Installing Subsequent Application Pack ...............    4-30

Verifying the Log File.........................................................................................................................    4-32

Running OIPA application pack.............................................................................................................    4-32

Silent Mode Installation ......................................................................................................................    4-32

Configuring OFSAAI_InstallConfig.xml ....................................................................................    4-32

Running the installer in Silent Mod........................................................................................... e   4-38

Completing the installation in Silent Mode .................................................................................    4-38

GUI Mode Installation ........................................................................................................................    4-43

Verifying the Installation.........................................................................................................................    4-70

5 Post Installation Configuration

Configuring Resource Reference ............................................................................................................    5-71

Configuring Web Application Server.....................................................................................................    5-71

Creating and Deploying the Application Pack Web Archive...............................................................    5-71

Changing Batch Ownership ....................................................................................................................    5-72

Updating OBIEE URL.............................................................................................................................    5-73

Configurations for Java 8 ........................................................................................................................    5-73

6 Start and Stop of  Infrastructure Services

Starting Infrastructure Services .............................................................................................................    6-75

Stopping Infrastructure Services ............................................................................................................    6-76

7 Post Deployment Configuration

Deploying the Application .......................................................................................................................    7-79

Logging as System Administrator ..........................................................................................................    7-79

Creating Users ..........................................................................................................................................    7-79

Mapping User to User Group..................................................................................................................    7-81

8 OIPIGI Configuration

A Appendix

Configuring Web Server...........................................................................................................................    A-1

Configuring Web Application Servers ....................................................................................................    A-1

 Configuring WebSphere for Application Deployment .......................................................................    A-2

Creation of New Profile in WebSphere ........................................................................................    A-2

Manage Applications in WebSphere ............................................................................................    A-3



                                                                            v 

Delete WebSphere Profiles ...........................................................................................................    A-4

WebSphere HTTPS Configuration ...............................................................................................    A-4

WebSphere Memory Settings .......................................................................................................    A-5

Configuring WebLogic for  Application Deployment .........................................................................    A-5

Creating Domain in WebLogic Server .........................................................................................    A-5

Delete WebSphere Profiles ...........................................................................................................    A-7

WebSphere HTTPS Configuration ...............................................................................................    A-7

WebSphere Memory Settings .......................................................................................................    A-7

Delete Domain in WebLogic ........................................................................................................    A-7

WebLogic Memory Settings .........................................................................................................    A-8

Configuring WebLogic for  Application Deployment .........................................................................    A-8

Creating Domain in WebLogic Server .........................................................................................    A-8

Delete Domain in WebLogic ......................................................................................................    A-16

WebLogic Memory Settings .......................................................................................................    A-16

Configuring Apache Tomcat Server for Application Deployment ....................................................    A-17

Tomcat User Administration ......................................................................................................    A-17

Configure Tomcat to use JAVA 64 bit Executables...................................................................    A-17

Configure Servlet Port ................................................................................................................    A-18

Create Tomcat WAR Files..........................................................................................................    A-18

SSL Port Configuration ..............................................................................................................    A-19

Apache Tomcat Memory Settings ..............................................................................................    A-19

Uninstalling WAR Files in Tomcat ............................................................................................    A-19

Configuration for Axis API ........................................................................................................    A-21

B Appendix

Configuring Resource Reference in Web Application Servers ...........................................................    B-23

Configuring Resource Reference in WebSphere Application Server ................................................    B-23

Creating JDBC Provider .............................................................................................................    B-23

Creating Data Source ..................................................................................................................    B-26

J2C Authentication Details .........................................................................................................    B-30

JDBC Connection Pooling..........................................................................................................    B-31

Configuring Resource Reference in Weblogic Application Server ...................................................    B-31

Create Data Source .....................................................................................................................    B-32

Create GridLink Data Source .....................................................................................................    B-37

Configure Multi Data Sources ....................................................................................................    B-38

Advanced Settings for Data Source ............................................................................................    B-40

JDBC Connection Pooling..........................................................................................................    B-41

Configuring Resource Reference in Tomcat Application Server ......................................................    B-41

Create Data Source .....................................................................................................................    B-42

JDBC Connection Pooling..........................................................................................................    B-42

Class Loader Configuration for Apache Tomcat ...............................................................................    B-44

C Appendix

Creating EAR/WAR File ........................................................................................................................    C-45

Creating WebSphere EAR/WAR File................................................................................................    C-45

Creating WebLogic EAR/WAR File ................................................................................................    C-46



vi                                                                            

Creating Tomcat EAR/WAR File ......................................................................................................    C-47

Deploying EAR/WAR File......................................................................................................................    C-47

Deploying EAR/WAR Files on WebSphere...............................................................................    C-47

Deploying EAR/WAR files for WebLogic ........................................................................................    C-56

Deploying Tomcat WAR Files on Tomcat ........................................................................................    C-64

Additional Configurations ......................................................................................................................    C-66

FTP/SFTP Configuration for Excel/Document Upload.....................................................................    C-67

Configuration for Dimension and Hierarchy Management ...............................................................    C-67

Configure Member Deletion .......................................................................................................    C-67

Configure Attribute Default Date Format...................................................................................    C-68

Configure Members Reverse Population ....................................................................................    C-68

Configure Hierarchy Reverse Population ...................................................................................    C-68

Configure Maximum Levels allowed in Hierarchies..................................................................    C-68

Configure Node Limit for a Hierarchy Tree ...............................................................................    C-69

Configure Infrastructure Server Memory ..........................................................................................    C-69

Infrastructure Application Server Memory Settings...................................................................    C-69

Internet Explorer Settings ..................................................................................................................    C-69

Retrieve Patch Information ................................................................................................................    C-72

OLAP Data Server Configuration......................................................................................................    C-73

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance .........................................    C-73

OFSAAI Setup Information Fetching Tool .......................................................................................    C-73

Encryption Changer ...........................................................................................................................    C-73

Infrastructure LDAP Configuration ...................................................................................................    C-74

Configure Infrastructure "Configuration Schema" .....................................................................    C-74

Configure OpenLDAP Files .......................................................................................................    C-75

Migrate Data from CSSMS tables to LDAP server ....................................................................    C-76

Configure OFSAAI Web Services .....................................................................................................    C-77

Configure DynamicWSConfig.xml File .....................................................................................    C-77

web.xml Entries ..........................................................................................................................    C-80

Deploy OFSAAI Web Services .........................................................................................................    C-82

Configuration to Enable Parallel Execution of DML statements ......................................................    C-83

Configure Message Details in Forms Designer .................................................................................    C-83

Clearing Application Cache ...............................................................................................................    C-83

Changing the CONFIG/ ATOMIC Schema passwords .....................................................................    C-84

OFSAA Infrastructure Config Schema password modification .................................................    C-84

OFSAA Infrastructure Atomic Schema password modification ................................................    C-84

Configure Java Virtual Machine ........................................................................................................    C-85

Configure Internal Service (Document Upload/Download) ..............................................................    C-85

Installation Checklist ..............................................................................................................................    C-86

OFSAA Landing Page.............................................................................................................................    C-86

OFSAAI Login...................................................................................................................................    C-87

Activating/Enabling a Product within an Application .......................................................................    C-88

D  Appendix

Configuring OFS_IP_PACK.xml file ....................................................................................................    D-91



                                                                            vii 

E Appendix

OFS_IP_SCHEMA_IN.xml file ..............................................................................................................   E-93

F  Appendix

Mapview Configurations .......................................................................................................................    F-101

Prerequisites ......................................................................................................................................    F-101

Creating the Mapviewer NAVTEQ Data source ..............................................................................    F-101

Downloading the Mapviewer NAVTEQ Database Dump ........................................................    F-101

Creating NAVTEQ User............................................................................................................    F-102

Creating the NAVTEQ Schema........................................................................................................    F-102

Configuration Edits and Server Starting ...........................................................................................    F-103

MapViewerConfig.xml Edits (Optional ) ..................................................................................    F-103

Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps.......................................    F-104

G Appendix

Cloning OFSAA Instance .....................................................................................................................    G-107

H Appendix

Patching Your OFSAA Infrastructure Installation ...........................................................................    H-109

I Appendix

Grants for Atomic Schema ...................................................................................................................    A-111

Grants for Config Schema ....................................................................................................................    A-112

Grants for Config Schema Entities for Atomic Users........................................................................    A-112

J Appendix

Prerequisites ..........................................................................................................................................    B-119

Migration for Excel Upload..................................................................................................................    B-119

K Appendix

L Appendix

Prerequisites ..........................................................................................................................................    D-123

Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8 ............................................................    D-123

Web Application Server Configurations.............................................................................................    D-124

Oracle WebLogic Server Updates....................................................................................................    D-124

Apache Tomcat Server Updates.......................................................................................................    D-125

OFSAA Generic Configurations ..........................................................................................................    D-125

User .profile Settings........................................................................................................................    D-125

Configurations for Java 8.................................................................................................................    D-125

OFSAA Configurations for New Web Application Server Installation ...........................................    D-126



viii                                                                            

M Appendix

Frequently Asked Questions .................................................................................................................   E-127

OFSAAI FAQs..................................................................................................................................   E-127

Application Pack 8.0.0.0.0 FAQs .....................................................................................................   E-145

Forms Framework FAQs ..................................................................................................................   E-148

Error Dictionary.....................................................................................................................................   E-148

Accessing Error Dictionary...............................................................................................................   E-148

Error Code Dictionary.......................................................................................................................   E-149



                                                                                 ix 

List of Figures

1–1 OFSAA Applications Packs...........................................................................................................    1-2
1–2 Components of OFSAAI ...............................................................................................................    1-3
2–1 Installation Overview.....................................................................................................................    2-6
2–2 Logical Deployment Architecture .................................................................................................    2-7
4–1 Schema Creation ..........................................................................................................................    4-26
4–2 Schema Creation ..........................................................................................................................    4-27
4–3 OFSAAI License Agreement Page ..............................................................................................    4-40
4–4 Initialization Window ..................................................................................................................    4-44
4–5 License Agreement ......................................................................................................................    4-44
4–6 Application Pack Details ............................................................................................................    4-45
4–7 License Agreement page .............................................................................................................    4-45
4–8 Manage Information Domain page .............................................................................................    4-46
4–9 License Agreement Window .......................................................................................................    4-47
4–10 License Details Page....................................................................................................................    4-47
4–11 User Installation Directory...........................................................................................................    4-48
4–12 OFSAA Infrastructure Server Details..........................................................................................    4-48
4–13 Web Application Server...............................................................................................................    4-49
4–14 Absolute Tomcat Path..................................................................................................................    4-49
4–15 WebSphere Setup Details ............................................................................................................    4-50
4–16 Weblogic Home ...........................................................................................................................    4-50
4–17 Weblogic Setup Details ...............................................................................................................    4-51
4–18 OLAP Details...............................................................................................................................    4-51
4–19 Web Server Details ......................................................................................................................    4-52
4–20 Database Details ..........................................................................................................................    4-52
4–21 Ports Configuration......................................................................................................................    4-53
4–22 Ports Configuration......................................................................................................................    4-54
4–23 Default Infrastructure Administrator and Authorizer User Password .........................................    4-54
4–24 SFTP Details ................................................................................................................................    4-55
4–25 OFSAAI Post Install Details........................................................................................................    4-56
4–26 Sample Application Installation...................................................................................................    4-56
4–27 Pre Installation Summary ............................................................................................................    4-57
4–28 Installing OFSAA Infrastructure .................................................................................................    4-58
4–29 Installation Summary...................................................................................................................    4-58
4–30 Installation Complete ...................................................................................................................    4-59
4–31 Checking OFSAAI Services ........................................................................................................    4-59
4–32 Solution Setup Introduction Window ..........................................................................................    4-60
4–33 Log Mode Window......................................................................................................................    4-60
4–34 Segment Creation window...........................................................................................................    4-61
4–35 Pre-Infodom Creation Summary window....................................................................................    4-61
4–36 Infodom creation Window ...........................................................................................................    4-62
4–37 Model Upload Window ...............................................................................................................    4-62
4–38 Model Type Window ...................................................................................................................    4-63
4–39 Model Review Window ...............................................................................................................    4-63
4–40 Model Heap Memory Warning....................................................................................................    4-64
4–41 Model Upload Window ...............................................................................................................    4-65
4–42 Source Pair details .......................................................................................................................    4-65
4–43 Staging Details Window ..............................................................................................................    4-66
4–44 Staging creation Window.............................................................................................................    4-66
4–45 Installation Details Review Window ...........................................................................................    4-67
4–46 Confirmation Window .................................................................................................................    4-67
4–47 Installation Progress Window......................................................................................................    4-68
4–48 Installation Completion Window.................................................................................................    4-68
4–49 Installation Summary Window ....................................................................................................    4-69
4–50 Installation Complete Window ....................................................................................................    4-69



x                                                                                            

4–51 Installation Complete ...................................................................................................................    4-70
8–1 Integrated Solutions Console Login .............................................................................................    A-3
8–2 Enterprise Applications.................................................................................................................    A-4
8–3 Welcome .......................................................................................................................................    A-6
8–4 Enterprise Applications.................................................................................................................    A-6
8–5 Welcome .......................................................................................................................................    A-9
8–6 Select Domain Source.................................................................................................................    A-10
8–7 Specify Domain Name and Location..........................................................................................    A-10
8–8 Configure Administrator Username and Password ....................................................................    A-11
8–9 Configure Server Start Mode and JDK.......................................................................................    A-12
8–10 Select Optional Configuration ....................................................................................................    A-13
8–11 Configure the Administration Server..........................................................................................    A-14
8–12 Configure Server Start Mode and JDK.......................................................................................    A-15
8–13 Configure Server Start Mode and JDK.......................................................................................    A-16
A–1 Tomcat Web Application Manager.............................................................................................    A-21
8–14 JDBC Providers ..........................................................................................................................    B-24
8–15 Create a new JDBC Provider ......................................................................................................    B-24
8–16 Enter database class path information ........................................................................................    B-25
8–17 Summary .....................................................................................................................................    B-26
8–18 Data Sources ...............................................................................................................................    B-27
8–19 Create a data source ...................................................................................................................    B-27
8–20 Select JDBC provider .................................................................................................................    B-28
8–21 Enter database specific properties...............................................................................................    B-28
8–22 Setup security aliases ..................................................................................................................    B-29
8–23 Summary.....................................................................................................................................    B-29
8–24 JAAS- J2C authentication data- New .........................................................................................    B-30
B–1 Connection pools ........................................................................................................................    B-31
8–25 Welcome ......................................................................................................................................    B-32
8–26 Summary of JDBC Data Sources................................................................................................    B-33
8–27 Create a New JDBC Data Source ...............................................................................................    B-33
8–28 JDBC Data Source Properties.....................................................................................................    B-34
8–29 Transaction Options ....................................................................................................................    B-34
8–30 Connection Properties.................................................................................................................    B-35
8–31 Test Database Connection ..........................................................................................................    B-36
8–32 Select Targets..............................................................................................................................    B-37
8–33 Create a New JDBC GridLinkData Source ................................................................................    B-37
8–34 JDBC GridLinkData Source- Connection Properties .................................................................    B-38
8–35 Summary of JDBC Multi Data Sources......................................................................................    B-39
8–36 Configure the  Multi Data Source...............................................................................................    B-39
8–37 Select Targets..............................................................................................................................    B-40
8–38 Select Data Source Type.............................................................................................................    B-40
8–39 Add Data Sources .......................................................................................................................    B-40
8–40 Settings for <Data Source Name> ..............................................................................................    B-41
C–1 Creating EAR/ WAR File ...........................................................................................................    C-46
8–41 Login Window .............................................................................................................................    C-48
8–42 New Application..........................................................................................................................    C-49
8–43 Preparing for the application installation ..................................................................................    C-49
8–44 Installation Options ....................................................................................................................    C-50
8–45 Install New Application ..............................................................................................................    C-51
8–46 Map Modules to Servers .............................................................................................................    C-52
8–47 Map Resource References to Resources .....................................................................................    C-53
8–48 Map Virtual host for Web Modules.............................................................................................    C-54
8–49 Summary .....................................................................................................................................    C-55
8–50 Enterprise Applications ..............................................................................................................    C-56
8–51 Summary of Deployments ...........................................................................................................    C-57



                                                                                 xi 

8–52 Install Application Assistant .......................................................................................................    C-59
8–53 Install Application Assistant .......................................................................................................    C-59
8–54 Optional Settings.........................................................................................................................    C-60
8–55 Deployment Summary .................................................................................................................    C-61
8–56 Settings for <Deployment Name> ..............................................................................................    C-62
8–57 Summary of Deployments ...........................................................................................................    C-63
8–58 Summary of Deployments ...........................................................................................................    C-64
8–59 Tomcat home ...............................................................................................................................    C-65
8–60 Tomcat Web Application Manager.............................................................................................    C-66
C–2 Internet Options ..........................................................................................................................    C-70
C–3 Internet Options ..........................................................................................................................    C-71
C–4 Internet Options- Popup Blocker Settings ..................................................................................    C-72
8–61 Select Source & Destination for Migration ................................................................................    C-76
8–62 Select Entities to Migrate............................................................................................................    C-77
C–5 OFSAA Landing Page ................................................................................................................    C-86
C–6 OFSAAI Login Page...................................................................................................................    C-87
C–7 OFSAAI Login Page...................................................................................................................    C-88
8–63 Error Dictionary ........................................................................................................................   E-149



xii                                                                                              

List of Tables

0–1 .....................................................................................................................................................    2-xv
0–2 Abbreviations and their meaning .................................................................................................    2-xv
2–1  Configurations Supported for Java 7 ............................................................................................    2-8
2–2  Configurations Supported for Java 8 ..........................................................................................    2-10
2–3 Recommended Software Combinations.......................................................................................    2-12
3–1  Prerequisite Information .............................................................................................................    3-14
4–1  Prerequisite Information .............................................................................................................    4-21
4–2  Prerequisite Information .............................................................................................................    4-33
4–3 Silent Installation Information .....................................................................................................    4-37
4–4  Webserver start up options .........................................................................................................    4-38
4–5  Webserver start up options .........................................................................................................    4-39
4–6  Webserver start up options .........................................................................................................    4-40
6–1  Webserver start up options .........................................................................................................    6-76
7–1  Prerequisite Information .............................................................................................................    7-80
B–1 Fields and their description.........................................................................................................    B-25
C–1  Member Deletion Configuration................................................................................................    C-68
C–2  Attribute Default Date Format ...................................................................................................    C-68
C–3  Members Reverse population ....................................................................................................    C-68
C–4  Hierarchy Reverse population ...................................................................................................    C-68
C–5  Hierarchy Maximum level allowed ...........................................................................................    C-68
C–6  Hierarchy Tree node limit..........................................................................................................    C-69
C–7  Configuration Schema ...............................................................................................................    C-74
C–8  WEBSERVICE tag ....................................................................................................................    C-78
C–9  OPERSTION tag........................................................................................................................    C-79
C–10   INPUT tag.................................................................................................................................    C-79
C–11  OUTPUT tag..............................................................................................................................    C-80
C–12  NotificationConfig.cfg File........................................................................................................    C-83
C–13  General, Pre-Install, Install, and Post Install) Checklist ............................................................    C-86
D–1 OFS_IP_PACK.XML Parameters ..............................................................................................    D-91
E–1 OFS_IP_SCHEMA_IN.xml parameters ......................................................................................   E-93
F–1 DIM_LOCATION .....................................................................................................................    F-105
F–2 FSI_LOCATION_MAP_COORD.............................................................................................    F-105
K–1 JDBC Jar files version details ...................................................................................................    C-121
M–1 Optimized Memory Settings for New Model Upload ...............................................................   E-139



                                                                          xiii

Preface

This Preface provides supporting information for the Oracle Insurance Performance 
Application Pack (OIPA) Installation Guide and includes the following topics:

•     Summary

•     Audience

•     Documentation Accessibility

•     Related Documents

•     Conventions

•     Abbreviations

Summary
You can find the latest copy of this document in OTN library which includes all the recent 
additions/revisions (if any) done till date.

Before you begin the installation, ensure that you have an access to the Oracle Support Portal 
with the required login credentials to quickly notify us of any issues at any stage. You can 
obtain the login credentials by contacting Oracle Support.

Audience
Oracle Insurance Performance Pack Installation Guide is intended for administrators, and 
implementation consultants who are responsible for installing and maintaining the application 
pack components. 

Prerequisites for the Audience
Following are the expected preparations from the administrator before starting the actual 
installation:

The document assumes that you have experience in installing Enterprise components and basic 
knowledge about the following are recommended:

•     Oracle Insurance Performance pack components

•     OFSAA Architecture

•     UNIX Commands

•     Database Concepts
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•     Web Server/Web Application Server

Note:

The Insurance Pack installer download contains a primary ERwin XML file that is 
required for uploading the model. This file is sufficient to install the v8.0.0.0.0 
product. However, this XML file cannot be opened in ERwin Data modeler tool and 
hence cannot be used for any data model customization. This ERwin file is delivered 
as a patch and need to be downloaded separately. This ERwin file should be used for 
any customization of the data model. 

Reference bug/patch where the primary ERwin file can be downloaded is Bug 
19438459 - Oracle Insurance Pack 8.0.0.0.0 Data Model

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
This section identifies additional documents related to OIPA. You can access Oracle 
documentation online from the Documentation Library for Oracle Performance Insight for 
General Insurance (OTN).

OFSAA Related Documents

•     Oracle Financial Services Advanced Analytical Applications Infrastructure Application 
Pack Installation and Configuration Guide

•     Oracle Financial Services Analytical Applications Infrastructure Environment Check 
Utility Guide

•     Oracle Financial Services Analytical Applications Infrastructure Administration Guide

•     Oracle Financial Services Analytical Applications Infrastructure User Guide

For more information, see the following documents in Oracle Insurance Performance Pack 8.0 
documentation set:

•     Oracle Insurance Performance Insight for General Insight Release 8.0.0.0.0 User Guide

•     Oracle Insurance Performance Insight for General Insight 8.0.0.0.0 Release Notes

The following document is available in My Oracle Support (MOS) and you should have SSO 
credentials to access MOS.

•     Oracle Financial Services Analytical Applications Infrastructure Security Guide

Conventions
The following text conventions are used in this document:

http://docs.oracle.com/cd/E60593_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables 
for which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, 
code in examples, text that appears on the screen, or text that you 
enter.
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Abbreviations
The following table lists the abbreviations used in this document:

Table 0–2 Abbreviations and their meaning

Abbreviation Meaning

IP Insurance Performance

GUI Graphical User Interface

HTTPS Hypertext Transfer Protocol Secure

J2C J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

LDAP Lightweight Directory Access Protocol

LHS Left Hand Side

MOS My Oracle Support

OFSAA Oracle Financial Services Analytical Application 

OFSAAI Oracle Financial Services Analytical Application Infrastructure

OLAP On-Line Analytical Processing

OS Operating System

SFTP Secure File Transfer Protocol

URL Uniform Resource Locator

Web Archive WAR

XML Extensible Markup Language
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1About OIPA Application Pack

This chapter provides complete details about Oracle Insurance Performance Application 
(OIPA) pack.

This chapter includes the following topics:

•     About Oracle Financial Services Analytical Applications (OFSAA)

•     About Oracle Financial Services Analytical Applications (OFSAA) Application Packs

•     Introduction to OIPA Application

•     About Oracle Financial Services Analytical Applications Infrastructure (OFSAAI)

About Oracle Financial Services Analytical Applications (OFSAA)
In today's turbulent markets, financial institutions require a better understanding of their 
risk-return, while strengthening competitive advantage and enhancing long-term customer 
value. Oracle Financial Services Analytical Applications (OFSAA) enable financial institutions 
to measure and meet risk adjusted performance objectives, cultivate a risk management culture 
through transparency, lower the costs of compliance and regulation, and improve insight into 
customer behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications 
architecture to enable integrated risk management, performance management, customer insight, 
and compliance management. OFSAA actively incorporates risk into decision making, enables 
to achieve a consistent view of performance, promote a transparent risk management culture, 
and provide pervasive intelligence.

With the help of OFSAA, the financial services organizations can achieve, management 
excellence with a lower total cost of ownership, due to our integrated, architecture, combining 
performance and risk applications into a single, seamlessly integrated framework.

OFSAA delivers a comprehensive and integrated suite of financial services analytical 
applications for both banking and insurance domain. 

About Oracle Financial Services Analytical Applications (OFSAA) 
Application Packs

The following figure depicts the various application packs that are available across the OFSAA 
Banking and Insurance domains:
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Figure 1–1 OFSAA Applications Packs

Introduction to OIPA Application
This application is a comprehensive business intelligence system created exclusively for the 
General Insurance/Property and Casualty (P&C) insurance industry. OIPIGI provides a 
complete set of Web-based analytical and reporting components that enable users to generate, 
view, analyze, distribute, electronically store and retrieve critical reports. It provides tools for 
data integration and includes customizable, pre-built dashboards and reports, a reporting data 
model, and user friendly functional subject areas for ad-hoc reporting. It enables you to actively 
plan, manage, and track key areas measuring organizational performance with pre-built reports, 
dashboards, and underlying data structures.

About Oracle Financial Services Analytical Applications 
Infrastructure (OFSAAI)

Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) powers the Oracle 
Financial Services Analytical Applications family of products to perform the processing, 
categorizing, selection and manipulation of data and information needed to analyze, understand 
and report on specific performance, risk, compliance and customer insight issues by providing a 
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strong foundation for the entire family of Oracle Financial Services Analytical Applications 
across the domains of Risk, Performance, Compliance, and Customer Insight.

Components of OFSAAI
The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the 
Oracle Financial Services Analytical Applications Data Model and form the array of 
components within the Infrastructure. 

The OFSAA Infrastructure components/frameworks are installed in two layers: primarily the 
metadata server and Infrastructure services run on one layer, and the UI and presentation logic 
runs on the other. The UI and presentation layer is deployed on any of the supported J2EE 
Servers.

The following figure depicts the various frameworks and capabilities that make up the OFSAA 
Infrastructure:

Figure 1–2 Components of OFSAAI

OFSAA Infrastructure High Availability
The current release of the OFSAA Infrastructure supports only "Single Instance" installation for 
the Infrastructure components. However, the High Availability (HA) for the Database Server 
and the Web Application Server clustering and deployment are supported in this release.
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2Understanding OIPA Pack Installation

This chapter includes the following topics:

•     Installation Overview

•     Logical Deployment Architecture

•     Hardware and Software Requirements

•     Verifying the System Environment

•     Understanding the Installation Mode

Installation Overview 
This section gives an overview of the OIPA Pack Installation. Figure 2–1 shows the order of 
procedures you will need to follow: 
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Figure 2–1 Installation Overview

 The following list provide additional information and links to specific documentation for each 
task in the flowchart.

•     Verify System Environment: This section provides details to verify that your system 
meets the minimum necessary requirements for installing and hosting the IP Application 
Pack. For more information, see Hardware and Software Requirements" and "Verifying the 
System Environment.

•     Obtain the Software: This section provides details about obtaining the software. For more 
information, see Obtaining the software.

•     Configure and Execute the Schema Creator Utility: This section provides details about 
configuring and executing the schema creator utility. For more information, see Configuring 
and Executing the Schema Creator Utility.

•     Install OIPA Pack: This section provides details about installing the OIPA Pack Installer. 
For more information, see Running OIPA application pack.

•     Verify Installation: This section provides details about verifying the installation. For more 
information, see Verifying the Installation.

•     Configure OIPA Pack: This section provides details about post installation configuration. 
For more information, see Post Installation Configuration.
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Logical Deployment Architecture
The deployment architecture depicts the mapping of a logical architecture to a physical 
environment. 

The physical environment includes the computing nodes in an intranet or Internet environment, 
CPUs, memory, storage devices, and other hardware and network devices.

Figure 2–2 Logical Deployment Architecture

Hardware and Software Requirements
This section describes the various Operating Systems, Database, Web Server, and Web 
Application Server versions, and other variant details on which this release of the OIPA 
Application Pack has been qualified. 

Note:

OIPA Application Pack installation can be performed on both Virtual and Physical 
servers.
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Configurations supported for Java 7
The following table shows the minimum hardware and software requirements for installing 
OIPA Application Pack (Java 7).

Table 2–1  Configurations Supported for Java 7

Operating System

Oracle Linux / Red Hat 
Enterprise Linux (x86-64)

•     Oracle Linux Server release 5.3 up to 5.10 - 64 bit

•     Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL is supported

Oracle Solaris(SPARC)/ 
Solaris x86

•     Oracle Solaris v5.10 Update 11 and above - 64 bit

•     Oracle Solaris v5.11 update 1 and above - 64 bit

IBM AIX (POWERPC) •     AIX 6.1 (TL 09 and above) - 64 bit

Shell •     KORN Shell (KSH)

Note : 

•     If the OS is IBM AIX 6.1, configure the size parameter setting for "Large File Support". Refer link 
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290 for more details.

•     If the operating system is RHEL, install the package lsb_release using one of the following 
commands by logging in as root user:

•     yum install redhat-lsb-core

•     yum install redhat-lsb

Java Runtime Environment

Oracle Linux / Red Hat 
Enterprise Linux

Oracle Solaris

•     Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit

IBM AIX •     IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit

Oracle Database Server and Client

•     Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC 
with/ without partitioning option

•     Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC 
with/ without partitioning option

•     Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

•     Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

•     Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

•     Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

•      Oracle Distribution of R version 2.15.1, 2.15.2 or 2.15.3.(Optional)

•     Oracle R Enterprise (Server) version 1.4. (Optional)

Note:

Ensure that the following patches are applied:

•     Oracle Server 12c,  v12.1.0.1 – 17082699

•     Oracle Server 12c,  v12.1.0.2 - 19392604, 19649591

•     Also for latest information, refer http://support.oracle.com/ ,  12.1.0.2 Bundle Patches for 
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

•     Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 12.1.0.1

OLAP

http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
http://support.oracle.com/
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Oracle Hyperion Essbase •     V 11.1.2.1+ (Server and Client) with Oracle 11g Database

•     V 11.1.2.3+ (Server and Client) with Oracle 12c Database

Oracle OLAP •     V 11.2.0.3+ with Oracle 11g Database

•     V 12.1.0.1+ with Oracle 12c Database

Note:

•     Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of 
OFSAAI. For Oracle OLAP, ensure that you have configured the Oracle Database server with 
OLAP option.

Web Server/ Web Application Server

Oracle Linux / Red Hat 
Enterprise Linux 

Oracle Solaris

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM HTTP 
Server

Oracle 11g Database:

•     Oracle WebLogic Server 12.1.2+ (64 bit)

•     IBM WebSphere Application Server 8.5+  with bundled IBM Java 
Runtime (64 bit)

•     Apache Tomcat 8.0.x (64 bit)

Oracle 12c Database:

•     Oracle WebLogic Server 12.1.2+ (64 bit)

•     IBM WebSphere Application Server 8.5+ with IBM Java Runtime 
(64 bit)

•     Apache Tomcat 8.0.x (64 bit)

Note: IBM WebSphere 8.5.x (Full Profile)  on Java 8 is not available.

Note:

•     OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit 
is not supported.

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1

Browser MS Internet Explorer  9, 10 (Compatibility Mode) and 11 
(Compatibility Mode)

Oracle Java plug-in 1.7.0+* (64-bit)

Turn off Pop-up blocker settings. For more information, see Internet 
Explorer Settings.

Office Tools •     MS Office 2007/2010/2013 

•     Adobe Acrobat Reader 10 and 11

Screen Resolution 1024*768 or 1280*1024

Other Software

Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and Oracle 
Internet Directory v 11.1.1.3.0. However, it can be integrated with 
other directory services software like MS Active Directory.

Note:

•     Configuration of Directory services software  for OFSAAI installation is optional. For more 
information on configuration, see Appendix C. 

•     Open LDAP needs to be installed on MS Windows Server machine only.

Table 2–1 (Cont.) Configurations Supported for Java 7
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Configurations supported for Java 8
The following table shows the minimum hardware and software requirements for installing 
OIPA Application Pack (Java 8):

Table 2–2  Configurations Supported for Java 8

Operating System

Oracle Linux / Red Hat 
Enterprise Linux (x86-64)

•     Oracle Linux Server release 5.3 up to 5.10 - 64 bit

•     Oracle Linux Server release 6.0 and above - 64 bit

Note: Same versions of RHEL is supported

Oracle Solaris(SPARC)/ 
Solaris x86

•     Oracle Solaris v5.10 Update 11 and above - 64 bit

•     Oracle Solaris v5.11 update 1 and above - 64 bit

IBM AIX (POWERPC) •     AIX 6.1 (TL 09 and above) - 64 bit

Shell •     KORN Shell (KSH)

Note : 

•     If the OS is IBM AIX 6.1, configure the size parameter setting for "Large File Support". Refer link 
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290 for more details.

•     If the operating system is RHEL, install the package lsb_release using one of the following 
commands by logging in as root user:

•     yum install redhat-lsb-core

•     yum install redhat-lsb

Java Runtime Environment

Oracle Linux / Red Hat 
Enterprise Linux

Oracle Solaris

•     Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit

IBM AIX •     IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit

Oracle Database Server and Client

•     Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC 
with/ without partitioning option

•     Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC 
with/ without partitioning option

•     Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

•     Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

•     Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

•     Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

•      Oracle Distribution of R version 2.15.1, 2.15.2 or 2.15.3.(Optional)

•     Oracle R Enterprise (Server) version 1.4. (Optional)

Note:

Ensure that the following patches are applied:

•     Oracle Server 12c,  v12.1.0.1 – 17082699

•     Oracle Server 12c,  v12.1.0.2 - 19392604, 19649591

•     Also for latest information, refer http://support.oracle.com/ ,  12.1.0.2 Bundle Patches for 
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

•     Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 12.1.0.1

OLAP

http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
http://support.oracle.com/
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OIPA Pack recommends the following software combinations for deployment:

Oracle Hyperion Essbase •     V 11.1.2.1+ (Server and Client) with Oracle 11g Database

•     V 11.1.2.3+ (Server and Client) with Oracle 12c Database

Oracle OLAP •     V 11.2.0.3+ with Oracle 11g Database

•     V 12.1.0.1+ with Oracle 12c Database

Note:

•     Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of 
OFSAAI. For Oracle OLAP, ensure that you have configured the Oracle Database server with 
OLAP option.

Web Server/ Web Application Server

Oracle Linux / Red Hat 
Enterprise Linux / IBM AIX

Oracle Solaris

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM HTTP 
Server

•     Oracle WebLogic Server 12.1.3+ (64 bit)

•     Apache Tomcat 8.0.x (64 bit)

Note: 

IBM JAVA8 SDK does not support  WebSphere full profile.

Note:

•     OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit 
is not supported.

•     For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install 
patch 18729264 from http://support.oracle.com/. 

Desktop Requirements

Operating System MS Windows 7/ Windows 8/ Windows 8.1

Browser •     MS Internet Explorer  9 , 10(Compatibility Mode) and 11 
(Compatibility Mode)

•     Oracle Java plug-in 1.7.0+*(64-bit)

Office Tools •     MS Office 2007/2010/2013 

•     Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280*1024

Other Software

Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and Oracle 
Internet Directory v 11.1.1.3.0. However, it can be integrated with 
other directory services software like MS Active Directory.

Note:

•     Configuration of Directory services software  for OFSAAI installation is optional. For more 
information on configuration, see Appendix D. 

•     Open LDAP needs to be installed on MS Windows Server machine only.

Note: If you wish to upgrade an existing OFSAA 8.0.x Java 7 instance to 
Java 8, see Appendix L

Table 2–2 (Cont.) Configurations Supported for Java 8

http://support.oracle.com/


Table 2–3 Recommended Software Combinations

Operating System Database Web Application Server Web Server

Oracle Linux 5.3 up 
to 5.10/ 6.0 and 
above 

Oracle Database Oracle WebLogic Server 
/Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

Oracle Solaris 5.10/ 
5.11

Oracle Database Oracle WebLogic Server 
/Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

IBM AIX 6.1 Oracle Database IBM WebSphere 
Application Server 
/Apache Tomcat Server

IBM HTTP Server/ 
Apache HTTP Server

Verifying the System Environment
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Verifying the System Environment
To verify that your system environment meets the minimum requirements for the installation, a 
Pre-Install Check utility is available within the Install Kit archive file. This utility can also be 
obtained separately by contacting Oracle Support.

Though the system environment verification is an integral and automated part of the installation 
of this software product, Oracle strongly recommends running this utility prior to beginning the 
installation as part of your organization's "Installation Readiness Verification Process".

Note:

For more details on download and usage of this utility, see Oracle Financial Services 
Analytical Applications Infrastructure Environment Check Utility Guide given in the 
Related Documents section.

Understanding the Installation Mode
The following modes of installation are available for the IP Application Pack.

•     GUI Mode

•     Silent Mode

GUI Mode
This mode launches the product installation in a Graphical User Interface (GUI) mode. Users 
need to enter the required information on various panels within the UI in a user interaction 
format at various stages.

Silent Mode
This mode mandates updating the installation configuration files with required details and 
performs installation in a "Silent" non user interactive format.
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3Preparing for Installation

This chapter provides necessary information to review before installing the Oracle  Insurance 
Performance Application (OIPA) Pack v8.0.0.0.0.

This chapter includes the following topics:

•     Installer and Installation Prerequisites

•     Obtaining the software

•     Common Installation Tasks

Installer and Installation Prerequisites
Table 3–1 mentions the list of prerequisites required before beginning the installation for IP 
application. The Pre-Check utility notifies you if any requirements are not met.
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Table 3–1  Prerequisite Information

Category Sub-Category Expected Value

Environment 
Settings

Java Settings •     PATH in .profile to be set to include the Java 
Runtime Environment absolute path. The path 
should include java version (java 6, java 7 or java 8) 
based on the configuration.

Note:

•      Ens ure the absolute path to JRE/bin is set at the 
beginning of PATH variable.

•     For example, PATH=/usr/java/jre1.6/bin:$ORACLE_
HOME/bin:$PATH 

•     Ensure no SYMBOLIC links to JAVA installation is 
being set in the PATH variable.

Oracle Database 
Settings

•     TNS_ADMIN to be set in .profile pointing to 
appropriate tnsnames.ora file

•     ORACLE_HOME to be set in .profile pointing to 
appropriate Oracle Client installation

•     PATH in .profile to be set to include appropriate 
$ORACLE_HOME/bin path

•     Ensure to add an entry (with SID/ SERVICE NAME) 
in the tnsnames.ora file on the OFSAA server.

Oracle Essbase 
Settings

•     ARBORPATH, ESSBASEPATH, HYPERION_
HOME to be set in the .profile pointing to an 
appropriate Oracle Essbase Client installation.

Note: 

These settings are required only if you want to use Oracle 
Hyperion Essbase OLAP features.

OS/ File System 
Settings

File Descriptor 
Settings

•     Greater than 15000

Total Number of 
Process Settings

•     Greater than 4096

Port Settings •     Default port numbers to be enabled on the system are 
6500, 6501, 6505, 6507, 6509, 6510, 6666, 9999, 
and 10101.

.profile 
permissions

•     User to have 755 permission on the .profile file.

Installation 
Directory

•     A directory where the installation files will be 
installed.

•     Set 755 permission on this directory. 

•     This directory needs to be set as FIC_HOME.

Staging Area/ 
Metadata Repository

•     A directory to hold the application metadata artifacts 
and additionally act as staging area for flat files. 

•     The directory should exist on the same system as the 
OFSAA Installation. This directory can be 
configured on different mount or under a different 
user profile.

•     Set 777 permission on this directory.

Download Directory •     A directory where the product installer files will be 
downloaded/ copied.

•     Set 755 permission on this directory.
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Obtaining the software
This release of IP Application Pack v8.0.0.0.0 can be downloaded from the Oracle Software 
Delivery Cloud (https://edelivery.oracle.com). You need to have a valid Oracle account 
in order to download the software.

Common Installation Tasks
The following are the common pre-installation activities that you need to carry out before 
installing the IP application pack.

This section includes the following topics:

•     Identifying the Installation Directory

Database Settings Database Instance 
Settings

•     NLS_CHARACTERSET to be AL32UTF8

•     NLS_LENGTH_SEMANTICS to be BYTE

•     OPEN CURSORS limit to be greater than 1000

Web Application 
Server

WebSphere/ 
WebLogic/ Tomcat

•     Web Application Server should be installed and 
profile /domain created.

•     You will be prompted to enter the WebSphere Profile 
path or WebLogic Domain path or Tomcat 
Deployment path during OFSAAI installation.

Note: 

•     Refer Appendix A for WebSphere Profile Creation 
and WebLogic Domain Creation.

•     For deployment on Oracle WebLogic Server 12.1.3+ 
(64 bit) with Java 8, download and install patch 
18729264 from http://support.oracle.com/.

Web Server Apache HTTP 
Server/ Oracle 
HTTP Server/

IBM HTTP Server

.

This is an optional requirement. HTTP Server Installation 
to be present. You will be required to enter the Web 
Server IP/Hostname and Port details during installation.

Note: Refer Appendix A for Web Server installation.

Others OFSAA •     For installation on Java 8, login to  
https://support.oracle.com/ and search for 21160684 
under the Patches & Updates tab. This is applicable 
only when you have installed 8.0.0.0.0 OFSAAI 
pack and not required for 8.0.0.1.0.

•     For installation of this release on an existing OFSAA 
instance version 8.0.1.0.0, login to 
https://support.oracle.com/ and search for 21133780  
under the Patches and Updates tab.

•     For installation of this release on an existing OFSAA 
instance version 8.0.2.0.0, login to 
https://support.oracle.com/  and search for 21657319 
under the Patches and Updates tab..

Note: Ensure that the tablespace(s) used for the database user(s) is set to 
AUTOEXTEND ON.

Table 3–1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value

https://edelivery.oracle.com
http://support.oracle.com/
https://support.oracle.com/ 
https://support.oracle.com/ 
https://support.oracle.com/ 
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•     Configuration for GUI Mode Installation

•     Copying and Extracting the Software

•     Setting Up the Web Application Server

Identifying the Installation Directory
This would typically be the User home directory and requires you to copy the following files:

•     OFSAA Installation Directory ($FIC_HOME) - To be created prior to installation.  This is 
the directory where the installer would copy the product files. $FIC_HOME to be set in the 
.profile pointing to the OFSAA Installation Directory.

•     OFSAA Installation Directory ($FIC_HOME) - To be created prior to installation.  This is 
the directory where the installer would copy the product files. $FIC_HOME to be set in the 
.profile pointing to the OFSAA Installation Directory.

•     OFSAA Download Directory - OFSAA Application Pack Installer File (Archive) to be 
copied to any directory/folder, typically the User Home directory.

Note:

Ensure the user permission set to 755 on the installation directory.

Configuration for GUI Mode Installation
To install OIPA Pack in GUI mode, you need to ensure the below software and configurations 
are available:

•     Install and configure any PC X Server software such as Open Text Exceed (formerly 
Hummingbird Exceed) on the user desktop system from which the installation is triggered.

•     Configure the DISPLAY variable.

Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed, 
to point to the user desktop system where the PC X Server software has been installed.

Syntax:

export DISPLAY=hostname:n.n1 
where hostname is the IP Address/Host Name of the user desktop system and n is the 
sequence number (usually 0).

For example, 10.11.12.13:0.0 or myhostname:0.0

Copying and Extracting the Software
Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the 
OFSAA Infrastructure components will be installed.

Note: 

You must be logged in to the UNIX operating system as a non-root user.

1. Download the unzip utility (OS specific) unzip_<os>.Z from the location 
https://updates.oracle.com/unzips/unzips.html, and copy it in Binary mode to 
the directory that is included in your PATH variable. If you already have the unzip utility to 
extract the contents of the downloaded archive, skip to the next step.

2. Uncompress the unzip installer file using the command:

https://updates.oracle.com/unzips/unzips.html
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uncompress unzip_<os>.Z

Note

In case you notice an error message "uncompress: not found [No such file or 
directory]" when the package is not installed, contact your UNIX 
administrator.

3. Give EXECUTE permission to the file using the command:

chmod 751 unzip_<OS>

For example, chmod 751 unzip_sparc

4. Extract the contents of the Oracle Insurance Performance Application Pack 8.0.0.0.0 in 
Download Directory installer archive file using the following command:

unzip IP_80000.zip

5. Navigate to the directory where the installer kit is extracted. 

chmod -R 755 OFS_IP_PACK

Setting Up the Web Application Server
For setting up the environment based on your selected Web Application Server, refer to 
Configuring Web Application Servers.
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4Installing OIPA Pack

This chapter describes the steps to be followed to install the OIPA pack depending on the 
offline and online modes of installation.

This chapter includes the following sections:

•     Schema creator utility

•     Configuring and Executing the Schema Creator Utility

•     Running OIPA application pack

Schema creator utility
Creating database users/schemas is one of the primary steps in the complete OFSAA 
installation. This release of OFSAA provides a utility to quickly get started with the OFSAA 
8.0 installation by allowing easier and faster creation of database User(s)/ Schema(s), assign the 
necessary GRANT(s), and so on. Additionally, it also creates the required entities in these 
schemas. 

The different types of schemas available for configuration in the OFSAA instance and their use 
is mentioned as follows:

•     CONFIG - This schema denotes the unique OFSAA setup configuration schema and holds 
entities and other objects required to hold the unique OFSAA setup information. 

Note: There can be only one CONFIG schema per OFSAA instance.

•     ATOMIC - This schema denotes the schema that holds the data model entities. One 
ATOMIC schema is attached to one Information Domain.

Note: There can be multiple ATOMIC schemas per OFSAA Instance and an 
Information Domain can have only one ATOMIC schema.

•     SANDBOX - This schema denotes the schema that holds the data for all Sandbox 
executions. One SANDBOX schema is attached to one Sandbox Information Domain. 

Note: There can be multiple SANDBOX schemas per OFSAA Instance and a 
Sandbox Information Domain can have only one SANDBOX schema.
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•     ADDON - This schema denotes any additional schema used by the OFSAA Applications.

Schema creator utility supports two modes of execution:

•     Online Mode: In this mode, the utility connects to the database and executes the DDLs for 
User, Entities, and Grants.

Note: To execute the utility in Online mode, you need to connect as "SYS AS 
SYSDBA" user.

•     Offline Mode: In this mode, the utility generates a  SQL script with all the required DDLs 
for User, Entities and Grants. This script needs to be executed by the DBA on the 
appropriate database identified for OFSAA usage.

Note: To execute the utility in Offline mode, you need to connect as any user with the 
following grants: 

? xx

? yy

? zz

Refer Appendix G for additional information on various grants.

Note: 

? Do not modify the OFS_IP_SCHEMA_OUT.XML file generated after the 
execution of this utility. 

? If there are any errors during the script executions and should you require to 
correct the same, reconfigure the OFS_IP_SCHEMA_IN.XML file and execute 
the utility. This will regenerate the scripts with corrected information.

Configuring and Executing the Schema Creator Utility
This section includes the following topics:

•     Prerequisites

•     Configuring the Schema Creator Utility

•     Executing the Schema Creator Utility

•     Verifying the Log File

Prerequisites
The following prerequisites must be satisfied before configuring the Schema Creator Utility:

•     You must have the Oracle User ID/Password with SYSDBA privileges.

•     You must have the JDBC Connection URL for RAC/Non RAC database.

•     The HOSTNAME/IP of the server on which OFSAA is getting installed.



Note:

If this release of the OIPA pack version 8.0.0.0.0 is being installed on an OFSAA 
setup where the underlying OFSAA Infrastructure (OFS AAI) version is upgraded to 
version 8.0.1.x.x, download and install the patch for schema creator utility (Bug 
21133780) by following the instructions in the Readme.txt packaged in it prior to 
executing the utility.

If this release of the OFS AAAI Application Pack version 8.0.0.0.0 is being installed 
on an OFSAA setup where the underlying OFSAA Infrastructure (OFS AAI) version 
is upgraded to version 8.0.2x.x, download and install the patch for schema creator 
utility (Bug 21657319) by following the instructions in the Readme.txt packaged in it 
prior to executing the utility..
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Configuring the Schema Creator Utility
This section explains the steps to configure the Schema Creator Utility.

To configure the Schema Creator Utility, follow these steps:

1. Navigate to the following path: OFS_IP_PACK/schema_creator/conf folder.

2. Edit the OFS_IP_SCHEMA_IN.xml file in a text editor.

3. Configure the following elements as described in the table:

Table 4–1  Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change

APP_PACK_ID Application Pack ID 
as per Product 
Management

- Mandatory

This value should not be 
edited.

 <JDBC_URL> Enter the JDBC 
URL.

Note: You can enter 
RAC and 
NON-RAC enabled 
database 
connectivity URL.

Example, 

jdbc:oracle:thin:@<HOS
T/IP>:<PORT>:<SID>

Mandatory

<JDBC_DRIVER> By default this 
driver is seeded. 

Note: Do not edit 
this attribute 
value.

Example, 

oracle.jdbc.driver.Oracle
Driver

Mandatory

<HOST> Enter the Hostname 
or the IP Address of 
the system on which 
you are installing the 
OFSAA 
components.

Host Name/IP Address Mandatory
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<SETUPINFO>/ 
NAME

Enter the acronym 
for the type of 
implementation. 
This information 
will be displayed in 
the OFSAA Home 
Page.

Note: On executing 
the schema creator 
utility, this value 
will be prefixed with 
each schema name. 
For example: dev_
ofsaaconf, uat_
ofsaaatm.

Accepts strings with a 
minimum length of two 
and maximum of four.

Example, 

DEV, SIT, PROD

Mandatory

<PASSWORD>/AP
PLYSAMEFORALL

Enter as Y if you 
want to apply the 
password specified 
in DEFAULT 
attribute for all the 
schemas. 

If you enter as N, 
then you need to 
provide individual 
passwords for all 
schemas.

Note: In case you 
have entered Y in 
APPLYSAMEFOR
ALL attribute and 
also have specified 
individual 
passwords for all the 
schemas, then the 
specified individual 
passwords will take 
precedence.

 

Y/N Mandatory 

Note: Setting this 
attribute value is 
mandatory, If DEFAULT 
attribute is set.

<PASSWORD>/ 
DEFAULT*

Enter the 
password if you 
want to set a 
default for all 
schemas.

Note: You also 
need to set 
APPLYSAMEFO
RALL attribute as 
Y to apply the 
default password 
for all the 
schemas.

The maximum length 
allowed is 30 characters. 
Special characters are 
not allowed.

Optional

Table 4–1 (Cont.) Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change
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<SCHEMA>TYPE The different types 
of schemas that are 
supported in this 
release are  
ATOMIC, CONFIG, 
and SANDBOX.

By default, the 
schemas types are 
seeded based on the 
Application Pack. 

Note: Do not edit 
this attribute value.

ATOMIC/CONFIG/SAN
DBOX/ADDON 

Mandatory

<SCHEMA> 
NAME

By default, the 
schemas names are 
seeded based on the 
Application Pack.

You can edit the 
schema names if 
required. 

Note:

? The Schema 
Name will have 
a prefix of the 
SETUPINFO/N
AME attribute.

? SCHEMA 
NAME must be 
same for all the 
ATOMIC 
Schemas of 
applications 
within an 
Application 
Pack. 

? The permissible 
length for 
schema name is 
15 characters.

- To identify which 
schema is associated 
to this Application.

Cannot be blank

Table 4–1 (Cont.) Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change
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<SCHEMA>/ 
PASSWORD*

Enter the password 
of the schema to be 
created.

Note:

? If this attribute 
is left blank, 
then the 
password 
specified in the 
<PASSWORD
>/DEFAULT 
attribute is 
applied as the 
Schema 
Password.

? The permissible 
length and 
allowed 
characters for 
schema 
password as 
defined by 
Oracle 
Database User 
naming 
convention

The maximum length 
allowed is 30 characters. 
Special characters are 
not allowed.

Optional

Note: You need to 
mandatorily enter the 
password if you have set 
the <PASSWORD>/ 
APPLYSAMEFORALL 
attribute as N.

<SCHEMA>/ APP_
ID

By default, the 
Application ID is 
seeded based on the 
Application Pack. 

Note: Do not edit 
this attribute value.

- Mandatory

<SCHEMA>/ 
DEFAULTTABLES
PACE

Enter the available 
default tablespace 
for DB User.

Note: If this 
attribute is left 
blank, then USERS 
is set as the default 
tablespace. 

- Optional

<SCHEMA>/ 
TEMPTABLESPAC
E

Enter the available 
temporary 
tablespace for the 
DB User.

Note: If this 
attribute is left 
blank, then TEMP is 
set as the default 
tablespace.

- Optional

Table 4–1 (Cont.) Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change
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Executing the Schema Creator Utility 
You can execute the schema creator utility either in Online Mode or Offline Mode. This section 
includes the following topics:

•     Executing the Schema Creator Utility in Online Mode

<SCHEMA>/QUOT
A

Enter the quota to be 
set on 
DEFAULTTABLES
PACE attribute for 
the schema/user. By 
default, the quota 
size is set to 500M.

Minimum: 500M or 
Unlimited on default 
Tablespace.

For example,

? 600M/m

? 20G/g

? UNLIMITED/unlimited

Optional

Table 4–1 (Cont.) Prerequisite Information

Element Name Description Permissible Value
Mandatory/Optional 
change
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•     Executing the Schema Creator Utility in Offline Mode

•     Executing the Schema Creator Utility in Silent Mode

•     Executing the Schema Creator Utility while Installing Subsequent Application Pack

Executing the Schema Creator Utility in Online Mode
In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects, and 
Grants in the database during the execution process.

To execute the schema creator utility while creating the schemas for the first application pack, 
follow these steps:

1. Navigate to the following folder path: OFS_IP_Pack/schema_creator/bin/

2. Execute the osc.sh file using the following command:

./osc.sh
3. The following message is displayed: You have chosen ONLINE mode.

4. Enter the DB Username with SYSDBA Previleges. For example: SYS as SYSDBA.

5. Enter the User Password.

Figure 4–1 Schema Creation

6. The console runs the initial validation checks and then displays the following message: You 
have chosen to install this Application Pack on <Name of the Atomic Schema>ATOMIC 
schema. Do you want to proceed? (Y/N)

7. Enter Y to start the schema creation.

Or

Enter N if you want to quit executing the schema creation.
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Figure 4–2 Schema Creation

Note: On successful execution of schema creator utility, the console displays the 
following status message:

Success. Please proceed with the installation. 

Refer log file in OFS_IP_PACK/schema_creator/logs folder for execution 
status. In case of any errors, contact Oracle Support.

Executing the Schema Creator Utility in Offline Mode
In Offline Mode, the Schema Creator Utility creates an output in SQL file format. This script 
has to be executed manually by logging as database user with SYSDBA privileges. The SQL 
file will contain the creation of Schemas, Schema Objects, and Roles.

Prerequisites:

•     DBA_ROLES

•     DBA_USERS

•     DBA_DIRECTORIES

•     DBA_TABLESPACES

•     CREATE SESSION

Note: Explicit Grants to the user are required. Grants assigned through 
Roles are not supported.

To execute the schema creator utility in the offline mode, follow these steps:

1. Navigate to the following folder path: OFS_IP_Pack/schema_creator/bin

2. Execute the osc.sh file using the following command:

./osc.sh -o

3. The following message is displayed: You have chosen OFFLINE mode.
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4. Enter the DB Username with SELECT privileges.

5. Enter the User Password.

6. The console runs the initial validation checks and displays the following message: You 
have chosen to install this Application Pack on <Name of the Atomic Schema>ATOMIC 
schema. Do you want to proceed? (Y/N)

7. Enter Y to start the script generation. 

Or

Enter N if you want to quit the script generation. 

Note: On successful execution of schema creator utility, the console displays the 
following status message: 

Success. Please execute OFS_IP_Pack/schema_creator/sysdba_output_
scripts.sql before proceeding with the installation.

8. Navigate to the directory: OFS_IP_Pack/schema_creator.

9. Login to SQLPLUS with a user having SYSDBA Privileges.
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10. Execute the sysdba_output_scripts.sql file using the following command:

SQL>@sysdba_output_scripts.sql

Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts 
folder to a remote server and execute sysdba_output_scripts.sql file.

Note: Refer log sysdba_output_scripts.log file for execution status. 
In case of any errors, contact Oracle Support.

Executing the Schema Creator Utility in Silent Mode
If you want to run the OFSAA Application Pack Installer in SILENT mode, it is mandatory to 
execute the schema creator utility with -s option.

To execute the utility with -s option, follow these steps:

1. Edit the file OFS_IP_PACK/schema_creator/conf/OFS_IP_SCHEMA_IN.xml in text 
editor.

2. Set the value for attribute "INFODOM" of <SCHEMA> tag(s) to specify a specific 
Information Domain name. By default, the value is empty and the utility will derive the 
Information Domain name. If the attribute value is set, the utility/ installer will configure 
the Information Domain against this <SCHEMA>.

3. Execute the utility with -s option.

For Example./osc.sh -s.



Note:  If the utility is executed without the -s option, it is mandatory to 
launch the OFSAA Application Pack Installer in GUI mode.

Note: To execute the utility in OFFLINE mode with SILENT option, type. 
/osc.sh -o -s
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Executing the Schema Creator Utility while Installing Subsequent Application 
Pack
While executing the schema creator utility for subsequent Application Pack, you can choose to 
install the pack either on the same Information Domain/Atomic Schema or on a new 
Information Domain/Atomic Schema. You can execute the Schema Creator Utility either in 
Online or Offline Mode.

Note: OIPA Pack cannot be installed on the same information domain/atomic 
schema, where Behavior Detection or Compliance Regulatory Reporting 
Packs are installed/configured.

To execute the schema creator utility while installing OIPA Pack over an existing Application 
pack, follow these steps:

1. Perform the steps 1 to 5 from the  Executing the Schema Creator Utility section.
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2. The console identifies the Application Packs that are already installed on the current 
OFSAA setup and displays the following:

? Atomic schema of the Existing Application Pack

? Information Domain Name of the Existing Pack

? List of Installed Application Packs.

3. Enter Y to start the schema creation.

Or

Enter N if you want to quit executing the schema creation. 

Note: On successful execution of schema creator utility, the console displays the 
following status message:

Success. Please proceed with the installation. 

Refer log file in OFS_IP_PACK/schema_creator/logs folder for execution 
status, if scripts are executed in online mode. 

Refer log sysdba_output_scripts.log file for execution status, if 
executed in offline mode.

In case of any errors, contact Oracle Support.
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Verifying the Log File

If schema creation is successful, the console would display an appropriate message. If the 
schema creation runs into errors, refer the following log file:

•     << OFSIP Installer folder>>/<<OFS_IP_PACK>>/schema_creator/logs/

•     OFS_IP_osc_<timestamp>.log

Note: For further details, you can contact Oracle Support.

Running OIPA application pack
Follow the instructions in this section to install the OIPA Pack depending on the mode of 
installation. 

This section covers the following topics:

•     Silent Mode Installation

•     GUI Mode Installation

Silent Mode Installation
In the Silent Mode Installation you must configure the product xml files and follow the 
instructions in command prompt.

Configuring OFSAAI_InstallConfig.xml
Follow these instructions to configure OFSAA_InstallConfig.xml file:

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the 
following:
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FIC_HOME=< OFSAA Installation Directory >

export FIC_HOME

3. Execute the user .profile.

4. Navigate to the file: OFS_IP_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml

5. Configure the OFSAAI_InstallConfig.xml as mentioned in the following table:

Table 4–2  Prerequisite Information

InteractionVariableNam
e Significance and Expected Value Mandatory

<Layer name="GENERAL">

WEBAPPSERVERTYPE Identifies the web application server on 
which the OFSAA Infrastructure web 
components would be deployed.

The below numeric value should be set 
depending on the type:

Apache Tomcat = 1

IBM WebSphere Application Server = 
2

Oracle WebLogic Server = 3

For example,  <InteractionVariable 
name="WEBAPPSERVERTYPE">3</
InteractionVari able>

? Yes

DBSERVER_IP Identifies the hostname or IP address of 
the system on which the Database 
Engine is hosted.

Note: For RAC Database , the value 
should be NA.

For example, <InteractionVariable 
name="DBSERVER_ 
IP">14.15.16.17</InteractionVariable> 
or

<InteractionVariable 
name="DBSERVER_ 
IP">dbhost.server.com</InteractionVar
iable

>

Yes

ORACLE_
SID/SERVICE_ NAME

Identifies the Oracle DB Instance SID 
or SERVICE_NAME

Note: The Oracle_SID value should be 
exactly the same as it is mentioned in 
JDBC_URL.

For example, <InteractionVariable 
name="ORACLE_SID/SERVICE_

NAME">ofsaser</InteractionVariable>

Yes
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ABS_DRIVER_PATH Identifies the directory where the 
JDBC driver (ojdbc6.jar) exists. This 
would typically be the

$ORACLE_HOME/jdbc/lib

For example, <InteractionVariable 
name="ABS_DRIVER_ 
PATH">">/oradata6/revwb7/oracle

</InteractionVariable>

Yes

OLAP_SERVER_ 
IMPLEMENTATION

Identifies if the OFSAA Infrastructure 
OLAP component needs to be 
configured depending on whether you 
intend to use the OLAP feature. The 
following numeric value should be set 
depending on the choice:

? YES - 1

? NO - 0

No

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following 
environment variables are set in .profile:

SFTP_ENABLE Identifies if the SFTP (Secure File 
Transfer Protocol) feature is to be 
enabled. The below numeric value 
should be set depending on the choice:

? SFTP - 1

? FTP - 0

Yes

Note:

The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends 
using SFTP instead of FTP because SFTP is considered more secure. However, a client may choose to 
ignore this recommendation and to use FTP by setting SFTP_ENABLE to 0. This selection may be 
changed later by using the OFSAAI administration interface.

FILE_TRANSFER_
PORT

Identifies the port used for the file 
transfer service. The default value 
specified is 22 (SFTP). Specify value 
as 21 or any other PORT value if value 
for SFTP_ENABLE is 0.

For example, <InteractionVariable 
name="FILE_TRANSFER_ 
PORT">21</InteractionVariable>

Yes

LOCALE Identifies the locale information to be 
used during the installation. This 
release of the OFSAA Infrastructure 
supports only US English.

For example, <InteractionVariable 
name="LOCALE">en_
US</InteractionVariable>

Yes

Note: The following ports are used internally by the various OFSAA Infrastructure services. The 
default values mentioned below are set in the installation. If you intend to specify a different value, 
update the parameter value accordingly and ensure this port value is in the range of 1025 to 65535 and 
the respective port is enabled.

JAVAPORT 9999 Yes

NATIVEPORT 6666 Yes

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNam
e Significance and Expected Value Mandatory
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AGENTPORT 6510 Yes

ICCPORT 6507 Yes

ICCNATIVEPORT 6509 Yes

OLAPPORT 10101 Yes

MSGPORT 6501 Yes

ROUTERPORT 6500 Yes

AMPORT 6505 Yes

<Layer name="OFSAAI_WEB_LAYER">

HTTPS_ENABLE Identifies if the UI should be accessed 
using HTTP or HTTPS scheme. The 
default value set is 0. The following 
numeric value should be set depending 
on the choice:

? Yes - 1

? No - 0

Yes

WEB_SERVER_IP Identifies the HTTP Server IP/ 
Hostname or Web Application Server 
IP/ Hostname, to be used for accessing 
the UI. This IP would typically be the 
HTTP Server IP.

If no separate HTTP Server is 
available, the value should be Web 
Application Server IP/Hostname.

For example, <InteractionVariable 
name="WEB_SERVER_ 
IP">10.11.12.13</InteractionVariable>

or

<InteractionVariable name="WEB_
SERVER_ 
IP">myweb.server.com</InteractionVa
riable>

No

WEB_SERVER_PORT Identifies the Web Server Port. This 
would typically be 80 for non SSL and 
443 for SSL. If no separate HTTP 
Server exists, the value should be the 
port configured for Web Server.

Note: The port value will not be 
accepted as 80 if HTTPS_ENABLE is 
1 and as 443, if HTTPS_ENABLE is 0.

For example, <InteractionVariable 
name="WEB_ SERVER_
PORT">80</InteractionVariable>

No

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNam
e Significance and Expected Value Mandatory
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CONTEXT_NAME Identifies the web application context 
name which will be used to built the 
URL to access the OFSAA 
applications. The context name can be 
identified from a URL as below:

<scheme>://<host>:<port>/<context-na
me>/lo gin.jsp

Sample URL:

https://myweb:443/ofsaadev/
login.jsp

For example, <InteractionVariable 
name="CONTEXT_ 
NAME">ofsaadev</InteractionVariabl
e>

Yes

WEBAPP_CONTEXT_
PATH

Identifies the absolute path of the 
exploded .ear file on the web 
application server.

For Tomcat, specify the Tomcat 
directory path till /webapps, such as 
/oradata6/revwb7/tomcat/webapps/.

For WebSphere, enter the WebSphere 
path as <WebSphere profile 
directory>/installedApps/<NodeCellNa
me>. For example, 
/data2/test//WebSphere/AppServer/prof
iles/<Profile_ 
Name>/installedApps/aix-imfNode01C
ell. Where aix-imf is Host name.

For WebLogic, provide the WebLogic 
home directory path as /<WebLogic 
home directory path>/bea/wlserver_
10.3

Note: For WebLogic, provide the 
WebLogic home directory path as 
/<WebLogic home directory 
path>/bea/wlserver_10.3

Yes

WEB_LOCAL_PATH Identifies the absolute path to any 
directory on the web application server 
that can hold temporary files being 
uploaded as part of the applications 
usage.

Note: In case of a clustered 
deployment, ensure this path and 
directory is same on all the nodes.

Yes

WEBLOGIC_DOMAIN_
HOME

Identifies the WebLogic Domain 
Home. Specify the value only if 
WEBSERVERTYPE is set as 3 
(WebLogic).

For example, <InteractionVariable 
name="WEBLOGIC_DOMAIN_

HOME">/home/weblogic/bea/user_ 
projects/domains/mydomain

</InteractionVariable>

No

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNam
e Significance and Expected Value Mandatory
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6. Navigate to the file: OFS_IP_PACK/conf/OFS_IP_Pack.xml and select the applications to 
be enabled.

Note: Enter Yes in ENABLE tag to enable application.

7. Rename Silent.template file to Silent.props present under  OFS_IP_PACK /<OFS_
IP/conf folder.

8. Configure Silent.props file as mentioned in the following table.

OFSAAI_FTPSHARE_
PATH

Identifies the absolute path to the 
directory identified as file system stage 
area.

Note: 

1.The directory should exist on the 
same system on which the OFSAA 
Infrastructure is being installed (can be 
on a separate mount).

2.The user mentioned in APP_SFTP_
USER_ID parameter below should 
have RWX permission on the directory.

For example, <InteractionVariable 
name="APP_FTPSHARE_
PATH">">/oradata6/revwb7/ftpshare</
InteractionVariable>

Yes

OFSAAI_SFTP_USER_
ID

Identifies the user who has RWX 
permissions on the directory identified 
under parameter APP_FTPSHARE_
PATH above.

Yes

Table 4–3 Silent Installation Information

Step Description File Path

1 Update Schema_
IN.xml file 
related to 
Atomic/Config 
scheme details

OFS_IP_PACK/schema_creator/conf

2 Update OFSAAI_
InstallConfig.
xml related to AAI 
configuration

OFS_IP_PACK/OFS_AAI/conf

Table 4–2 (Cont.) Prerequisite Information

InteractionVariableNam
e Significance and Expected Value Mandatory
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Running the installer in Silent Mode
To install the OFSAA Infrastructure in Silent mode, execute the following command:

./setup.sh SILENT in the console.

Note:

Edit the VerInfo.txt file to modify the value for property JAVA_VERSION to 1.8.

Completing the installation in Silent Mode
On launching the installer in silent mode, the environment check utility is executed. Enter the 
required information to execute the utility as explained:

Table 4–4  Webserver start up options

Console Prompts User Inputs

Enter OFSAAI CONFIG 
Schema user name

Enter the user name for OFSAAI configuration schema.

Enter password Enter the configuration schema password.

Enter Oracle SID/ SERVICE 
name

Enter the SID or service name of the Oracle database instance.

The status of each checks performed by the utility is displayed as shown in the figure If the status of the 
utility is Success, it proceeds with the installation.

3 Update Pack.xml 
file for Licensing 
the application in 
the pack.

Update the attribute 
ENABLE="YES/
NO" in pack.xml 
for licensing the 
application in the 
pack

OFS_IP_PACK/conf

4 Rename 
Silent.templat
e to 
Silent.props 
and update  the 
application related 
installer 
configuration

OFS_IP_PACK/<OFS_App>/conf

5 Execute" osc.sh 
-s" for schema 
creation process in 
Silent mode

OFS_IP_PACK/schema_
creator/bin

6 Execute" 
setup.sh 
SILENT" to start 
the Installation 

OFS_IP_PACK/bin

Table 4–3 Silent Installation Information

Step Description File Path



Note: The above table item is asked if environment check utility  is executed 
in the standalone mode.

Table 4–5  Webserver start up options

Console Prompts User Inputs

Enter Infrastructure FTP/SFTP 
password

Enter the password to access Product Staging/Metadata repository directory in the 
application server.

Note: During installation stage, you need to enter the config schema password 
again.
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1. The OFSAAI License Agreement is displayed as shown in the figure:
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Figure 4–3 OFSAAI License Agreement Page

2. Accept the License Agreement.

Table 4–6  Webserver start up options

Console Prompts User Inputs

 Are you accepting the terms 
and conditions mentioned 
above? [Y/N]

Enter Y if you accept the license agreement and want to proceed with installation.

Enter password for default 
Infrastructure administrator 
user SYSADMN

Enter the password for the System Administrator.
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Re-enter password for default 
Infrastructure administrator 
user SYSADMN

Enter the same password again to confirm its validity.

Enter password for default 
Infrastructure authorizer user 
SYSAUTH

Enter the password for the System Authorizer.

Enter password for default 
Infrastructure authorizer user 
SYSAUTH

Enter the same password again to confirm its validity.

Note: SYSADMN and SYSAUTH are the two default OFSAAI 
administrative users created.

Table 4–6 (Cont.) Webserver start up options

Console Prompts User Inputs
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Note: The installation process continues on the console. Do not close the 
console until the installation process is complete.

Running OIPA application pack

                                Installing OIPA Pack 4-43 

GUI Mode Installation

Note: Ensure you have followed the steps as mentioned in the Configuration 
for GUI Mode Installationsection prior to proceeding with the next steps.

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the 
following:

FIC_HOME=<ofsaa_install_dir>
export FIC_HOME 

3. Execute the user .profile.

4. Navigate to the path: OFS_IP_PACK/bin

5. Execute ./setup.sh GUI in the console.

Note:

For Java 8: Edit the VerInfo.txt file to modify the value for property JAVA_
VERSION to 1.8.

Note: If the Precheck is successful, the installation begins. Else the 
installation aborts.
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Figure 4–4 Initialization Window

Figure 4–5 License Agreement

6. Select I accept the terms if the License Agreement option.

7. Click Next.

The  Insurance Performance Application Pack details are displayed.



Running OIPA application pack

                                Installing OIPA Pack 4-45 

Figure 4–6 Application Pack Details 

8. Select the product to enable for which you have already obtained license. 

9. Click Next. The License Agreement page is displayed.

Figure 4–7 License Agreement page 

10. Select I accept the terms of the License Agreement option.

11. Click Next.

The Manage Information Domain page is displayed.
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Figure 4–8 Manage Information Domain page 

12. Edit the Information Domain Name if it is a new Information domain or if you want to 
change the name of the information domain name.

Note: In case of subsequent Application Pack installation on the same 
Information Domain, you cannot edit the name.

13. Click Next. The License Agreement window is displayed.
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Figure 4–9 License Agreement Window

14. Select I accept the terms of the License Agreement option.

15. Click Next. The License Details page is displayed.

Figure 4–10 License Details Page

16. Click Next. The User Installation Directory window is displayed.
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Figure 4–11 User Installation Directory

Note: The User Installation Directory path is auto-populated from the path 
you have set in the user .profile file in step 2.

17. Click Next. The OFSAA Infrastructure Server Details window is displayed.

Figure 4–12 OFSAA Infrastructure Server Details

18. Enter the IP address or hostname of the OFSAAI server and Database server.



Running OIPA application pack

                                Installing OIPA Pack 4-49 

19. Click Next. The Web Application Server window is displayed.

Figure 4–13 Web Application Server

20. Select the appropriate Web Application server type. The options are Tomcat, WebSphere, 
and WebLogic.

21. Click Next. Based on the selection, corresponding screens are displayed.

For Tomcat: The Absolute Tomcat Path window is displayed.

Figure 4–14 Absolute Tomcat Path
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22. Enter the Tomcat installation path (till/webapps) where OFSAAI is deployed. 

For WebSphere: The WebSphere Setup Details window is displayed.

Figure 4–15 WebSphere Setup Details

23. Enter the installation path (up to the host name directory) of the WebSphere. The format is 
WebSphere path <WebSphere profile 
directory>/installedApps/<NodeCellName>.

For WebLogic: The Weblogic Home window is displayed.

Figure 4–16 Weblogic Home

24. Enter the WebLogic home directory path.
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Figure 4–17 Weblogic Setup Details

25. Enter the path of the Weblogic domain home directory and click Next. The OLAP Details 
window is displayed.

Figure 4–18 OLAP Details

26. Enter 1 if you want to configure OFSAAI OLAP feature. By default, 0 is displayed.

27. Click Next. The Web Server Details window is displayed.
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Figure 4–19 Web Server Details

28. Select Enable HTTPS checkbox to configure HTTPS.

29. Enter Web Server (HTTP Server) Port, Web App Server (HTTP Server) IP address, context 
name for deployment and the local path to any folder on the Web Application Server 
(Tomcat/ Websphere/ Weblogic).

30. Click Next. The Database Details window is displayed.

Figure 4–20 Database Details

31. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID and 
Password, and Absolute Driver Path.



Note:

Absolute Driver Path can be the path where Oracle DB client is installed or 
JDBC driver is installed. For example, 
/scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib
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32. Click Next. The Ports Configuration window is displayed.

Figure 4–21 Ports Configuration

33. Enter Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native Port. You can 
proceed with the default port values configured.

34. Click Next. The Ports Configuration window is displayed.
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Figure 4–22 Ports Configuration

35. Enter OLAP Port, Message Server Port, Router Port, and AM Port.

36. Click Next. The Default Infrastructure Administrator and Authorizer User Password 
window is displayed.

Figure 4–23 Default Infrastructure Administrator and Authorizer User Password

37. Enter the passwords for default System Administrator and System Authorizer users.

38. Click Next. The SFTP Details window is displayed.
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Figure 4–24 SFTP Details

39. Enter 1 to enable SFTP or 0 to enable FTP.

Note: Ensure that the system on which the OFSAA Infrastructure is being 
installed, has either FTP/SFTP enabled.

40. Enter the port to be used for file transfer.

41. Click Next. The OFSAAI Post Install Details window is displayed.
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Figure 4–25 OFSAAI Post Install Details

42. Enter the FTPSHARE Path, FTP/SFTP User ID and Password for OFSAAI Server.

Note: The transfer of data (files) between the OFSAAI Server and the Web 
Application Server happens over FTP/SFTP. Ensure the necessary host 
configurations are made for a successful handshake.

43. Click Next. The Sample Application Installation window is displayed.

Figure 4–26 Sample Application Installation
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44. Select Yes if you want to install Sample Application.

Note: Ensure the appropriate DB schemas are created for holding the Sample 
Application data. See Database User/Schema Database User/Schema 
Database User/Schema section..

45. Click Next. The Pre Installation Summary window is displayed.

Figure 4–27 Pre Installation Summary 

46. Click Install. The Installing OFSAA Infrastructure window is displayed.
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Figure 4–28 Installing OFSAA Infrastructure

Anytime during the installation you can click Cancel to stop the installation. Once 
completed, the Installation Summary window is displayed.

Figure 4–29 Installation Summary

The Summary window displays the number of Fatal Errors, Errors, Debug Statements, 
Informations, and Warnings along with the location of log files.

47. Click Next. The Installation Complete window is displayed.
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Figure 4–30 Installation Complete

Note: If the installation is successful with some warnings, you can navigate 
to the installation log for more details and address them.

48. Click Done. The following message is displayed: Please wait, pack_install is being 
configured for your system. This may take a moment.

Figure 4–31 Checking OFSAAI Services

49. The Solution Setup - Introduction window is displayed.
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Figure 4–32 Solution Setup Introduction Window

50. Click Next. The Log mode window is displayed. Select the Log Mode.

Figure 4–33 Log Mode Window

51. Click Next. The Segment creation window is displayed. Enter the log paths.
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Figure 4–34 Segment Creation window

52. Click Next. The Pre-Infodom Creation Summary window is displayed.

Figure 4–35 Pre-Infodom Creation Summary window

53. Click Next. The Infodom creation window is displayed.
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Figure 4–36 Infodom creation Window

54. Click Next. The Model Upload Window is displayed.

Figure 4–37 Model Upload Window

55. Select Yes and click Next. The Model Type window is displayed.
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Figure 4–38 Model Type Window

56. The Model Review Window is  displayed.

Figure 4–39 Model Review Window

57. Click Next. The Heap Memory Warning window  is displayed.
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Figure 4–40 Model Heap Memory Warning

58. Click Back. Update your .profile entry with required heap memory size.

? Open a new session in Putty

? Shutdown Reveleus server using $FIC_HOME/ficapp/common/FICServer/bin/ 
reveleusshutdown.sh

? Update the X_ARGS_APP entry in .profile. For example,

X_ARGS_APP="-Xms2g -Xmx18g -XX:+UseAdaptiveSizePolicy 
-XX:MaxPermSize=1024M -XX:+UseParallelOldGC  
-XX:+DisableExplicitGC"

? Run .profile.

? Start Reveleus using $FIC_HOME/ficapp/common/FICServer/bin/ 
reveleusstartup.sh

? Proceed for model Upload by clicking Next.

59. Click Next again. The Upload starts. This takes 3 Hours, approximately.
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Figure 4–41 Model Upload Window

60. Provide OFSAAI Application and Source Pair details.

Figure 4–42 Source Pair details

61. Select New application source pair and click Next. The Staging details window is 
displayed.
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Figure 4–43 Staging Details Window

62. Click Next. This creates the staging source folder.

Figure 4–44 Staging creation Window

63. After Creation, click Next. The Installation Details Review window opens.
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Figure 4–45 Installation Details Review Window

64. Click Install. A Confirmation window is displayed.

Figure 4–46 Confirmation Window

65. Click Yes. The Installation starts and the Installation Progress is displayed in the 
Installation Progress window.
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Figure 4–47 Installation Progress Window

66. After Installation completion, the Installation Completion window is displayed.

Figure 4–48 Installation Completion Window

67. Click Done. The Installation Summary window is displayed.
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Figure 4–49 Installation Summary Window

68. Click Next to finish the installation.

Figure 4–50 Installation Complete Window

Post Install Health checks are displayed:
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Figure 4–51 Installation Complete

Verifying the Installation
This section explains the steps to verify your installation of Application.

To verify that you have successfully installed the Insurance Performance pack, follow these 
steps:

1. Login in to the atomic/*schema.

2. Verify the application log (it must not have any error).

3. Verify all the database objects like view, procedure, and functions must have been 
complied without any compilation error.

4. Deploy the war file and check whether the application screen is coming or not.
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5Post Installation Configuration

On successful installation of the Oracle  Insurance Performance Application Pack, refer the 
following post installation sections:

This chapter includes the following sections:

•     Creating and Deploying the Application Pack Web Archive 

•     Configuring Resource Reference

•     Configuring Web Application Server

•     Changing Batch Ownership

•     Updating OBIEE URL

•     Configurations for Java 8

Note: Ensure to clear the application cache prior to the deployment of 
Application Pack Web Archive. This is applicable to all Web Servers 
(WebSphere, WebLogic, and Tomcat). For more information, refer 
Appendix C section.

Configuring Resource Reference
This section describes the details for configuring the resource reference in WebSphere, 
Weblogic, and Tomcat Application Servers. For detailed information, refer to Configuring 
Resource Reference in Web Application Servers  section.

Configuring Web Application Server
This section describes the details to configure the different web application servers for OFSAA 
Infrastructure deployment namely, IBM Websphere, Oracle Weblogic, and Apache Tomcat 
Servers. For detailed information, refer to Configuring Web Application Serversection.

Creating and Deploying the Application Pack Web Archive
To create and deploy the application pack web archive, follow these steps:

1. Navigate to the $FIC_WEB_HOME directory.

2. Execute the command:

./ant.sh
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3. This will trigger the creation of EAR/WAR file - <contextname>.<extn>. Here 
<contextname> is the context name given during installation.

4. On completion of the EAR/WAR files creation, the "BUILD SUCCESSFUL" and "Time 
Taken" message is displayed and you are returned to the prompt.

5. The EAR/WAR file - <contextname>.<extn> - is created under "$FIC_WEB_HOME" 
directory.

Note: This process overwrites any existing version of EAR/WAR file in the path. If 
the web application server is Apache Tomcat, the file created would be 
<contextname>.war.

6. Deploy the generated EAR/WAR file on to the web application server. For detailed 
information, refer Deploying EAR/WAR File section.

Changing Batch Ownership
All the seeded batches are created with SYSADMN as the owner by default. This needs to be 
updated with username of the user who is responsible for maintenance of the batches. This can 
be done by executing the following procedure in the config schema:

begin

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromUser','toUser','infodom;

end;

OR

begin

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromuser','touser');

end;

where "FromUser" indicates the user who currently owns the batch and "toUser" indicates the 
user to which ownership needs to be transferred to. "Infodom" is an optional parameter.
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Updating OBIEE URL
UPDATE AAI_MENU_B

SET V_MENU_URL = '<obieeURL>'

WHERE V_MENU_ID IN ('<List of enabled BI Analytical Links for a particular 
Media Pack >')

/

COMMIT

/

For IP Media Pack as an example:

UPDATE AAI_MENU_B

SET V_MENU_URL = 'http://OIPIGI:port/analytics'

WHERE V_MENU_ID = 'OFS_OIPIGI_BI'

/

Configurations for Java 8
Refer to the following instructions to extract and apply the patch.

1. Copy the downloaded patch file ( 21160684) to your OFSAA server in Binary mode. 

For more information on downloading the patch files, refer  Prerequisite Information 
section >> Category - Others >> Sub-Category - OFSAA.

2. Follow the instructions given in the Readme to apply the patch.

3. If the Oracle Database version is 12c, copy ojdbc7.jar from $ORACLE_HOME/jdbc/lib 
to the following locations:

•     $FIC_HOME/utility/OFSAAGenerateRepository/lib/

•     $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

•     $FIC_HOME/ficdb/lib/

•     $FIC_HOME/ficapp/icc/lib/

•     $FIC_HOME/ficapp/common/FICServer/lib/

•     $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

•     $FIC_HOME/ficweb/webroot/WEB-INF/lib/

•     $FIC_HOME/ficdb/etl/classes/

4. If the Oracle Database version is 11g, copy ojdbc6.jar from $ORACLE_HOME/jdbc/lib 
to the following locations:

•     $FIC_HOME/utility/OFSAAGenerateRepository/lib/

•     $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

•     $FIC_HOME/ficdb/lib/

•     $FIC_HOME/ficapp/icc/lib/

•     $FIC_HOME/ficapp/common/FICServer/lib/

•     $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/
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•     $FIC_HOME/ficweb/webroot/WEB-INF/lib/

•     $FIC_HOME/ficdb/etl/classes/
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6Start and Stop of  Infrastructure Services

This chapter details about how to start and stop Infrastructure services.

This chapter includes the following topics:

•     Starting Infrastructure Services

•     Stopping Infrastructure Services

Starting Infrastructure Services
Once the installation of Infrastructure has been completed successfully and the post-installation 
steps are completed, the servers must be started. Log on to each machine and run the .profile 
file. All servers mentioned must be started from the same shell encoding. The servers 
mentioned below are dependent on each other. It is mandatory to maintain the order in which 
the servers are started. Allow each of the servers to initialize completely before starting the next 
server.

1. On the machine in which Infrastructure Application components have been installed, 
navigate to $FIC_APP_HOME/common/FICServer/bin and execute the following 
command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the command 
"nohup ./ startofsaai.sh &". Starting the process using "nohup" and 
"&" will return the command prompt without having to wait till the process 
completes. However, this command cannot be used when you are starting the 
server for the first time or starting after changing user password in the 
configuration database schema.You can also start the Infrastructure Server by 
executing the command "nohup ./ startofsaai.sh &". Starting the 
process using "nohup" and "&" will return the command prompt without 
having to wait till the process completes. However, this command cannot be 
used when you are starting the server for the first time or starting after 
changing user password in the configuration database schema.

2. Select the required webserver start up option from the following table:



Table 6–1  Webserver start up options

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 
/AppServer/<profiles>/<profile name>/bin and execute the 
command: ./startServer.sh server1

Starting WebLogic Domain On the machine in which WebLogic is installed, navigate to 
<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin and execute the command: 
startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic Admin 
Console. Stop and start the application <context name>.ear

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to <Tomcat_
Install_ Directory>/bin and execute the command: 
./catalina.sh run
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3. Start ICC server:

a. On the machine in which Infrastructure default Application components have been 
installed, navigate to $FIC_HOME/ficapp/icc/bin and execute the command:

 ./iccserver.sh

Note: Only Infrastructure Default Application Server would hold ICC 
component.

4. To start Back-end Services:

a. On the machine on which Infrastructure Database components have been installed, 
navigate to $FIC_DB_HOME/bin and execute the command to start "Agent server":

./agentstartup.sh 

Or

Start Back-end services using the command:

nohup./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP data 
server, and AM services.

Stopping Infrastructure Services
To stop Infrastructure services, follow these steps:

1. On the machine in which Infrastructure Application components have been installed, 
navigate to $FIC_APP_HOME/common/FICServer/bin and execute the command:.

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application 
components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and execute 
the command:

./iccservershutdown.sh



Note: Only Infrastructure Default Application Server would hold ICC 
component.
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3. To stop Back-end server, on the machine in which Infrastructure database components 
have been installed, navigate to $FIC_DB_HOME/bin and execute the command:

./agentshutdown.sh
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7Post Deployment Configuration

This chapter includes the following topics:

•     Deploying the Application

•     Logging as System Administrator

•     Creating Users

•     Mapping User to User Group

Deploying the Application
This section explains the steps to deploy the application. For more information, refer to 
Deploying EAR/WAR File section.

Logging as System Administrator
Post installation, the first login into Infrastructure is possible only for a System Administrator 
through the user id "sysadmn". This ID is created at the time of installation with the password 
provided during installation. Enter the login id  "sysadmn" and password that was provided 
during installation. Click Login. For more information, refer OFSAAI Login section.

Creating Users
User Maintenance facilitates you to create user definitions, view, manage, modify, and delete 
user information. You can access User Maintenance by expanding User Administrator section 
within the tree structure of LHS menu.

The User Maintenance screen displays user details such as User ID, Name, Profile Name, Start 
and End dates. You can also identify the user status if enabled to access the Infrastructure 
system.

To add a user in the User Maintenance screen, follow these steps:

1. Click Add  the User Maintenance toolbar. This button is disabled if you have selected any 
User ID in the grid. The New User screen is displayed.
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2. Enter the user details as tabulated.

Table 7–1  Prerequisite Information

Category Expected Value

User ID Enter a unique user id. Ensure that there are no special 
characters and extra spaces in the id entered.

User Name Enter the user name. The user name specified here will 
be displayed on the Infrastructure splash screen. Ensure 
that the User Name does not contain any special 
characters or spaces except "-", "'". and ".".

Contact Address Enter the contact address of the user. It can be the 
physical location from where the user is accessing 
the system. Ensure that Contact Address does not 
contain any special characters except ".", "#", "-", 
",".

Date Of Birth Specify the date of birth. You can use the popup calendar 
to enter the date.

Designation Enter the user designation. Ensure that Designation does 
not contain any special characters except "_, ":" and "-".

Profile Name Select the profile name by clicking on the drop-down list. 

User Start Date Specify the user start date based on the day slot the user 
is enabled to access the system. Ensure that User Start 
Date is greater than today's date. You can use the popup 
calendar to enter the date. 
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3. Click Save to upload the user details.

The new User details are populated in the User Authorization screen which has to be 
authorized by System Authorizers. Once authorized, the User details are displayed in User 
Maintenance screen and can then be mapped to the required user group in the User 
UserGroup Map screen.

Mapping User to User Group
User UserGroup Map facilitates you to map user(s) to specific user group which in turn is 
mapped to a specific Information Domain and role. Every UserGroup mapped to the infodom 
needs to be authorized. Else, it cannot be mapped to users.

User UserGroup Map screen displays details such as User ID, Name, and the corresponding 
Mapped Groups. You can view and modify the existing mappings within the User UserGroup 
Maintenance screen.

You can access User UserGroup Map by expanding User Administrator section within the tree 
structure of LHS menu.

UGIPIGIADMIN is the user-group available for Insurance Performance Pack.

User End Date Specify the user end date based on month and year when 
the user Id expires. Ensure that user End Date is greater 
than User Start Date. You can use the popup calendar to 
enter the date. 

Password Enter the default password for the user for the initial 
login. User needs to change the default password during 
the first login. 

A user is denied access in case the user has forgotten the 
password or enters the wrong password for the specified 
number of attempts (as defined in the Configuration 
screen). To enable access, enter a new password here.

Notification Time •     (Optional) Specify the notification start and end time 
within which the user can be notified with alerts. 

E-mail ID Enter the e-mail address of the user. 

Mobile No (Optional) Enter the mobile number of the user

Pager No (Optional) Enter the pager number of the user. 

Enable User Select the checkbox to allow user to access the system. 

A deselected checkbox denies access to the user.

Table 7–1 (Cont.) Prerequisite Information

Category Expected Value
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8OIPIGI Configuration

This chapter expalins the following steps are to be followed for configuring Oracle Insurance 
Performance Insight for General Insurance v8.0.0.0.0 Dashboards and Reports after OBIEE 
installation (Server):

A. Preliminary Installation of Software

1. Make sure Oracle Business Intelligence (Version 11.1.1.7.1) installation is completed and 
available.

2. If the OBIEE is installed in other than Windows environment, ensure that a standalone 
OBIEE Client is installed in a Windows environment.

B. Modify Repository Connection Pool Settings

For Windows Server

1. Copy the Repository file from the $FIC_HOME/OIPIGIand place it in the Repository folder 
where OBIEE is installed.

<OBIEE Install Folder>/instances/instance1/bifoundation/ 
OracleBIServerComponent/coreapplication_obis1/repository

2. Select Start >Programs >Oracle Business Intelligence>Administration.

3. Select File >Open >Offline.

4. Locate the OFS OIPIGI-PC.rpd and open.

5. Provide Repository password. The Repository password is "Admin123". 

Set the Connection Pool Properties:

6. In the "Physical" layer, under Database object, double-click the Connection Pool to update 
its properties.

7. In the General tab, edit/check the following entry: 

Call Interface: Default (OCI 10g/11g)

8. Update Data source name as give in the following example:

(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database IP 
Address>)(PORT=<Port no>)))(CONNECT_DATA=(SID=<Database name>)))

9. Enter Database Schema user name in the User Name field.

10. Enter Database Schema password in the Password field.

11. Click OK to close the window and click Save to save the RPD file.

12. Click No for the Global Consistency Message.

13. Close the RPD file (File/Exit).
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For Other Servers

1. Copy the Repository file from the $FIC_HOME/OIPIGIand place it anywhere in the local 
Windows system.

2. Open the BI Administration tool in the windows environment.

3. Select Start >Programs >Oracle Business Intelligence Enterprise Edition Plus 
Client>Administration.

4. Select File >Open > Offline.

5. Locate the file OIPIGI-PC.rpd and open.

6. Provide Repository password. The Repository password is "Admin123".

Set the Connection Pool Properties as described in the above steps 6...14.

C. Starting Node manager and Weblogic Servers

1. Check if the Node Manager is running or not. If not then follow the following steps.

For Windows Server

1. Go to the services.

2. Start the Service Oracle Weblogic NodeManager.

Alternatively you can start Node Manager and all the managed services from the All 
Programs -> Oracle Business Intelligence-> Start BI Services option in the Start 
menu.

For Other Servers

1. Navigate to < OBIEE Install Folder >/ wlserver_10.3/server/bin folder.

2. Run the following command: nohup ./startNodeManager.sh &.

Check if the Weblogic AdminServer if running or not. If not, then follow these steps.

For Windows Server
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•     Navigate to < OBIEE Install Folder >/user_projects/domains/bifoundation_
domain/bin

•     Run the following command: startWebLogic.cmd

Note: The Weblogic Admin Server would have been already started if you 
had started through the All Programs -> Oracle Business Intelligence-> Start 
BI Services option as stated above

For Other Servers

•     Navigate to < OBIEE Install Folder >/user_projects/domains/bifoundation_
domain/bin

•     Run the following command: ./startWebLogic.sh

•     Enter the weblogic credential defined during the installation.

•     Bringing up this service can take a few minutes depending on your environment, wait 
until the command line stops scrolling and indicates server in RUNNING mode.

•     Start Weblogic Managed Server (bi_server1)

•     Log in to Fusion Middleware Control http://<hostserver name or IP>:<Port 
No Default is 7001>/em using the weblogic credentials defined during installation.

•     Under the WebLogic Domain, expand the bifoundation_domain node in the 
navigation tree.

•     Select bi_cluster and click the WebLogic Cluster menu to the right of it. Select the 
Control option from the menu, and select Start Up to start the Managed Servers.

•     Verify the status of the applications.
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D. Deployment

Deploy RPD file

1. Log in to Fusion Middleware Control http://<hostserver name or IP>:<Port No 
Default is 7001>/em using the weblogic credentials defined during installation.

2. Go to Business Intelligence folder > coreapplication> Deployment and click Lock and 
Edit Configuration.

3. In the Upload BI Server Repository click Browse and locate the folder where the new OFS 
OIPIGI-PC.rpd which has to be deployed is present.

4. Now put the existing RPD Password. Then Apply >Activate Changes.

5. You can see the new Default RPD as the OIPIGI_BI0008.0
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6. Restart the BI Server as mentioned in the Starting the Analytics services section.

7. Modify the NQSConfig.INI file to incorporate User Roles and Group Id changes in case 
any GUID related error occurs. The location is < OBIEE Install Folder>

/instances/instance1/config/OracleBIServerComponent/coreapplication_
obis1

Change the FMW_UPDATE_ROLE_AND_USER_REF_GUIDS to YES.

For example: FMW_UPDATE_ROLE_AND_USER_REF_GUIDS = YES;

8. After modifying the file, restart the BI services again to remove the above error.

Deploy Web Catalog

1. Copy the OIPIGI-PC.catalog file from $FIC_HOME/OIPIGI folder

2. Go to Business Intelligence folder > coreapplication> Deployment and check for the 
Catalog name. Change to OIPIGI-PC then apply and activate changes. This will create a 
new empty catalog with the name given.

For example

$ORACLE_
INSTANCE/bifoundation/OracleBIPresentationServicesComponent/$COMPONENT_
NAME/catalog/OIPIGI-PC

3. Go to Catalog Manager. Open the newly created catalog File -> Open Catalog.

4. Open the catalog offline -> Browse to the catalog path. Click OK.
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5. Now navigate to the /shared folder in the catalog manager and unarchive by selecting the 
path where the OIPIGI-PC.catalog was present. Then press OK.

6. Verify that the OIPIGIfolder appears under /shared folder.



                                OIPIGI Configuration 8-89

7. Once the Unarchive is done. Restart the BI Presentation Services(see Starting the Analytics 
services) to apply the change. 

8. Modify the instanceconfig.xml file in case of any GUID error related to the BI 
Presentation Server to instruct Presentation Services to refresh GUIDs on restart.

The location of instanceconfig.xml file is < OBIEE Install Folder> 
/instances/instance1/config/OracleBIPresentationServicesComponent/corea
pplication_obips1

Edit the file to add the line 
<UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> and restart the BI 
presentation services once again.

9. The steps mentioned above will force the BI Presentation Services to shut down after 
updating the Account GUIDS.

In that case, go to instanceconfig.xml file and revert back the changes made, that is,  
remove the line <UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> from 
the instanceconfig.xml file and restart the services again.

E. Starting the Analytics services 

The Oracle Business Intelligence system components can start in any of the following manner.

Through OPMN controller

For Windows Server

1. Open a command prompt, navigate to <OBIEE Install 
Folder>/instances/instance1/bin

2. Run the opmnctl startall command.

For Other Servers 

1. Navigate to < OBIEE Install Folder > /instances/instance1/bin

2. Run the command ./opmnctl startall

3. Check the status by running the command ./opmnctl status
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Through Enterprise Manager

1. Login to the EM administration screen using the url http://<hostserver name or 
IP>:<Port No Default is 7001>/em

2. Expand Business Intelligence node on the left and select Core application.

3. Navigate to Capacity management > Availability.

4. Click the necessary buttons to start and stop the services.

5. In case of any problems, check for the log files present in the respective diagnostic folders 
of analytics server, that is, <OBIEE Install 
Folder>/instances/instance1/diagnostics/logs.

F. Testing the Analytics reports 

1. Log in to http:// <host server name or IP>:<Port No default is 
7001>/analytics/saw.dll?Dashboard using your Administrator credentials created 
during platform install.

2. Check for the reports availability. 
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3. In case of any problems, check for the log files present in the respective diagnostic folders 
of analytics server, that is, <OBIEE Install 
Folder>/instances/instance1/diagnostics/logs. 
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AAppendix

This chapter covers the following topics:

•     Configuring Web Server

•     Configuring Web Application Servers

Configuring Web Server
The Web Server (HTTP Server) supported in this release of OFSAA are Oracle HTTP Server, 
Apache HTTP Server, and IBM HTTP Server.

Refer the product specific installation guide to install and configure the Web Server. If an 
installation already exists, skip and proceed to the next step.

Note: Make a note of the IP Address/Hostname and Port of the web server. 
This information is required during the installation process.

Note: Refer OFSAA Secure Configuration Guide/Security Guide for 
additional information on securely configuring your Web Server.

Note: Ensure to enable sticky session/ affinity session configuration on the 
web server. Refer the respective product specific Configuration Guide for 
more details. Additionally, you also need to enable the sticky session/ affinity 
session configuration at Load Balancer level if you have configured a Load 
Balancer in front of the web server(s).

Configuring Web Application Servers
You can deploy multiple OFSAA applications on different profiles of a WebSphere application 
server. To create multiple WebSphere "Profiles", use the command line option as explained 
below. A profile is the set of files that define the runtime environment. At least one profile must 
exist to run WebSphere Application Server.

This section includes the following topics:

•     Configuring WebSphere for Application Deployment

•     Configuring WebLogic for Application Deployment

•     Configuring Apache Tomcat Server for Application Deployment



Note: Refer OFSAA Secure Configuration Guide/Security Guide for 
additional information on securely configuring your Web Application Server.
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 Configuring WebSphere for Application Deployment
You can deploy multiple Infrastructure applications on different profiles of a stand-alone 
WebSphere application server. To create multiple WebSphere "Profiles" in a stand-alone server, 
use the command line option as explained below. A profile is the set of files that define the 
runtime environment. At least one profile must exist to run WebSphere Application Server.

This section covers the following topics:

•     Creation of New Profile in WebSphere

•     Manage Applications in WebSphere

•     Delete WebSphere Profiles

•     WebSphere HTTPS Configuration

•     WebSphere Memory Settings

Creation of New Profile in WebSphere
The Profile is created in WebSphere through command line using the manageprofiles.sh which 
resides in <WebSphere Install directory>/AppServer/bin.

The command to create a profile without admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name>"

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/websphere/webs64/Appserver/profiles/mockaix 
-templatePath/websphere/webs64/Appserver/profileTemplates/default 
-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName 
ipa020dor

The command to create a profile with admin security through command line is as follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name> -enableAdminSecurity true -adminUserName 
<Admin User Name> -adminPassword < Admin User Password> -samplespassword 
<sample User Password>" 

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/websphere/webs64/Appserver/profiles/mockaix 
-templatePath/websphere/webs64/Appserver/profileTemplates/default 
-nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName 
ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword 
ofsaai -samplespassword ofsaai"



Note: While using the manageprofiles.sh command to create a New 
Profile in WebSphere, you can also use "-validatePorts" to validate if the 
specified ports are not reserved or in use. Additionally, you can specify new 
ports with "-startingPort <base port>" which specifies the starting port 
number to generate and assign all ports for the profile. For more information 
on using these ports, refer WebSphere manageprofiles command.
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Manage Applications in WebSphere
To manage the installed applications in WebSphere, do the following:

1. Open the administrator console using the following URL:

http://<ipaddress>:<Administrative Console Port>/ibm/console

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

Note: Administrative Console Port value is available in serverindex.xml 
file within <WebSphere Profile Directory>/config/cells/<Node 
Cell>/nodes/<Node Name> directory.

The Integrated Solutions Console Login window is displayed.

Figure 8–1 Integrated Solutions Console Login

2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere 
Enterprise Applications.

The Enterprise Applications screen is displayed.

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html
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Figure 8–2 Enterprise Applications

 This Enterprise Applications screen helps you to:

•     Install new application

•     Uninstall existing applications

•     Start or Stop the installed applications

Delete WebSphere Profiles
To delete a WebSphere profile, do the following:

1. Select the checkbox adjacent to the required application and click Stop.

2. Stop the WebSphere profile to be deleted.

3. Navigate to WebSphere directory:

<WebSphere_Installation_Directory>/AppServer/bin/

4. Execute the command:

manageprofiles.sh -delete -profileName <profile_name>

5. Delete profile folder.

Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_
name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry

WebSphere HTTPS Configuration
Following are the steps for configuring an HTTPS Transport on WebSphere:

1. Create a profile using the Profile Creation Wizard in WebSphere.



Note: Note down the https port specified during this process and use the 
same as servlet port or web server port during OFSAAI installation.
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2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 
OFSAAI_InstallConfig.xml for Silent mode OFSAAI installation.

WebSphere Memory Settings
To configure the WebSphere Memory Settings:

1. Navigate to Websphere applications server > Application servers > server1 
> Process definition > Java Virtual Machine.

2. Change the memory setting for Java Heap:

Initial heap size = 512

Maximum heap size = 3072

Configuring WebLogic for  Application Deployment
You can deploy multiple Infrastructure applications on different domains of a stand-alone 
weblogic application server. To create multiple WebLogic "Domains" in a stand-alone server 
you can use the Domain Creation wizard. A domain is the set of files that define the runtime 
environment. At least one domain must exist to run WebLogic Application Server.

Note:

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download 
and install patch 18729264.

This section covers the following topics:

•     Creating Domain in WebLogic Server

•     Delete Domain in WebLogic

•     WebLogic Memory Settings

Creating Domain in WebLogic Server
To create a new domain using Configuration Wizard in WebLogic, do the following:

1. Navigate to the directory <weblogic_Home Directory>/wlserver_10.3/common/bin 
and execute the command:

.\config.sh

The Welcome window of the Configuration Wizard is displayed.
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Figure 8–3 Welcome

2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere 
Enterprise Applications.

The Enterprise Applications screen is displayed.

Figure 8–4 Enterprise Applications

This Enterprise Applications screen helps you to:
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•     Install new application

•     Uninstall existing applications

•     Start or Stop the installed applications

Delete WebSphere Profiles
To delete a WebSphere profile, do the following:

1. Select the checkbox adjacent to the required application and click Stop.

2. Stop the WebSphere profile to be deleted.

3. Navigate to WebSphere directory:

<WebSphere_Installation_Directory>/AppServer/bin/

4. Execute the command:

manageprofiles.sh -delete -profileName <profile_name>

5. Delete profile folder.

Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_
name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry

WebSphere HTTPS Configuration
Following are the steps for configuring an HTTPS Transport on WebSphere:

1. Create a profile using the Profile Creation Wizard in WebSphere.

Note: Note down the https port specified during this process and use the 
same as servlet port or web server port during OFSAAI installation.

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 
OFSAAI_InstallConfig.xml for Silent mode OFSAAI installation.

WebSphere Memory Settings
To configure the WebSphere Memory Settings:

1. Navigate to Websphere applications server > Application servers > server1 
> Process definition > Java Virtual Machine.

2. Change the memory setting for Java Heap:

Initial heap size = 512

Maximum heap size = 3072

Delete Domain in WebLogic
1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain 
name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.
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3. Delete the Weblogic domain.

WebLogic Memory Settings
To configure the WebLogic Memory Settings:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh 
file, which resides in the folder <DOMAIN_HOME>/bin and in CommEnv.sh file which 
resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings depending on 
the available hardware configuration.

Example 1:

if [ "${JAVA_VENDOR}" = "Sun" ] ; then

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

else

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

Example 2:

JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring WebLogic for  Application Deployment
You can deploy multiple Infrastructure applications on different domains of a stand-alone 
weblogic application server. To create multiple WebLogic "Domains" in a stand-alone server 
you can use the Domain Creation wizard. A domain is the set of files that define the runtime 
environment. At least one domain must exist to run WebLogic Application Server.

Note:

For deployment on Oracle WebLogic Server 12.1.2+ (64 bit) with Java

8, download and install patch 18729264.

This section covers the following topics:

•     Creating Domain in WebLogic Server

•     Delete Domain in WebLogic

•     WebLogic Memory Settings

Creating Domain in WebLogic Server
To create a new domain using Configuration Wizard in WebLogic, do the following:



Configuring Web Application Servers

                       Appendix A-9

1. Navigate to the directory <weblogic_Home Directory>/wlserver_10.3/common/bin 
and execute the command:

.\config.sh

The Welcome window of the Configuration Wizard is displayed.

Figure 8–5 Welcome

2. Select Create a new WebLogic domain option and click Next.

The Select Domain Source window is displayed.
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Figure 8–6 Select Domain Source

3.  Select the Generate a domain configured automatically to support the following 
products option and click Next. 

The Specify Domain Name and Location window is displayed.

Figure 8–7 Specify Domain Name and Location
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4. Enter the Domain Name and Location. Click Browse to navigate and specify the location. 
Click Next.

The Configure Administrator Username and Password window is displayed.

Figure 8–8 Configure Administrator Username and Password

5. Enter the User name and User password to be assigned to the Administrator. Ensure that 
the password is of minimum 8 characters in length.

6. Re-enter the password for confirmation and add a brief Description. Click Next.

The Configure Server Start Mode and JDK window is displayed.
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Figure 8–9 Configure Server Start Mode and JDK

7. Select the following options: 

In the WebLogic Domain Startup Mode section, select the required mode (Development 
Mode or Production Mode).

In the JDK Selection section, select Other JDK. Click Browse and navigate to the JDK 
location. Click Next.

The Select Optional Configuration window is displayed.
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Figure 8–10 Select Optional Configuration

8. Select Administration Server. A WebLogic Server domain must have an Administration 
Server. You can also select Manages Servers, Clusters and Machines and RDBMS Security 
Store if required. Click Next.

The Configure the Administration Server window is displayed.
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Figure 8–11 Configure the Administration Server

9. Enter Administration Server details such as the Name, Listen address, Listen Port, SSL 
listen port, and SSL enabled (for secure login using https) check box. Click Next.

The Configuration Summary window is displayed.

Note: Make a note of the Listen Port or SSL Listen Port value (ex: 7007), 
since the same has to be re-entered in the Servlet port field during 
Infrastructure installation.
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Figure 8–12 Configure Server Start Mode and JDK

10. Verify the configuration details of the WebLogic domain and click Create. 

The Creating Domain window is displayed with the status indication of the domain 
creation process.
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Figure 8–13 Configure Server Start Mode and JDK

11. Click Done when complete. The domain server is created enabling the deployment of 
multiple Infrastructure applications on a single WebLogic.

Delete Domain in WebLogic
1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain 
name>/bin

2. Execute stopWebLogic.sh to stop the Weblogic domain.

3. Delete the Weblogic domain.

WebLogic Memory Settings
To configure the WebLogic Memory Settings:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh 
file, which resides in the folder <DOMAIN_HOME>/bin and in CommEnv.sh file which 
resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings depending on 
the available hardware configuration.

Example 1:

if [ "${JAVA_VENDOR}" = "Sun" ] ; then

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

else
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WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

Example 2:

JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring Apache Tomcat Server for Application Deployment
This section is applicable only when the Web Application Server type is Tomcat.

This section covers the following topics:

•     Tomcat User Administration

•     Configure Tomcat to use JAVA 64 bit Executables

•     Configure Servlet Port

•     Create Tomcat WAR Files

•     SSL Port Configuration

•     Apache Tomcat Memory Settings

•     Uninstalling WAR Files in Tomcat

•     Configuration for Axis API

Tomcat User Administration
The Tomcat administration and manager application does not provide a default login. You are 
required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed below.

This file contains an XML <user> for each individual user, which will display the username 
and password used by admin to log on to Tomcat, and the role names to which the admin user 
is associated with. For example, <user name="admin" password="admin" 
roles="standard,manager" />

1. Add the manager role to any one of the existing username/password combination as shown 
in the example above.

2. Use the same username/password to which the manager role has been assigned to access 
the Tomcat Application Manager.

3. If the Tomcat server is already running, it requires a re-start after the above configuration is 
done.

Configure Tomcat to use JAVA 64 bit Executables
1. Navigate to the "$CATALINA_HOME/bin" folder.

2. Edit the setclasspath.sh as explained below:

3. Under 'Set standard commands for invoking Java', change "$JAVA_HOME"/bin to "$JAVA_
BIN".

Example:

Edit the following block of text:
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# Set standard commands for invoking Java.

_RUNJAVA="$JAVA_HOME"/bin/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_HOME"/bin/jdb

Change it to:

# Set standard commands for invoking Java.

_RUNJAVA="$JAVA_BIN"/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_BIN"/jdb

If the Tomcat server is already running, it requires a re-start after the above configuration is 
done.

Configure Servlet Port
The Servlet Port specified during the Infrastructure installation process must be configured if 
your Web Application Server is Tomcat. If you are using the default port (8080), then you are 
not required to configure the same, since it is already configured.

If you are using a different port number, you must first configure the port in the "server.xml" 
in the "conf" directory of Tomcat Installation directory. The following steps guide you through 
the configuration process:

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag:

"Define a non-SSL HTTP/1.1 Connector on port 8080 " 

2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to 
the new port number that was used during the Infrastructure installation process. 

3. Save your changes in "server.xml".

Create Tomcat WAR Files
The WAR files are required to assemble servlets, .jsp files, web pages, and other static content 
into a deployable unit.

The following steps will guide you through the WAR files creation process:

1. On the machine in which Infrastructure Web components have been installed, navigate to 
the path $FIC_WEB_HOME.

2. Execute the command: 

./ant.sh

This will trigger the creation of WAR file - <contextname>.war. The <contextname> is 
the name given during installation.

3. On completion of the WAR files creation, a confirmation message will be displayed and 
you will be returned to the prompt.

4. The WAR file - <contextname>.war- is created on the machine on which Infrastructure 
Web components are installed under $FIC_WEB_HOME directory.

Note the following:

•     This process will not overwrite any existing version of WAR file that exists in the path. 
Rename/delete any existing war file.
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•     Proceed with the Tomcat WAR Files Deployment.

•     Log on to the server in which Tomcat is installed.

SSL Port Configuration
 Ensure that the following connect tag under "Define a SSL HTTP/1/1 Connector on 
port 8443" in "<Tomcat_installation_folder>/conf/server.xml" file is 
uncommented for SSL Configuration. (By default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"

maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note: The port mentioned as connector port is the Web Application Server 
port or servlet port in Infrastructure.

For more information related to SSL Configuration on Tomcat, refer to 
http://tomcat.apache.org/.

Apache Tomcat Memory Settings
To configure the Apache Tomcat Memory Settings, follow these steps:

1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin

2. Edit this file for customizing the memory settings and garbage collector settings depending 
on the available hardware configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

4. For example:

if [ -z "$LOGGING_MANAGER" ]; then

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"

else

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER"

fi

Uninstalling WAR Files in Tomcat
On the machine that hosts Tomcat, perform the following steps to uninstall any previously 
deployed application:

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf 
directory to avoid conflict during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:

<!--

<Context path ="/pr2test" docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" 
debug="0" reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/PR2ATM"

http://tomcat.apache.org/
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type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="pr2atm"

password="pr2atm"

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

-->

Restart the Tomcat service by doing the following:

•     Login to the "Unix server" through a terminal emulator.

•     Navigate to $catalina_home/bin directory.

•     Stop the tomcat services using the command ./shutdown.sh

•     Start the tomcat services using the command ./startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>. (https if 
SSL is enabled). The Tomcat home window is displayed.

3. Click the Manager App. The Connect to window is displayed.

4. Login with the user credentials having admin rights. The Tomcat Web Application 
Manager window is displayed with the list of all applications deployed in Tomcat.
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Figure A–1 Tomcat Web Application Manager

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation 
message is displayed on the application /Infrastructure being uninstalled.

Configuration for Axis API
This step is optional and required only if the web application server used in Apache Tomcat. If 
you use any other web application server, skip and proceed to next step.

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_
4/webapps/axis/WEB-INF/lib and place it in under <Tomcat Installation 
Directory>/lib and restart the Tomcat Server.
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BAppendix

Configuring Resource Reference in Web Application Servers
This section covers the following topics:

•     Configuring Resource Reference in WebSphere Application Server

•     Configuring Resource Reference in Weblogic Application Server

•     Configuring Resource Reference in Tomcat Application Server

Configuring Resource Reference in WebSphere Application Server
This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

•     Creating JDBC Provider

•     Creating Data Source

•     J2C Authentication Details

•     JDBC Connection Pooling

Creating JDBC Provider
1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if 
SSL is enabled). The Login window is displayed. 

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. The 
JDBC Providers window is displayed.
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Figure 8–14 JDBC Providers

4. Select the Scope from the drop-down list. Scope specifies the level at which the resource 
definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create new 
JDBC provider window is displayed.

Figure 8–15 Create a new JDBC Provider

6. Enter the following details:



Table B–1 Fields and their description

Field Description

Database Type Oracle

Provider Type Oracle JDBC Driver

Implementation Type  Connection pool data source

Name The required display name for the resource

Description The optional description for the resource
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7. Click Next. 

Figure 8–16 Enter database class path information

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use 
the trailing slash file separators. 

The Oracle JDBC driver can be downloaded from the following Oracle Download site:

•     Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers

•     Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.

Note:

Refer Appendix K for identifying the correct ojdbc<version>.jar version to be copied.

9. Click Next. The Summary window is displayed.

http://www.oracle.com/technetwork/apps-tech/jdbc-112010-090769.html
http://www.oracle.com/technetwork/database/features/jdbc/jdbc-drivers-12c-download-1958347.html
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Figure 8–17 Summary

10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Creating Data Source
The steps given below are applicable for both config and atomic data source creation.

1. Open this URL in the browser window: http://<ipaddress>:<administrative 
console port>/ibm/console. (https if SSL is enabled). The Login window is displayed. 

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click  JDBC > Data sources option. 
The Data sources page is displayed.
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Figure 8–18 Data Sources

4. Select the Scope from the drop down list. Scope specifies the level at which the resource 
definition is visible.

5. Click New. The Create a Data Source window is displayed.

Figure 8–19 Create a data source

6. Specify the Data Source name and JNDI name for the new "Data Source".



Configuring Resource Reference in Web Application Servers

B-28 Oracle Insurance Performance Application Pack             

The JNDI and Data Source name are case sensitive and ensure that JNDI name is same as 
the "Information Domain" name. 

7. Click Next. The Select JDBC provider window is displayed.

Figure 8–20 Select JDBC provider

8. Select the option Select an Existing JDBC Provider and select the required JDBC 
provider from the drop-down list. Click Next.

Figure 8–21 Enter database specific properties

9. Specify the database connection URL.

For example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the 
checkbox Use this data source in container managed persistence (CMP) is selected. 

Note: For RAC configuration, provide the RAC url specified during 
installation.

Example: jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.13)(port=1521))(ADDRESS=(PRO
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TOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(LOAD_
BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb)))

11. Click Next.

Figure 8–22 Setup security aliases

12. Map the J2C authentication alias, if already created. If not, you can create a new J2C 
authentication alias by accessing the link given (Global J2C authentication alias) or you 
can continue with the data source creation by clicking Next and then Finish.

Figure 8–23 Summary

You can also create and map J2C authentication alias after creating the data source.
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13. You must create another Data source by following the above procedure with 
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of Infrastructure.

J2C Authentication Details
The steps given below are applicable for creating both config and atomic J2C Authentication.

To create J2C Authentication details:

1. Select the newly created Data Source and click JAAS - J2C authentication data link 
under Related Items. 

JAAS- J2C authentication data

2. Click New under the Preferences section.

Figure 8–24 JAAS- J2C authentication data- New
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3. Enter the Alias, User ID, Password, and Description. Ensure the following:

•     User ID is the Oracle user ID created for the respective CONFIG and ATOMIC 
Schema for the "Information Domain".

•     Specify the CONFIG database user ID and password information for the 
jdbc/FICMASTER data source, and specify the ATOMIC database user ID and 
password information for the ATOMIC schema data source that you created earlier.

4. Click Apply and save the details.

JDBC Connection Pooling
To define the JDBC connection pooling ensure that you have created JDBC Provider and Data 
source to access the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option. 
The Data sources page is displayed.

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data 
sources>$DATA_SOURCE$>Connection pools.

Figure B–1 Connection pools

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100 
connections, and Minimum connections to 10 connections as shown in the above figure. 
You can also define Reap Time, Unused Timeout, and Aged Timeout as required.

Configuring Resource Reference in Weblogic Application Server
This section is applicable only when the Web Application Server type is WebLogic.This section 
includes the following topics:

•     Create Data Source
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•     Create GridLink Data Source

•     Configure Multi Data Sources

•     Advanced Settings for Data Source

•     JDBC Connection Pooling

•     For a Non RAC Database instance, Generic Data Source can be created. See Creating 
Data Source.

•     For a RAC Database instance, Gridlink Data Source has to be created. See Create 
GridLink Data Source.

•     When Load Balancing/Fail over is required, Multi Data Source has to be created. See 
Configure Multi Data Sources.

Create Data Source
The steps given below are applicable for both config and atomic data source creation.

1. Open the following URL in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Welcome window is displayed. 

2. Login with the Administrator Username and Password. 

Figure 8–25 Welcome

3. From the LHS menu (Domain Structure), click Services > Data Sources. The Summary of 
JDBC Data Sources window is displayed.
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Figure 8–26 Summary of JDBC Data Sources

4. Click New and select Generic Data Source option. The Create a New JDBC Data Source 
window is displayed.

You can also select GridLink Data Source or Multi Data Source while creating a Data 
Source. For more information, see Creating Data Sourceor Configure Multi Data Sources.

Figure 8–27 Create a New JDBC Data Source

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the 
drop-down list. Click Next.

Ensure the following:

•     The JNDI Name field should be in the format "jdbc/informationdomain"
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•     Same steps needs to be followed to create a mandatory data source pointing to the 
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name. 

•     JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.

•     Required "Database Type" and "Database Driver" should be selected.

Figure 8–28 JDBC Data Source Properties

6. Select the Database Driver from the drop-down list. You need to select the Database 
Driver depending on database setup, that is, with or without RAC. Click Next.

Figure 8–29 Transaction Options

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.

8. Click Next. The Connection Properties window is displayed.
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Figure 8–30 Connection Properties

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User 
Name, and Password. 

10. Click Next. The Test Database Connection window is displayed.
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Figure 8–31 Test Database Connection

11. Verify the details and click Test Configuration and test the configuration settings.

A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.

Note the following:

•     "User ID" is the Oracle user ID that is created for the respective "Information Domain".

•     "User ID" to be specified for data source with "FICMASTER" as "JNDI" name should be 
the Oracle user ID created for the "configuration schema".

13. Select the new Data Source and click the Targets tab. 
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Figure 8–32 Select Targets

14. Select the AdminServer option and click Finish.

Create GridLink Data Source
If you have selected the option, New > GridLink Data Source while creating the "Data 
Source", you can directly specify the JDBC URL as indicated.

Figure 8–33 Create a New JDBC GridLinkData Source

1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA 
Driver checkbox is not selected. Click Next.
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Figure 8–34 JDBC GridLinkData Source- Connection Properties

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The 
created "Data Source" is displayed in the list of Data Sources.

Configure Multi Data Sources
A JDBC multi data source is an abstraction around a group of data sources that provides load 
balancing and failover between data sources. As with data sources, multi data sources are also 
bound to the JNDI tree. Applications can look up a multi data source on the JNDI tree and then 
reserve a database connection from a data source. The multi data source determines from which 
data source to provide the connection.

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle 
Database to run across a set of clustered servers, then group of data sources can be created for 
instances running on a set of clustered servers and a JDBC multi data source can be created so 
that applications can look up a multi data source on the JNDI tree to reserve database 
connection. If a clustered server fails, Oracle continues running on the remaining servers.

1. Open WebLogic Admin Console  in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Login window is displayed. 

2. Login with the "User ID" that has admin rights.

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources. The 
Summary of JDBC Multi Data Sources window is displayed. 
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Figure 8–35 Summary of JDBC Multi Data Sources

4. Click New. The New JDBC Multi Data Source screen is displayed.

Note: Ensure that the Data Sources which needs to be added to new JDBC 
Multi Data Source has been created.

Figure 8–36 Configure the  Multi Data Source

5.  Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the 
drop-down list. Click Next.

Note the following:

•     The JNDI Name has to be specified in the format jdbc/infodomname. 

•     JNDI Name of the Data Sources that will be added to new JDBC Multi data source 
should be different from the JNDI name specified during Multi Data Source. 

•     Same steps needs to be followed to create a mandatory data source pointing to the 
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name for 
Data Source. 

•     JNDI Name provided in multi data source should be the same name that will be 
mentioned in the web.xml file of OFSAAI Application.
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•     You can select the Algorithm Type as Load-Balancing.

Figure 8–37 Select Targets

6. Select the AdminServer check box and click Next.

Figure 8–38 Select Data Source Type

7.  Select the type of data source which will be added to new JDBC Multi Data Source. Click 
Next.

Figure 8–39 Add Data Sources

8.  Map the required Data Source from the Available Data Sources. Click Finish.

 The New JDBC Multi Data Source is created with added data sources.

Advanced Settings for Data Source
1. Click the new Data Source from the Summary of JDBC Data Sources window. The 

Settings for <Data Source Name> window is displayed.
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2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the page, and check the Test Connection of 
Reserve checkbox (Enables Weblogic Server to test a connection before giving it to a 
client).

To verify if the data source is valid, select "Data Source name". For example, 
FICMASTER.

Figure 8–40 Settings for <Data Source Name>

4. Select the server and click Test Data Source.

A message is displayed indicating that the test was successful.

5.  Once the "Data Source" is created successfully, the following messages are displayed:

•     All changes have been activated. No restart is necessary.

•     Settings updated successfully. 

If not, follow the steps given above to recreate the data source. 

JDBC Connection Pooling
To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data 
source to access the data from the database.

1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Home 
>Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data 
Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity 
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.

3.  Click Save.

Configuring Resource Reference in Tomcat Application Server
This section is applicable only when the Web Application Server type is Tomcat.

Copy the JDBC driver file depending on your Oracle database version. As OFSAAI is certified 
on Oracle 11gR2, copy the Oracle JDBC driver file, "ojdbc6.jar" from <Oracle 
Home>/jdbc/lib and place it in <Tomcat Home>/lib.

This section covers the following topics:
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•     Create Data Source

•     JDBC Connection Pooling

Create Data Source
To create "data source" for Infrastructure application, navigate to <Tomcat Home>/conf and 
edit the following block of text by replacing the actual values in server.xml.

<Context path ="/<context name>" docBase="<Tomcat Installation 
Directory>/webapps/<context name>" debug="0" reloadable="true" 
crossContext="true">

<Resource auth="Container" 

name="jdbc/FICMASTER"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the configuration schema database>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100" 

maxIdle="30"

maxWait="10000"/>

<Resource auth="Container"

name="jdbc/< INFORMATION DOMAIN NAME >"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the database>"

password="<password for the above user id>"

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

Note the following:

Note: The <Resource> tag must be repeated for each Information Domain 
created. After the above configuration, the "WAR" file has to be created and 
deployed in Tomcat.

JDBC Connection Pooling
To define the JDBC connection pooling, do the following:

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT_
DIRECTORY/lib/.



Note:

Refer Appendix K for identifying the correct ojdbc<version>.jar version to be copied.
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2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the below 
changes, which is required for connection pooling.

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " debug="0" 
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/ $INFODOM_NAME$"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username=" $ATOMICSCHEMA_USERNAME$"

password="$ATOMICSCHEMA_PASSWORD$"

url="$JDBC_CONNECTION_URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"

logAbandoned="true"/>

</Context>

Note the following:

•     $TOMCAT_DIRECTORY$ should be replaced by Tomcat application installed path.

•     $CONTEXTNAME$ should be replaced by OFSAAI context name.

•     $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed path.

•     $INFODOM_NAME$ should be replaced by Infodom Name.

•     $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema database user 
name.

•     $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema database 
password.

•     $JDBC_CONNECTION_URL should be replaced by JDBC connection string 
jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, jdbc:oracle:thin 
10.80.50.53:1521:soluint

•     The User-IDs for configuration/atomic schemas have the prefix of setupinfo depending on 
the value set for PREFIX_SCHEMA_NAME in IP_SCHEMA_IN.XML file of Schema 
Creator Utility. 

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the schema 
name was mentioned as ofsaaconf, then the actual schema created in the database would be 
DEV_ofsaaconf.



Configuring Resource Reference in Web Application Servers

B-44 Oracle Insurance Performance Application Pack             

Class Loader Configuration for Apache Tomcat
•     Edit the server.xml available in $TOMCAT_HOME/conf/folder

•     Add tag <Loader delegate="true"/> within the <Context> tag, above the <Resource> 
tag. This is applicable only when the web application server is Apache Tomcat 8.

Note

This configuration is required if Apache Tomcat version is  8.
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CAppendix

This appendix covers the following topics:

•     Creating EAR/WAR File

•     Deploying EAR/WAR File

•     Additional Configurations

•     Installation Checklist

•     OFSAA Landing Page

Creating EAR/WAR File
This section includes the following topics:

•     Creating WebSphere EAR/WAR File

•     Creating WebLogic EAR/WAR File

•     Creating Tomcat EAR/WAR File

Creating WebSphere EAR/WAR File
The EAR files are required to assemble servlets, .jsp files, web pages, and other static content 
into a deployable unit. The EAR file is created to reflect the changes made to the web.xml file.

To create WebSphere EAR/WAR File, follow these steps:

1. Navigate to the "$FIC_WEB_HOME" directory on the machine in which Infrastructure Web 
components have been installed and execute the command:

./ant.sh

2. This triggers the creation of EAR file -<contextname>.ear. The <contextname> is the 
name given during installation.

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" 
message is displayed and you will be returned to the prompt.
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Figure C–1 Creating EAR/ WAR File

4. The EAR file - <contextname>.ear - is created on the machine on which Infrastructure 
Web components are installed under $FIC_WEB_HOME directory.

Note: This process overwrites any existing version of EAR file that exists in 
the path.

Creating WebLogic EAR/WAR File 
The EAR files are required to assemble servlets, .jsp files, web pages and other static content 
into a deployable unit. This EAR file creation is required to reflect the changes made to the 
web.xml file.

To create WebLogic EAR/WAR File, follow these steps:

1. Navigate to the path "<WEBLOGIC_INSTALL_DIR>/Bea/user_
projects/domains/<DOMAIN_NAME>/bin/".

2. Start WebLogic Domain by executing the command:

./startWeblogic.sh -d64

3. Navigate to the "$FIC_WEB_HOME" directory in the machine in which Infrastructure Web 
components have been installed.

4. Execute the command:

./ant.sh 

This will trigger the creation of EAR file - <contextname>.ear. Here <contextname> is 
the context name given during installation.
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5. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time Taken" 
message is displayed and you will be returned to the prompt.

6. The EAR file - <contextname>.ear - is created on the machine on which Infrastructure 
Web components are installed under "$FIC_WEB_HOME" directory.

Note: This process overwrites any existing version of EAR file in the path.

Creating Tomcat EAR/WAR File
The WAR files are required to assemble servlets, .jsp files, web pages, and other static content 
into a deployable unit.

To create Tomcat EAR/WAR File, follow these steps:

1. On the machine in which Infrastructure Web components have been installed, navigate to 
the path $FIC_WEB_HOME.

2. Execute the command: 

./ant.sh

This will trigger the creation of WAR file - <contextname>.war. The <contextname> is 
the name given during installation.

3. On completion of the WAR files creation, a confirmation message will be displayed and 
you will be returned to the prompt.

4. The WAR file - <contextname>.war- is created on the machine on which Infrastructure 
Web components are installed under $FIC_WEB_HOME directory.

Note the following:

•     This process will not overwrite any existing version of WAR file that exists in the path. 
Rename/delete any existing war file.

•     Proceed with the Tomcat WAR Files Deployment.

•     Log on to the server in which Tomcat is installed.

Deploying EAR/WAR File
This section covers the following topics:

•     Deploying EAR/WAR Files on WebSphere

•     Deploying EAR/WAR files for WebLogic

•     Deploying Tomcat WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment of 
Applications Pack Web Archive. This is applicable to all Web Servers 
(WebSphere, WebLogic, and Tomcat). For more information, refer Clearing 
Application Cache section.

Deploying EAR/WAR Files on WebSphere
To deploy Infrastructure application in WebSphere:
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1. Start WebSphere Profile by navigating to the path "/<Websphere_Installation_
Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and 
execute the command:

 ./startServer.sh server1

2. Open the following URL in the browser: http://<ipaddress>:<Administrative 
Console Port>/ibm/console. (https if SSL is enabled). The login screen is displayed. 

Figure 8–41 Login Window

3. Enter the user credentials which has administrator rights and click Log In.

4. From the LHS menu, select Applications and click New Application. The New 
Application window is displayed.
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Figure 8–42 New Application

5. Click New Enterprise Application. The Preparing for the application installation window 
is displayed. 

Figure 8–43 Preparing for the application installation

6. Select Remote File System and click Browse. Select the EAR file generated for OFSAAI 
to upload and install. Click Next. 
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Figure 8–44 Installation Options

7. Select the Fast Path option and click Next. The Install New Application window is 
displayed.
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Figure 8–45 Install New Application
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8. Enter the required information and click Next. The Map Modules to Servers window is 
displayed.

Figure 8–46 Map Modules to Servers

9.  Select the Web Application and click Next. The Map Resource References to Resources 
window is displayed.
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Figure 8–47 Map Resource References to Resources

10. Map each resource defined in the application to a resource JNDI name defined earlier.

11. Click Modify Resource Authentication Method and specify the authentication method 
created earlier.

You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the 
authentication method.

12. Select the OFSAAI Web Application check box and click Next. The Map Virtual hosts 
for Web Modules window is displayed.
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Figure 8–48 Map Virtual host for Web Modules

13. Select the Web Application check box and click Next. The Summary page is displayed.
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Figure 8–49 Summary

14. Click Finish and deploy the Infrastructure Application on WebSphere.

15. On successful installation, a message is displayed. Click Save and save the master file 
configuration. The details are displayed in the Master File Configuration window.

Start the application:

1. Expand Applications > Application Type > WebSphere enterprise applications. The 
Enterprise Applications window is displayed.
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Figure 8–50 Enterprise Applications

2. Select the installed application and click Start.

Note: 

? <profile name> is the profile name given while creating the WebSphere 
profile.

? <cell name > is the cell name given during profile creation 

? <contextname> is the context name given during installation.

Deploying EAR/WAR files for WebLogic
Following are the steps for deploying Infrastructure application that would be created during 
installation:

1. Navigate to the path "<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin" in the machine in which WebLogic is 
installed.

2. Start WebLogic by executing the command:

./startWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console. 
(https if SSL is enabled). The Sign in window of the WebLogic Server Administration 
Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing 
"./reveleusstartup.sh" as mentioned in Starting Infrastructure Services 
section.

4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy 
the EAR file.
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5. From the Domain Structure LHS menu, click Deployments. The Summary of 
Deployments window is displayed.

Figure 8–51 Summary of Deployments

6. Click Install. The Install Application Assistant window is displayed.

7. Select the Exploded EAR directory after browsing to the directory where it is saved and 
click Next.

Explode EAR

To explode EAR, follow these steps:

1. Create the "applications" folder under domain name. For example, "/Bea/user_
projects/domains/ <Domain _name>/applications".

2. Create <context_name>.ear folder under "applications" folder. 

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/.

4. Explode the <context_name>.ear file by executing the command:

jar -xvf <context_name>.ear

5. Delete the <context>.ear and < context >.war file (recently created).

6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_DIR>/Bea/user_
projects/domains/<DOMAIN_NAME>/applications.
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7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear/.

8. Explode the <context_name>.war file by executing the following command to get the 
directory structure:

jar -xvf <context_name>.war
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Install Application

To install Application: 

1. Open the Install Application Assistant. 

Figure 8–52 Install Application Assistant

2. Click Next. 

Figure 8–53 Install Application Assistant 

3. From the Choose targeting style section, select the Install this deployment as an 
application option and click Next. The Optional Settings window is displayed.
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Figure 8–54 Optional Settings

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles and 
policies that are defined in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location option 
under the Source accessibility section. 

7. Click Next to continue. The Deployment Summary window is displayed.
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Figure 8–55 Deployment Summary

8. Select the Yes, take me to the deployment's configuration screen option and click 
Finish. The Settings for <Deployment Name> window is displayed.
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Figure 8–56 Settings for <Deployment Name>

9. Review the general configuration details of the deployment. You can also update the 
configuration of the deployment in this window. In the Overview tab, you can view the 
complete deployment configuration.

10. Click Save to update the changes, if any.



Deploying EAR/WAR File

                      Appendix C-63

11. From the LHS menu, click Deployments. The Summary of Deployments window is 
displayed.

Figure 8–57 Summary of Deployments

12. Select the newly deployed Infrastructure application and click Start > Servicing all 
requests. Ensure that the Infrastructure server is up and running.
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Figure 8–58 Summary of Deployments

The State of the deployed application will be displayed as Active if started successfully.

Deploying Tomcat WAR Files on Tomcat
Before deploying the WAR files, ensure that the previously deployed applications of 
Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for 
the procedure to uninstall the previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow the steps outlined to deploy Infrastructure 
application:

1. Open the URL in Browser window: http://<IP address>:<Tomcat server port>. 
(https if SSL is enabled). The Tomcat home window is displayed.
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Figure 8–59 Tomcat home 

2. Click Manager App. The Connect to dialog box is displayed.

3. Enter the User Id and Password that has admin rights and click OK. (For user creation in 
tomcat, see "Tomcat User Administration". The Tomcat Web Application Manager window 
is displayed with the list of all the applications deployed.
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Figure 8–60 Tomcat Web Application Manager

4. In the Deploy section, enter the Context Path provided during the installation as 
"/<context-name>".

5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_
HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.

On successful application deployment, a confirmation message is displayed.

•     For information on starting the Tomcat server, see Starting Infrastructure Services.

Additional Configurations
Refer to the following sections for detailed module specific post installation configurations.

This section covers the following topics:

•     FTP/SFTP Configuration for Excel/Document Upload

•     Configuration for Dimension and Hierarchy Management

•     Configure Infrastructure Server Memory

•     Internet Explorer Settings

•     Retrieve Patch Information

•     OLAP Data Server Configuration

•     Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance

•     Configure OFSAAI Web Services

•     Deploy OFSAAI Web Services

•     Configuration to Enable Parallel Execution of DML statements
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•     Configure Message Details in Forms Designer

•     Clearing Application Cache

•     Changing the CONFIG/ ATOMIC Schema passwords

•     Configure Java Virtual Machine

•     Configure Internal Service (Document Upload/Download)

FTP/SFTP Configuration for Excel/Document Upload
In OFSAA, certain modules require transfer of files from the web application server to the 
OFSAA server over SSH.   Follow these steps to ensure the OFSAA server recognizes the web 
application server during file transfers.

1.   Login to the web application server.

Example: <App Layer path>scp nohup.out <user>@<Web Server 
path>:/export/home/<user>

2. Type sftp <user>@<OFSAA Server>

3. Specify Yes when prompted for permission. Are you sure you want to continue connecting 
(Yes/No)? 

4.  This will add an entry into the "known_hosts" file.

5. A confirmation message is displayed: Permanently added <OFSAA Server> RSA) to the 
list of known hosts..

Configuration for Dimension and Hierarchy Management
These configuration changes are applicable when Dimension Management features provided in 
OFSAAI are used. You can open AMHMConfig.properties file present in the $FIC_WEB_
HOME/webroot/conf directory to set the properties for the following:

•     Configure Member Deletion

•     Configure Attribute Default Date Format

•     Configure Members Reverse Population

•     Configure Members Reverse Population

•     Configure Maximum Levels allowed in Hierarchies

•     Configure Node Limit for a Hierarchy Tree

Configuration for Dimension and Hierarchy Management has to be done only after the 
application/solution installation is done. The properties specific to Information Domain are:

•     $INFODOM$=<Name of the Information Domain>

•     $DIMENSION_ID$=<Dimension ID for which the property to be set>

Configure Member Deletion
This property should be set to allow the user to delete the Members for the Dimension.



Table C–1  Member Deletion Configuration

Value Code Example

# Member Deletion 
Configuration - VALUE- Y/N

MEMBER_
DEL-$INFODOM$-$DIMEN
SION_ID$=$VALUE$

MEMBER_
DEL-ORAFUSION-1=Y
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Configure Attribute Default Date Format
This property should be set to display the Default Date Format for Date type Attribute in 
Attributes window.

Table C–2  Attribute Default Date Format

Value Code Example

# Attribute Default Date 
Format - DB_DATE_
FORMAT:DD-MON-YYYY

ATTR_DEF_DATE_
FORMAT-$INFODOM$=$D
B_DATE_FORMAT$

ATTR_DEF_DATE_
FORMAT-ORAFUSION=DD/
MON/YYYY

Configure Members Reverse Population
This property should be set for reverse population of Members for the Dimensions in required 
Information Domains.

Table C–3  Members Reverse population

Value Code Example

# Members Reverse 
population - VALUE- Y/N

MEMBER_REVERSE_
POP-$INFODOM$-$DIMEN
SION_ID$=$VALUE$

MEMBER_REVERSE_
POP-ORAFUSION-1=Y

Configure Hierarchy Reverse Population
This property should be set for reverse population of Hierarchies for the Dimensions in 
required Information Domains.

Table C–4  Hierarchy Reverse population

Value Code Example

#Hierarchy Reverse 
population - VALUE- Y/N

HIERARCHY_REVERSE_
POP-$INFODOM$-$DIMEN
SION_ID$=$VALUE$

HIERARCHY_REVERSE_
POP-ORAFUSION-1=Y

Configure Maximum Levels allowed in Hierarchies
This property is required to set the maximum levels allowed to build the Hierarchies tree 
structure.

Table C–5  Hierarchy Maximum level allowed

Value Code Example

#Hierarchy Maximum level 
allowed for the hierarchy in 
particular Information Domain 
- VALUE - Integer number

MAX_
DEPTH-$INFODOM$=$VAL
UE$

MAX_DEPTH-FUSION=15
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The Maximum Levels allowed in the hierarchies is less than or equal to 15. If the Hierarchy 
Reverse population is set as "Y" and more than 15 levels are created. Then an alert is displayed 
as "The number of levels exceeding the limit".

If the maximum level allowed is set as more than 15 and hierarchy reverse population is set as 
"Y" then an error is displayed as "Error occurred in Reverse populating the hierarchy".

Configure Node Limit for a Hierarchy Tree
This property is required to display the Hierarchy as a small or a large hierarchy. If the tree 
node limit exceeds the set limit, the Hierarchies are treated as large Hierarchy.

Table C–6  Hierarchy Tree node limit

Value Code Example

#Tree node limit for the 
hierarchy - Values is Integer 
number

TREE_NODE_
LIMIT=$VALUE$

TREE_NODE_LIMIT=30

Configure Infrastructure Server Memory
The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic 
can be edited for customizing memory settings and garbage collector settings depending on the 
available hardware configuration as explained below. These settings are base minimum and has 
to be incremented considering the deployment metrics into account. The increments are usually 
handled in multiples of 128mb for heap and 64mb for stack.

Infrastructure Application Server Memory Settings
You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector 
settings depends on the hardware configuration.

This has a default value X_ARGS="-Xms200m"

X_ARGS=" "$X_ARGS" $DELIM -Xmx2048m"

Note: This parameter is modified in 7.3.2 IR and you need to modify X_
ARGS_APP variable in the .profile file to customize Java Memory Settings 
for Model Upload based on the Data Model size.

Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet Explorer, that 
is, 100%. 
Cookies should be enabled.

The following browser settings have to be specified at every client machine prior to accessing 
the Infrastructure application.

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window 
is displayed.
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2. Click the Settings button. The Settings window is displayed.

3. Select the option Everytime I Visit the webpage and click OK.

Figure C–2 Internet Options

4. In the Internet Options window, select the Security tab and select the Internet option 
under Select a zone to view or change the security settings.

5. Click Default Level under Security level for this zone.



Additional Configurations

                      Appendix C-71

Figure C–3 Internet Options

6. Click OK to save.

7. Click Internet Explorer >> Tools >> Compatibility View Settings.

8. Enter the OFSAA setup URL in the Add this website field.

9. Click Add.

10. Ensure the URL is listed under Websites you've added to Compatibility View.

11. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up 
Blocker option under Pop-up Blocker settings.
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Figure C–4 Internet Options- Popup Blocker Settings

12. Click Settings. The Pop-up Blocker Settings window is displayed.

13. Enter the URL of the OFSAA Application in the Address of Website to Allow field.

14. Click Add. The OFSAA URL is displayed in the Allowed Sites section.

15. Click Close.

16. Click OK in the Internet Options window.

Retrieve Patch Information
To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.

2. Navigate to Object Administration tab.

3. Click System Utilities.

4. Click Patch Information.

5. The page displays the list of patches installed on the OFSAA setup across 
Applications/Platform.
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OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAAI.

The following parameters must be set to ensure that the system limitations are not exceeded at 
any stage. The values for these OS parameters should be specified based on the expected load 
at each implementation site.

Example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

•     Sort Buffer settings: This must be set at the Essbase application level appropriate to the 
anticipated load.

•     Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data 
Services that is communicating with an OLAP Data Server, it is imperative to ensure that 
the cleanup of the old instance is completed on the OLAP Data Server before restarting the 
OFSAAI Server. Pause for a period of time based on the load the system was subjected to, 
before restarting the Data Services subsystem.

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
For information on this section, refer OFS Analytical Applications Infrastructure 
Administration User Guide in OTN.

OFSAAI Setup Information Fetching Tool
Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the 
related information about the OFSAAI Set up such as Operating System Name and version, 
Database Type and Version, OFSAAI architecture, Log file locations and so on.

To execute "SetupInfo.jar" in console:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Encryption Changer
This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the 
encrypted values of the OFSAAI setup according to the new key.

To execute EncryptC.jar in console:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar EncryptC.jar

A confirmation message is displayed after execution.

Once executed, you need to create and deploy the EAR / WAR file depending on the configured 
Web Application Server. For more information, see , "Configuring Web Application Servers".

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Infrastructure LDAP Configuration
This provides you with the option of using LDAP (Lightweight Directory Access Protocol) 
authentication or Infrastructure SMS authentication for logging on to Infrastructure.

If you are using the Infrastructure authentication, the user and user group details, profile 
creation, function and role maintenance and other mappings can be done through the 
Infrastructure Administration module under Security Management. The data in this case, will 
be updated in the CSSMS table.

However, if you wish to use LDAP for user authentication, then you have to ensure that the 
LDAP server is installed and configured. Also make sure that OPEN LDAP 2.2.29+ is installed 
and configured in Windows machine. Before doing the following configuration, it is required to 
select the "Authentication type" as LDAP in the Configuration screen of Infrastructure. This 
screen can be accessed by selecting System Configuration > Configuration in the LHS menu of 
Infrastructure. In the Windows machine in which LDAP Server is installed, go to the 
OpenLDAP installation directory through the command prompt and execute the command 
"slapd -d 1" to start the LDAP server.

Configure Infrastructure "Configuration Schema"
In the Infrastructure "configuration schema", ensure the following entries in Configuration 
Table.

Table C–7  Configuration Schema

PARAMNAME Description PARAM Value Example

AUTHENTICATIONTYPE Authentication type 2 - AUTHENTICATIONTYPE value 
must be 2 for LDAP

ROOTCONTEXT The Root Context for the 
LDAP Directory

dc=<Reveleus>, dc=<com>

ROOTDN The Root dn for LDAP 
directory

cn=<Manager>, dc=<Reveleus>, 
dc=<com>

ROOTPASS Password for the Root <secret>

LDAPURL LDAP URL <ldap://10.11.12.13.1234/>

LDAP_SSL_MODE LDAP in SSL Mode N for non - SSL and Y for SSL

HASHPASS Should the user password 
be Hashed

FALSE or TRUE.

When HASSPASS is set as FALSE, we 
need to have the ROOTDN value as 
"uid=ORCLADMIN, ou =Users, 
dc=OFSAAI, dc=com". ORCLADMIN is 
a dummy user, it will be replaced 
dynamically with the logged in user.

When HASSPASS is set as TRUE, we 
need to have the ROOTDN value as 
"cn=orcladmin, cn=Users, 
dc=i-flex,dc=com" and proper 
oracladmin LDAP password as 
ROOTPASS. First OFSAAI connects to 
LDAP directory using orcladmin user 
and fetches the login user details and 
verifies the entered password.

RETRIEVE_DN To  re t r i e v e  

Distinguished Name

TRUE



Note: ROOTCONTEXT, ROOTDN, and ROOTPASS entries should be 
same as in the slapd.conf file.
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Configure OpenLDAP Files
1. Copy the reveleusSchema.schema from <Infrastructure Installation 

Directory> /ficapp/common/FICServer/conf/LDAP_LDIF folder to LDAPServer 
Schema folder.

2. Copy the Domains.ldif and Reveleus.ldif files from <Infrastructure 
Installation Directory>/ficapp/common/FICServer/conf/LDAP_LDIF folder to 
OpenLDAPServer folder.

Note: Make sure that the ROOTCONTEXT in the Domains.ldif and 
Reveleus.ldif files are the same as slapd.conf file.

3. Provide the appropriate entries for ROOTDN, ROOTPASS, and ROOTCONTEXT in 
slapd.conf file in the OpenLDAPServer folder.

4. Add the text "include schema/reveleusSchema.schema" as the first line of the slapd.conf 
file 

Note: The above steps of the configuration are for OpenLDAP Server only. If 
you need to configure Infrastructure for any other LDAP Server, you will 
have to make the changes appropriately.

5. In the command prompt, navigate to the LDAP installation directory and execute the 
command "ldapadd -D"ROOTDN"  -w ROOTPASS -f/data/Reveleus.ldif"

This is for creating the entries for Users, User Groups, Functions, Profiles, Segments, 
Domains, Roles, and HolidayMaster in the Data information Tree of LDAP.

6. Make an entry in the Domains.ldif file for each Information Domain that is created 
through the Infrastructure UI.

To add an entry corresponding to the new Information Domain to the Domains.ldif file, add 
the following block of text with the appropriate values:

Note: DSNID refers to Information Domain name.

dn: DSNID=<DSN ID>,ou=Domains,@LDAP_DIRECTORY_ROOTCONTEXT@

changetype: add

mappedsegments: <Mapped segments/~>

dsnid: <DSN ID>

infodomname: < Information Domain Name>

objectClass: Infodom

objectClass: top

infodomdescription: < Information Domain Description>

Example:
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dn: DSNID=FUSIONMOCK, ou=Domains, dc=FTP1,dc=com

mappedsegments: ~

dsnid: FUSIONMOCK

infodomname: FUSIONMOCK

objectClass: Infodom

objectClass: top

infodomdescription: FUSIONMOCK

Then, navigate to LDAP installation directory and execute the command "D"ROOTDN"  -w 
ROOTPASS -f/data/Domains.ldif"

Note: You can add entries for multiple Information Domains at the same 
time.

Migrate Data from CSSMS tables to LDAP server
If you are using LDAP authentication, it is required to migrate all the details from the CSSMS 
table, which contains the information entered using the Infrastructure Administration module 
under Security Management to the LDAP Server.

To migrate data from CSSMS tables to LDAP server:

1. Invoke the LDAP_Migration.sh file in $FIC_HOME/MigrationUtilities/Migration_
LDAP/ bin folder. The Select Source & Destination for Migration window is displayed 
with the option to migrate the data from SMS to LDAP or vice versa.

Figure 8–61 Select Source & Destination for Migration

2. Select the SMS to LDAP option and click OK. The Select Entities to Migrate window is 
displayed.
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Figure 8–62 Select Entities to Migrate

You can select the data that you wish to migrate such as Users, User Groups, Functions, 
Roles, Segment, Profiles, Holiday Master, Function Role Maps, User - User Group Maps, 
User Group Role Map, and User Group- Domain Map.

3. Select the entities that you wish to migrate and click Migrate. The data is migrated and a 
confirmation dialog is displayed.

You can verify the data migrated to LDAP server through the LDAP Browser.

Note: You should also enter the passwords for all the users as passwords are 
not migrated in migration process.

Configure OFSAAI Web Services
Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or 
"synchronously" execute requested tasks offered by OFSAAI. The configuration steps given 
below are to be done only if you are using the Web Services feature of OFSAAI.

Configure DynamicWSConfig.xml File
For each third party web service that needs to be accessed using the OFSAAI Web services 
framework and the operations to be invoked, corresponding entries are to be made in the 
DynamicWSConfig.xml template file.

The variable <WebServer> denotes any one of the application server, i.e. WebSphere, 
WebLogic, or Tomcat.

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation 
Directory>/EXEWebService/ <WebServer>/ROOT/conf directory. This file can be placed 
in any directory that is accessible by the application and this location must be specified in the 
web.xml file, as WSCONFIGFILE parameter.
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The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/ 
EXEWebService.ear/EXEWebService.war/conf directory

This template is given below:

<XML>

<WEBSERVICES>

<WEBSERVICE CODE="$CODE"

ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"

XMLNS_XSD="$XMLNS_XSD" ENCODINGSTYLE="$ENCODINGSTYLE"

SERVICENAME="$SERVICENAME" PORTTYPENAME="$PORTTYPENAME"

SESSION_MAINTAIN_PROPERTY="$SESSION_MAINTAIN_PROPERTY"

USERNAME="$USERNAME"

PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE"

STUBIMPLEMENTATION="$STUBIMPLEMENTATION">

<OPERATION CODE="$CODE"

NAME="$NAME"

SOAPACTION="$SOAPACTION"

STYLE="$STYLE"

PACKAGENAME="$PACKAGENAME">

<INPUT ORDER="$ORDER"

PARAMNAME="$PARAMNAME"

ARGTYPE="$ARGTYPE"

CLASSNAME="$CLASSNAME"/>

<OUTPUT PARAMNAME="$PARAMNAME"

RETURNTYPE="$RETURNTYPE"

CLASSNAME="$CLASSNAME"/>

</OPERATION>

</WEBSERVICE>

</WEBSERVICES>

</XML>

The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be updated 
depending on the web service chosen and the mode of accessing it. For each Web service to be 
accessed, the entire webservice tag in the DynamicWSConfig.xml file must be repeated. The 
placeholders tabulated below should be set in accordance to the parameters published in the 
third party wsdl files (webservices) to be accessed. The stub class specified must implement 
the "com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF" interface.

Attributes for WEBSERVICE tag

Table C–8  WEBSERVICE tag

Placeholder Description

$CODE Unique number within the xml file and cannot be 999 or 0.
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Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.

Table C–9  OPERSTION tag

Placeholder Description

$CODE Should be unique within the Webservice tag.

$NAME The name of the Function that is to be called by the wsdl file.

$SOAPACTION The URL for the Operation to access. This is associated with the 
Operation tag of the wsdl file.

$STYLE This can take "rpc" if the web services invoking is in DII 
mode or "stub" if it is in static mode. This is a mandatory 
parameter.

$PACKAGENAME Represents the JAXB package of input object.

Attributes for INPUT tag

$ENDPOINT soap: address location in the wsdl: service name tag of the 
wsdl file.

$TARGETNAMESPACE The attribute value for the targetNamespace of the wsdl: 
definitions tag.

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions tag

$ENCODINGSTYLE The attribute value for the xmlns:soapenc of the 
wsdl:definitions tag.

$SERVICENAME Name of the service found under the wsdl:service name tag of 
the wsdl file.

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file.

$SESSION_MAINTAIN_PROPERTY This could be given as "" also.

$USERNAME User name to access the web services. Enter "" if no user name is 
required.

$PASSWORD Password to access the web services. Enter "" if no password is 
required.

$WEBSERVICESTYLE This can take either "rpc" in case of DII mode of invoking web 
services or "stub" in case of static mode. This is a mandatory 
parameter.

$STUBIMPLEMENTATION Fully qualified class name (package name.classname).

Table C–10   INPUT tag

Placeholder Description

$ORDER The sequential number of the INPUT tag. Should start 
from 0. This is in line with the input order of the 
arguments that the API accepts which is called by this 
operation.

$PARAMNAME Input parameter name to be called by the wsdl file.

$ARGTYPE Input Parameter Data Type. If the input argument type is 
complex object, specify $ARGTYPE as "xmlstring".

Table C–8 (Cont.) WEBSERVICE tag

Placeholder Description
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Attributes for OUTPUT tag

Table C–11  OUTPUT tag

Placeholder Description

$PARAMNAME Output parameter name to be returned by the web 
service.

$RETURNTYPE Output parameter Data Type. If the web service response is a 
complex object, then specify $RETURNTYPE as "object".

$CLASSNAME Represents class name of output object parameter.

web.xml Entries
1. This step is optional and required only if the web application server used is Tomcat. In case 

of any other application server, skip and proceed with next step.

Navigate to $FIC_HOME/webroot/WEB-INF/ and edit the web.xml file. Set parameter 
value DOCSERVICEAPP to EXEWebServiceAXIS.

2. Navigate to <OFSAAI Installation 
Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit the web.xml file 
as explained below.

Note:

In case of Java 7 when WebLogic is used as web application server replace following 
line of <OFSAAI Installation 
Directory>/EXEWebService/Weblogic/ROOT/WEB-INF/web.xml file that is

<?xml version='1.0' encoding='UTF-8'?>

<web-app id="WebApp_ID" version="3.0"

xmlns="http://java.sun.com/xml/ns/javaee"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:schemaLocation="http://java.sun.com/xml/ns/javaee

http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd" 
metadata-complete="true">

with

<?xml version='1.0' encoding='UTF-8'?>

<web-app xmlns="http://java.sun.com/xml/ns/j2ee"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

Entry for WSConfig File

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer Deployment 
Path>/ EXEWebService.ear/EXEWebService.war/conf directory. This file can be placed 
in any directory that is accessible by the application.

The path where the WSCONFIG file is placed must be specified in place of 
$WSCONFIGFILELOCATION$ in the below block of text in web.xml.

$CLASSNAME Represents class name of input object parameter.

Table C–10 (Cont.)  INPUT tag

Placeholder Description
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<context-param>

<description>WebServices Configuration File</description>

<param-name>WSCONFIGFILE</param-name>

<param-value>$WSCONFIGFILELOCATION$</param-value>

<!--Specify the Location of DynamicWSConFig.xml-->

</context-param>

Proxy Settings

The following block of text in web.xml file, replace the <param-value> given in bold below 
with appropriate values.

If no values are required, leave the <param-value> blank.

<context-param>

<description>http Proxy Host</description>

<param-name>http.proxyHost</param-name>

<param-value>$PROXYHOST$</param-value>

<!-- Specify the IP address or hostname of the http proxy server-->

</context-param>

<context-param>

<description>http Proxy Port</description>

<param-name>http.proxyPort</param-name>

<param-value>$PROXYPORT$</param-value>

<!--Port Number for the Proxy Server-->

</context-param>

<context-param>

<description>http proxy UserName</description>

<param-name>http.proxyUserName</param-name>

<param-value>$PROXYUSERNAME$</param-value>

<!-- User ID To get authenticated by proxy server-->

</context-param>

<context-param>

<description>http proxy Password</description>

<param-name>http.proxyPassword</param-name>

<param-value>$PROXYPASSWORD$</param-value>

<!-- User Password To get authenticated by proxy server-->

</context-param>

<context-param>

<description>http non-ProxyHosts</description>

<param-name>http.nonProxyHosts</param-name>
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<param-value>$NONPROXYHOST$</param-value>

<!--Hosts for which the proxy settings should get by-passed (Note: 
Separate them by "|" symbol) -->

</context-param>

OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI installation and 
should be accessible.

Replace $FIC_HOME$ in the following block of text in web.xml with <WebServer 
Deployment Path>/EXEWebService.ear/EXEWebService.war.

<context-param>

<description>OFSAAI Web Home</description>

<param-name>FIC_HOME</param-name>

<param-value>$FIC_HOME$</param-value>

<!--OFSAAI Installation Folder-->

</context-param>

<context-param>

<description>OFSAAI Web Home</description>

<param-name>FIC_PHYSICAL_HOME</param-name>

<param-value>$FIC_HOME$</param-value>

<!--OFSAAI Installation Folder-->

</context-param>

DynamicWSConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web services 
framework, and the operation to be invoked, make corresponding entries into this file. This file 
is to be placed in the location that is specified in the web.xml, as WSCONFIGFILE parameter.

Deploy OFSAAI Web Services
You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web 
Services as part of the installation.

1. Complete the manual configuration of OFSAAI Web Services.

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> and 
execute the command:

./ant.sh

This will trigger the EAR/WAR file creation, which is required for the deployment. 

3. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the WebServer.

If you have already configured OFSAAI Web Services as part of the installation, deploy the 
generated EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI Deployment 
area in WebServer profile.
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Configuration to Enable Parallel Execution of DML statements
A configuration file, OracleDB.conf has been introduced to accommodate any configurable 
parameter related to operations on oracle database. If you do not want to set a parameter to a 
specific value, then the respective parameter entry can be removed/commented off form the 
OracleDB.conf file which resides in the path $FIC_DB_HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML 
operation if parallel DML is explicitly enabled in the session with the ENABLE PARALLEL 
DML clause of the ALTER SESSION statement. The default mode of a session is DISABLE 
PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not set, then the default degree, 
as decided by Oracle will be used.

Configure Message Details in Forms Designer
You can configure the Message Details in Forms Designer under Data Entry Forms and Queries 
module by updating the details of mail server in the "NotificationConfig.cfg" file which 
resides in the path $FIC_APP_HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message details 
are included in Administration > Security Management > User Administrator > User 
Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Table C–12  NotificationConfig.cfg File

Parameter Description

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server.

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true', 
otherwise set value to 'false'.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be 
authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if 
authentication is not required use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if 
authentication is not required use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that ID 
need to be added. Exchange server forces you set a valid 
ID that is there in the exchange server. (Based on 
Security settings)

Ensure that the authorized User details are included in Administration > Security Management 
> User Administrator > User Maintenance window.

Clearing Application Cache
This is applicable to all Web Servers (that is,  WebSphere, WebLogic, and Tomcat). 

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, 
navigate to the following path depending on the WebServer configured and clear the cache:

•     Tomcat: <Tomcat installation 
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp
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•     WebLogic: <Weblogic installation location>/domains/<Domain 
name>/servers/<Server name>/tmp/_WL_user/<Application name>/qaelce/jsp_
servlet

•     WebSphere: <Websphere installation 
directory>/AppServer/profiles/<Profile name>/temp/<Node 
name>/server1/<Application name>/<.war file name>

Changing the CONFIG/ ATOMIC Schema passwords
This section explains about how to modify the OFSAA Infrastructure Config Schema and 
Atomic Schema passwords.

OFSAA Infrastructure Config Schema password modification
To change the Config Schema password, perform the following steps:

1. Change the Config schema User Password in the database.

2. Delete the $FIC_HOME/conf/Reveleus.SEC file.

3. Shutdown the OFSAAI App service:

cd $FIC_APP_HOME/common/FICServer/bin

./reveleusshutdown.sh

4. Start the Infrastructure Server in foreground directly on the server or through X-Windows 
software using the command:

./reveleusstartup.sh

5. At the prompt, enter System Password. Enter the "new Config schema" password. The 
service will start and initialize itself if it is able to successfully connect to the DB.

6. Post successful startup of the service, if required, the Infrastructure server may be shut 
down and restarted in the background using nohup mode.

OFSAA Infrastructure Atomic Schema password modification
To change the Atomic Schema password, perform the following steps:

1. Change the Atomic schema User Password in the database.

2. Login to the application from the browser using SYSADMN account or any user id, which 
has System Administrator role mapped.

3. Navigate to System Configuration > Database Details window. Select the appropriate 
connection and edit the password.

4. Navigate to Data Management Tools >Data Sources> Source Designer window. Update the 
password of the appropriate Source.

5. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag 
details in Server.xml file from the $CATALINA_HOME/conf folder. (In case of Tomcat 
only Atomic <Resource> will exist).

If you are using WebSphere as Web server:

a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated 
on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this case, both 
Config and Atomic data sources will need to be modified).
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If you are using WebLogic as Web server:

a. Login to the WebLogic Administration Console, from the left side menu

b. Under Domain Structure list box, expand the appropriate Domain and navigate to 
Services > JDBC >Data Sources. A list of data sources will be populated on the right 
side. 

c. Select the appropriate Data Source and edit the connection details. (In this case, both 
Config and Atomic data sources need to be modified).

6. Restart the OFSAAI services.

Configure Java Virtual Machine
While running several database intensive tasks in parallel, fetching the database connection 
from connection pool may face an error. To ensure no such error is encountered, add the line 
securerandom.source=file:/dev/./urandom in the java.security configuration file 
available in $JAVA_HOME/jre/lib/security/ path.

This needs to be configured only on the machine where the OFSAAI database components 
(ficdb layer) are installed.

Configure Internal Service (Document Upload/Download)
This step can be ignored if it has already been configured as part of any previous IR/ML 
installation. The Document Upload/Download feature has undergone a change and can now be 
configured to use Internal service for document upload / download instead of the earlier 
ExeWebService.To facilitate Internal service for document upload/ download, perform the 
following configurations:

1. Create the folders download, upload, TempDocument, and Temp in the local path  of 
Web application server and provide Read/Write permission.

•     To find the exact location, execute the following query in CONFIG schema: 

select localpath from web_server_info

•     To create folders with Read/Write permission, execute the command:

mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write 
permission.

•     To find the exact location, execute the query in CONFIG schema:

select ftpdrive from app_server_info

•     To create folder with Read/Write permission, execute the command:

mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to 
FALSE in the Configuration table in CONFIG schema and hence the application 
“ExeWebService” will not be used. It is recommended that the value to be set to FALSE and 
use the Internal service for document upload/downloads. If you intend to continue using the 
External ExeWebService, set the value to TRUE.

Navigate to $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier and 
type ./ant.sh. This triggers the creation of EAR/WAR file  EXEWebService.ear/.war. The 
EAR/WAR file EXEWebService.ear/.war will be created  in $FIC_
HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier.  Redeploy the generated 
EAR/WAR file onto your configured web application server.
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Installation Checklist
Before starting on the OFSAAI Installation Kit, ensure that the following pre-installation 
activities checklist is completed successfully. It is recommended to take a print out of the 
checklist and follow the checklist step by step.

Table C–13  General, Pre-Install, Install, and Post Install) Checklist

Step No Task Done

General

1 Check the OFS Insurance Performance 
Release Notes and Read Me document 
for any additional steps to be performed 
on OFS Insurance Performance Pack or 
OFSAAI.

Note: For more details, contact Oracle 
support.

Yes/No

Insurance Performance Application  Pre Installation + During Installation

1 Prior to installation, ensure that 
sufficient free temp space (minimum 1 
GB free) is available in /tmp directory of 
unix server hosting OFSAAI.

Yes/No

CRR Application Pack Post Installation

1 Perform post-installation steps. For more 
information, refer to Post Installation.

Yes/No

OFSAA Landing Page

Figure C–5 OFSAA Landing Page
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Infrastructure can be accessed through your web-browser as soon as the System Administrator 
(SA) installs and configures Oracle Financial Services Analytical Applications Infrastructure.

The SA will provide you  a link through which you can access Oracle Financial Services 
Analytical Applications Infrastructure. You can access the Infrastructure application login 
screen through your web-browser using the URL: <IP Address of the Web Server > 
:<servlet port>/<context name>/login.jsp.

You can also login to the Infrastructure application with the host name instead of the IP 
address. To do this, it is necessary to have the host name mapped to the IP address in the hosts 
file the client Windows machine. The hosts file will be in %systemroot%\system32\ 
drivers\etc\ directory.

OFSAAI Login
While accessing Oracle Financial Services Analytical Applications Infrastructure, the Splash 
screen is as displayed:

Figure C–6 OFSAAI Login Page

You can select the required language from the Language drop-down list. The language options 
displayed in the drop-down list are based on the license. Based on the Language selected, the 
appropriate language login screen is displayed.

Enter the User ID and Password provided by the System Administrator and click Login. You 
will be prompted to change your password on your first login. Alternatively, you can also 
choose to change your password any time.
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Figure C–7 OFSAAI Login Page

 

In the Change Password screen, enter a new password, confirm it and click OK to view the 
Splash screen. Refer to the following guidelines for Password Creation:

•     Passwords are displayed as asterisks (stars) while you enter. This is to ensure that the 
password is not revealed to other users.

•     Ensure that the entered password is at least six characters long.

•     The password must be alphanumeric with a combination of numbers and characters.

•     The password should not contain spaces.

•     Passwords are case sensitive and ensure that the Caps Lock is not turned ON.

•     By default, the currently used password is checked for validity if password history is not 
set.

•     New password should be different from previously used passwords based on the password 
history which can be configured.

•     If you encounter any of the following problems, contact the System Administrator:

•     Your user ID and password are not recognized.

•     Your user ID is locked after three consecutive unsuccessful attempts.

•     Your user ID has been disabled.

•     Guest user cannot change the password.

Activating/Enabling a Product within an Application
Each product is marketed by a separate team and which is headed by a Sales Manager who 
reports to the Sales Head. Each Sales Manager in turn has two Sales Officers who are 
responsible for sales and profitability of the product. 

The Sales Head has decided that the Sales Officer of each product will not have access to the 
information of other products. However, each Sales Manager will have access to Sales figures 
of the other products.
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Using the Oracle Financial Services Analytical Applications Infrastructure Security Hierarchy 
feature, Administrator can provide information security at hierarchy level by defining security 
options for each hierarchy node. Thus, the Bank can control access of information at a node 
level and not increase the overheads.

This is how it is done in Oracle Financial Services Analytical Applications Infrastructure:

•     Firstly, the users are created in Oracle Financial Services Analytical Applications 
Infrastructure and then, a business hierarchy (as defined above) is created.

•     Now, the bank can restrict access of certain information to certain people in the Hierarchy 
Security configuration. 

•     The administrator can control security by mapping the users to various nodes in hierarchy.

For example, the administrator maps Sales Officer 1 and Sales Officer 2 to only the Personal 
Loans Node in the Product hierarchy. This restricts Sales Officer 1 and 2 to only viewing and 
maintaining their particular node in the hierarchy. 

By default, all the users mapped to a domain can access all the hierarchy levels to which they 
are mapped. This function allows the administrator to restrict or exclude a user/s from 
accessing restricted nodes.
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D Appendix

Configuring OFS_IP_PACK.xml file
The insuranceperformance.xml file holds details on the various OFSAA products that are 
packaged in a particular Application Pack. 

The following table gives details about the various tags/parameters available in the file and the 
values that need to be updated. Prior to installing the OFSAA Application. Pack in SILENT 
mode, it is mandatory to update this file. 

Note: If you are installing in the GUI mode, then this file need not be 
updated.

Table D–1 OFS_IP_PACK.XML Parameters

Tag 
Name/Attribute 
Name

Description Mandatory  
(Y/ N)

Default Value/ 
Permissible Value

Comments

APP_PACK_ID Unique 
Application 
Pack Identifier

Y Unique Seeded Value DO NOT modify 
this value.

APP_PACK_
NAME

Unique 
Application 
Pack Name

Y Unique Seeded Value DO NOT modify 
this value.

APP_PACK_
DESCRIPTION

Unique 
Application 
Pack 
Description

Y Unique Seeded Value DO NOT modify 
this value.

VERSION Unique release 
version

Y Unique Seeded Value DO NOT modify 
this value.

APP Unique 
Application 
Entries

Y Unique Seeded Value DO NOT remove 
these tags.

APP_ID Unique 
Application 
Identifier

Y Unique Seeded Value DO NOT modify 
this value.
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APP_ID/ 
PREREQ

Prerequisite 
Application/ 
Product

Y Unique Seeded Value For most 
applications 
Infrastructure 
would be the 
prerequisite set. 
For certain other 
applications, an 
appropriate 
Application ID 
would be set. 
DO NOT modify 
this value.

APP_ID/ DEF_
SEL_FLAG

Default Selected 
Flag

Y Default - YES In all Application 
Packs, 
Infrastructure 
would have this 
value set to 
“YES”. DO NOT 
modify this value.

APP_ID/ 
ENABLE

Enable 
Application/ 
Product

YES if 
installing in 
SILENT mode.

Default –  
YES for Infrastructure 
NO for Others

Permissible -  YES or 
NO

Set this 
attribute-value to 
YES against 
every APP_ID 
which is licensed 
and should be 
enabled for use. 
 
Note: 
Application/ 
Product once 
enabled cannot be 
disabled. 
However, 
Application/ 
Product not 
enabled during 
installation can be 
enabled later 
through the 
Administration 
UI.

APP_NAME Unique 
Application/ 
Product Name

Y Unique Seeded Value DO NOT modify 
this value.

APP_
DESCRIPTION

Unique 
Application/ 
Product Name

Y Unique Seeded Value DO NOT modify 
this value.

VERSION Unique release 
version

Y Unique Seeded Value DO NOT modify 
this value.

Table D–1 OFS_IP_PACK.XML Parameters



E

                Appendix E-93

EAppendix

OFS_IP_SCHEMA_IN.xml file
Creating database schemas, object with schemas and assigning appropriate grants are the 
primary steps in the installation process of OFSAA Applications.  The OFS_IP_SCHEMA_
IN.xml file contains details on the various application schemas that should be created prior to 
the Application Pack installation. 

The following table gives details about the various tags/parameters available in the file and the values that need to 
be updated. Prior to executing the schema creator utility, it is mandatory to update this file.

Table E–1 OFS_IP_SCHEMA_IN.xml parameters

Tag Name/  
Attribute Name

Description Mandatory/ 
Optional

Default Value/  
Permissible Value

Comments

<APP_PACK_
ID>

Unique 
Application 
Pack Identifier

Mandatory Unique Seeded Value DO NOT modify 
this value.
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<JDBC_URL> Enter the JDBC 
URL.

Note: You can 
enter RAC and 
NON-RAC 
enabled database 
connectivity 
URL.

Mandatory Example, 

jdbc:oracle:thin:@<HOST
/IP>:<PORT>:<SID>

or

jdbc:oracle:thin:@//[HOS
T][:PORT]/SERVICE

or

jdbc:oracle:thin:@(DESC
RIPTION=(ADDRESS_
LIST=(ADDRESS=(PRO
TOCOL=TCP)(HOST=[H
OST])(port=[PORT]))(AD
DRESS=(PROTOCOL=T
CP)(HOST=[HOST])(PO
RT=[PORT]))(LOAD_
BALANCE=yes)(FAILO
VER=yes))(CONNECT_
DATA=(SERVICE_
NAME=[SERVICE]))) 

For example, 
jdbc:oracle:thin:@//dbhost
.server.com:1521/service1 

or

jdbc:oracle:thin:@//dbsho
st.server.com:1521/scan-1

or

jdbc:oracle:thin:@(DESC
RIPTION=(ADDRESS_
LIST=(ADDRESS=(PRO
TOCOL=TCP)(HOST=db
host1.server.com)(port=15
21))(ADDRESS=(PROTO
COL=TCP)(HOST=dbhos
t2.server.com)(PORT=152
1))(LOAD_
BALANCE=yes)(FAILO
VER=yes))(CONNECT_
DATA=(SERVICE_
NAME=service1)))

Ensure to add an 
entry (with SID/ 
SERVICE 
NAME) in the 
tnsnames.ora file 
on the OFSAA 
server. The entry 
should match 
with the SID/ 
SERVICE 
NAME used in 
the JDBC URL.

<JDBC_
DRIVER>

By default this 
driver name is 
seeded. 

Note: Do not 
edit this attribute 
value.

Mandatory Example, 

oracle.jdbc.driver.OracleD
river

Only JDBC Thin 
Driver is 
supported. 
DO NOT modify 
this value.

<HOST> Enter the 
Hostname/ IP 
Address of the 
system on which 
you are 
installing the 
OFSAA 
components.

Mandatory

Host Name/ IP Address

Table E–1 OFS_IP_SCHEMA_IN.xml parameters
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<SETUPINFO>
/ NAME

Enter the 
acronym for the 
type of 
implementation. 
This information 
will be displayed 
in the OFSAA 
Home Page.

Note: On 
executing the 
schema creator 
utility, this value 
will be prefixed 
with each 
schema name. 
For example: 
dev_ofsaaconf, 
uat_ofsaaatm.

Mandatory Accepts strings with a 
minimum length of two 
and maximum of four.

Example, 

DEV, SIT, PROD

This name would 
appear in the 
OFSAA Landing 
Page as 
“Connected To: 
xxxx”

The schemas 
being created 
would get this 
prefix. For E.g. 
dev_ofsaaconf, 
uat_ofsaaconf 
etc.

<PASSWORD>
/ DEFAULT*

Enter the 
password if you 
want to set a 
default password 
for all schemas.

Note: You also 
need to set 
APPLYSAMEF
ORALL 
attribute as Y to 
apply the default 
password for all 
the schemas.

Optional The maximum length 
allowed is 30 characters. 
Special characters are not 
allowed.

Table E–1 OFS_IP_SCHEMA_IN.xml parameters
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<PASSWORD>
/ 
APPLYSAMEF
ORALL

Enter as Y if you 
want to apply 
the password 
specified in 
DEFAULT 
attribute for all 
the schemas. 

If you enter as 
N, you need to 
provide 
individual 
passwords for all 
schemas.

Note: In case 
you have entered 
Y in 
APPLYSAMEF
ORALL 
attribute and 
also have 
specified 
individual 
passwords for all 
the schemas, 
then the 
specified 
individual 
passwords will 
take precedence.

Mandatory Default – N 
Permissible – Y or N

Note: Setting this 
attribute value is 
mandatory, If 
DEFAULT 
attribute is set.

Table E–1 OFS_IP_SCHEMA_IN.xml parameters
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<SCHEMA>/ 
TYPE

The different 
types of schemas 
that are 
supported in this 
release are  
ATOMIC, 
CONFIG, 
SANDBOX, and 
ADDON.

By default, the 
schemas types 
are seeded based 
on the 
Application 
Pack. 

Note: Do not 
edit this attribute 
value.

Mandatory ATOMIC/CONFIG/SAN
DBOX/ADDON

Note: 

SANDBOX AND 
ADDON schemas are not 
applicable for OFS AAAI 
Application Pack.

Only One 
CONFIG schema 
can exist in the 
file. 
This schema 
identifies as the 
CONFIGURATI
ON schema that 
holds the OFSAA 
setup details and 
other metadata 
information.

Multiple 
ATOMIC/ 
SANDBOX/ 
ADDON 
schemas can exist 
in the file.

ATOMIC schema 
refers to the 
Information 
Domain schema. 
SANDBOX 
schema refers to 
the SANDBOX 
schema. ADDON 
schema refers to 
other 
miscellaneous 
schema (not 
applicable for this 
Application 
Pack). 

<SCHEMA.>/ 
NAME

By default, the 
schemas names 
are seeded based 
on the 
Application 
Pack.

You can edit the 
schema names if 
required. 

Note:

The Schema 
Name will have 
a prefix of the 
SETUPINFO/ 
NAME attribute.

SCHEMA 
NAME must be 
same for all the 
ATOMIC 
Schemas of 
applications 
within an 
Application 
Pack.

Mandatory The permissible length is 
15 characters and only 
alphanumeric characters 
allowed. No special 
characters allowed except 
underscore ‘_’.

SETUPINFO/ 
NAME attribute 
value would be 
prefixed to the 
schema name 
being created. 
For E.g. if name 
is set as 
‘ofsaaatm’ and 
setupinfo as ‘uat’ 
then schema 
being created 
would be ‘uat_
ofsaaatm’. 

NAME should be 
same where 
APP_GRP=1 for 
all SCHEMA 
tags (Not 
applicable for this 
Application 
Pack).

Table E–1 OFS_IP_SCHEMA_IN.xml parameters
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<SCHEMA>/ 
PASSWORD*

Enter the 
password of the 
schema to be 
created. 

Note: 

If this attribute is 
left blank, then 
the password 
specified in the 
<PASSWORD>/
DEFAULT 
attribute is 
applied as the 
Schema 
Password.

Optional The maximum length 
allowed is 30 characters. 
Special characters are not 
allowed.

Note: You need 
to mandatorily 
enter the 
password if you 
have set the 
<PASSWORD>/ 
APPLYSAMEFO
RALL attribute 
as N.

<SCHEMA>/ 
APP_ID

By default, the 
Application ID 
is seeded based 
on the 
Application 
Pack. 

Note: Do not 
edit this attribute 
value.

Mandatory Unique Seeded Value Identifies the 
Application/ 
Product for which 
the schema is 
being created.

DO NOT modify 
this value.

<SCHEMA>/ 
DEFAULTTAB
LESPACE

Enter the 
available default 
tablespace for 
DB User.

Note: 

If this attribute is 
left blank, then 
USERS is set as 
the default 
tablespace.

Optional Default – USERS 
Permissible – Any 
existing valid tablespace 
name. 

Modify this value 
to associate any 
valid tablespace 
with the schema.

<SCHEMA>/ 
TEMPTABLES
PACE

Enter the 
available 
temporary 
tablespace for 
the DB User. 

Note: 

If this attribute is 
left blank, then 
TEMP is set as 
the default 
tablespace.

Optional Default – TEMP 
Permissible – Any 
existing valid temporary 
tablespace name.

Modify this value 
to associate any 
valid tablespace 
with the schema.

Table E–1 OFS_IP_SCHEMA_IN.xml parameters
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<SCHEMA>/ 
QUOTA

Enter the quota 
to be set on 
DEFAULTTAB
LESPACE 
attribute for the 
schema/ user. By 
default, the 
quota size is set 
to 500M.
Minimum: 
500M or 
Unlimited on 
default 
Tablespace

Optional Example, 

600M/m

20G/g

UNLIMITED/unlimited

Modify this value 
to grant the 
specified quota 
on the mentioned 
tablespace to the 
user. 

<SCHEMA>/ 
INFODOM

Enter the name 
of the 
Information 
Domain to 
associate this 
schema. 
The schema 
creator utility 
automatically 
derives an 
Information 
Domain Name 
based on the 
Application 
Pack if no value 
is specified for 
this attribute.

Optional Permissible length is 16 
characters and only 
alphanumeric characters 
allowed. No special 
characters allowed.

Table E–1 OFS_IP_SCHEMA_IN.xml parameters
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Mapview Configurations
This section provides information on prerequisites, creating the mapviewer NAVTEQ data 
source, configuration edits and server starting.

Note: This is just a sample configuration working on sample data provided 
by NAVTEQ.)

This section covers the following topics: 

•     Prerequisites

•     Creating the Mapviewer NAVTEQ Data source

•     Creating the NAVTEQ Schema

•     Configuration Edits and Server Starting

•     Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps

Prerequisites
NAVTEQ database dump can be imported only into an Oracle 11g database. If you have no 
other option than using a 10g version, contact OBIEE/Mapviewer Product Management.

Creating the Mapviewer NAVTEQ Data source
Ensure that you have a connection to 11g Oracle database from the machine where your OBIEE 
platform is installed.

Create a NAVTEQ schema within that database for holding the NAVTEQ spatial data. To create 
NAVTEQ schema, perform the steps as explained in the following section.

Downloading the Mapviewer NAVTEQ Database Dump
To download the Mapviewer NAVTEQ Database Dump, follow these steps:

1. Access the SampleApp_Navteq_dmp.zip file from the SampleApp download location 
(127MB)

http://www.oracle.com/technetwork/middleware/bi-foundation/obieesamples
archive-2026956.html

http://www.oracle.com/technetwork/middleware/bi-foundation/obieesamplesarchive-2026956.html
http://www.oracle.com/technetwork/middleware/bi-foundation/obieesamplesarchive-2026956.html
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2. Download and unzip the SampleApp_Navteq_dmp.zip file that contains an Oracle 
Database export file named

obiee_navteq.dmp

Creating NAVTEQ User
To create a NAVTEQ user, follow these steps:

1. Start a SQL*Plus session to the Oracle Database as a user with system or DBA privileges.

2. Run the following script:

create user obiee_navteq identified by obiee_navteq default tablespace 
users quota unlimited on users;

grant "connect" to obiee_navteq;

grant "resource" to obiee_navteq;

3. Once the script is executed, verify whether you can connect to the newly created user.

Note: The OBIEE_NAVTEQ user creation script defaults with the password 
obiee_navteq (same as user name) within the script. It is recommended that 
you keep this value unchanged to simplify configuration. Oracle OBIEE 11G 
SampleApp Deployment Instructions 32.

Creating the NAVTEQ Schema
To create NAVTEQ Schema, follow these steps:

Importing the database dmp file

1. Import the Oracle Database export file - obiee_navteq.dmp into the obiee_navteq 
schema using the following import command, from the command line (Command Prompt 
in Windows):

c:\> imp obiee_navteq/obiee_navteq@connectString file=obiee_navteq.dmp 
FULL=Y 

2. ConnectString is the connection string to your Oracle Database 11g where the user obiee_
navteq was created in the step mentioned earlier. Wait for the import process to complete, 
once successfully completed, login on your DB as obiee_navteq/obiee_navteq and validate 
that you can view the schema tables and some data.

Inserting Extra Spatial Metadata

1. Start a SQL*Plus session to the Oracle Database and connect as user obiee_navteq. For 
example: c:\>sqlplus obiee_navteq/obiee_navteq@connectString

2. Run the following script:

INSERT INTO user_sdo_maps SELECT * FROM my_maps;

INSERT INTO user_sdo_themes SELECT * FROM my_themes;

INSERT INTO user_sdo_styles SELECT * FROM my_styles;

INSERT INTO user_sdo_cached_maps SELECT * FROM my_tile_cache;

Commit;
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Configuration Edits and Server Starting
Confirm that WLS server and WLS managed servers are up and running, and ensure that 
OMPNCTL is not running.

Note: Neither OBIS nor OBIPS are running.

MapViewerConfig.xml Edits (Optional )
1. Open the Mapviewer console using the following URL:

http://10.228.235.83:9704/mapviewer (replace 10.228.235.83:9704 with 
the correct IP address and port number on your install).

2. Click Admin.

3. Login with the username/password that you provided while installing the product.

4. Click Configuration. This opens the mapViewerConfig.xml on your setup.

5. Make the following updates to the xml file.

<security_config> (Optional)

In the <security_config> property of this file, make the following changes:

1. Change the <proxy_enabled_hosts> property to the following: Substitute the 
hostname, IP address and port to the correct values on your setup.

<proxy_enabled_hosts>

http://dadvmc0508.us.oracle.com:9704/mapviewer

http://dadvmc0508.us.oracle.com:9704/,http://10.228.235.83:9704/

http://10.228.235.83:9704/mapviewer

</proxy_enabled_hosts>

2. Substitute any entries with these tags with the following property entries:

<disable_direct_info_request> true </disable_direct_info_request>

<disable_info_request> true </disable_info_request>

<disable_csf>true</disable_csf>

<enforce_security_role> true </enforce_security_role>

Oracle OBIEE 11G SampleApp Deployment Instructions 33

Predefined Data Sources

1. At the end of the file, in the section named Predefined Data Source, add the following 
data source entry.

2. Replace the IP address, SID, and port to the correct values of the database where the 
obiee_navteq schema has been created in the above steps.

<map_data_source name="OBIEE_NAVTEQ_SAMPLE"

jdbc_host="10.229.147.238" (use your db ip)

jdbc_sid="orcl" (use your db sid)

jdbc_port="1521" (use your db port)

jdbc_user="obiee_navteq"
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jdbc_password="!obiee_navteq" (use your selected password if 
different from OOB)

jdbc_mode="thin"

number_of_mappers="3"

allow_jdbc_theme_based_foi="false" />

Note: Ensure that all tags have been closed correctly and also the above data 
source is not within the comments section (ensure that it is outside the 
comments section which is represented by <!-- .. -->).

Save and Restart, Verify

Click Save and Restart button at the bottom of the file.

1. Verify whether you can view OBIEE_NAVTEQ_SAMPLE as an entry in data sources.

2. Then after you are successful, there will entry in DataSources section.

3. Login to Analytic screen>Administration.

4. Click Manage map Data. 

5. Click Import Layer and then choose OBIEE_COUNTRY.

6. Choose Preview MAP as OBIEE_WORLD_MAP_FAST.

7. Same for OBIEE STATE.

8. Select Background Maps.

9. Use import Background maps and chosen OBIEE_WORLD_MAP_FAST.

10. Edit the same, add layer OBIEE COUNTRY and then OBIEE STATE. While choosing, chose 
the location OBIEE_WORLD_MAP for higher Zoom value.

11. Select the zoom level for country 0 and for country 2...15.

12. Navigate back to Layers tab.

13. Edit OBIEE COUNTRY and OBIEE STATE.

14. By adding BI Key Columns 

15. For Country>choose Insurance Claims>Location Map>Country Description.

16. For State>choose Insurance Claims>Location Map>State Description.

17. Once configuration.xml file is restarted, click Data Sources.

Loading FSI_LOCATION_MAP_COORD for viewing NAVTEQ Maps
For NAVTEQ Maps to work, it requires the location data in our atomic schema to be in sync 
with the map metadata in NAVTEQ schema. This is achieved through a new table FSI_
LOCATION_MAP_COORD, the load process of which is described as follows.

Populate FSI_LOCATION_MAP_COORD based on DIM_LOCATION data itself, but description and 
codes should come from tables OBIEE_COUNTRY, OBIEE_STATE, OBIEE_CITY (from the DB 
schema configured for Maps, 'OBIEE_NAVTEQ', for example in this case) respectively for 
Country, State and City, and n_location_skey should be the corresponding n_location_skey 
from DIM_LOCATION.

For Instance, let us consider the following data from DIM_LOCATION.



Table F–1 DIM_LOCATION

N_LOCATION_SKEY 1

V_LOCATION_CODE HAW

V_COUNTRY_CODE USA

V_COUNTRY_DESC United States

V_STATE_CODE HI

V_STATE_DESC Hawaii

V_CITY_CODE CITI1

V_CITY_DESC Honolulu

V_ZIP_CODE 96813
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Now, to populate the following columns in FSI_LOCATION_MAP_COORD

Table F–2 FSI_LOCATION_MAP_COORD

n_location_skey = 1

v_country_code = OBIEE_
COUNTRY.ISO_COUNTRY_
CODE

USA

v_country_code_map = 
OBIEE_COUNTRY.ISO_
COUNTRY_CODE

USA

v_country_desc = OBIEE_
COUNTRY.NAME

United States

v_state_code = OBIEE_
STATE.ISO_CTRY_CD_
STATE_ABBRV

USA_HI

v_state_code_map = OBIEE_
STATE.ISO_CTRY_CD_
STATE_ABBRV

USA_HI

v_state_desc = OBIEE_
STATE.STATE_NAME

HAWAII

v_city_code = OBIEE_
CITY.CTRY_CD3_STATE_
ABBRV_CITY

USA_HI_Honolulu

v_city_code_map = OBIEE_
CITY.CTRY_CD3_STATE_
ABBRV_CITY

USA_HI_Honolulu

v_city_desc = OBIEE_
CITY.CITY_NAME

HONOLULU

v_zip_code = 96813

Note: This would be a one-time manual activity, and the Map tables and 
columns would change based on the Maps used. The process mentioned here 
is for NAVTEQ Maps.
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Cloning OFSAA Instance
There is a consistent need for a faster and effective approach of replicating an existing OFSAA 
instance for further project developments, that is, setting up OFSAA instances that are exact 
copies of the current OFSAA instance. For more information on cloning, refer OFSAA Cloning 
Reference Guide.

http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
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Patching Your OFSAA Infrastructure Installation
Oracle strongly recommends installing the latest available patchset so as to be up to date with 
the various releases of the OFSAA Infrastructure product.

You can refer to the below links on http://support.oracle.com for more information on 
latest releases and upgrade compatibility:

Latest OFSAAI 7.3 Release and OFSAA 6.0 and 6.1 Release Information (Doc 
ID 1456593.1)

OFSAAI 7.3 Upgrade and Compatibility Reference (Doc ID 1590502.1)

http://support.oracle.com
https://support.oracle.com/epmos/faces/ui/km/SearchDocDisplay.jspx?returnToSrId=&_afrLoop=17630110005355&srnum=&type=DOCUMENT&id=1456593.1&displayIndex=2&_afrWindowMode=0&_adf.ctrl-state=7tfacg6pm_179
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=17722932179153&id=1590502.1&_afrWindowMode=0&_adf.ctrl-state=7tfacg6pm_200
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This Appendix discusses the following sections:

•     Grants for Atomic Schema

•     Grants for Config Schema

•     Grants for Config Schema Entities for Atomic Users

Grants for Atomic Schema
The following are the Grants for Atomic Schema:

grant create SESSION to &database_username

/

grant create PROCEDURE to &database_username

/

grant create SEQUENCE to &database_username

/

grant create TABLE to &database_username

/

grant create TRIGGER to &database_username

/

grant create VIEW to &database_username

/

grant create MATERIALIZED VIEW to &database_username

/

grant olap_user to &database_username

/

grant select on SYS.V_$PARAMETER to &database_username

/

grant create SYNONYM to &database_username

/
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Grants for Config Schema
The following are the Grants for Config Schema:

grant create SESSION to &database_username

/

grant create PROCEDURE to &database_username

/

grant create SEQUENCE to &database_username

/

grant create TABLE to &database_username

/

grant create TRIGGER to &database_username

/

grant create VIEW to &database_username

/

grant create MATERIALIZED VIEW to &database_username

/

grant olap_user to &database_username

/

grant select on SYS.V_$PARAMETER to &database_username

/

grant create SYNONYM to &database_username

/

Grants for Config Schema Entities for Atomic Users
The following are the Grants for Config Schema entities for Atomic Users:

grant select on CSSMS_USR_PROFILE to &database_username

/

grant select on CSSMS_ROLE_MAST to &database_username

/

grant select on CSSMS_GROUP_MAST to &database_username

/

grant select on CSSMS_FUNCTION_MAST to &database_username

/

grant select on CSSMS_USR_GROUP_MAP to &database_username

/

grant select on CSSMS_USR_GROUP_DSN_SEG_MAP to &database_username

/
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grant select on CSSMS_ROLE_FUNCTION_MAP to &database_username

/

grant select on CSSMS_GROUP_ROLE_MAP to &database_username

/

grant select on CSSMS_SEGMENT_MAST to &database_username

/

grant select on CSSMS_USR_DSN_SEG_MAP to &database_username

/

grant select on CSSMS_USR_ROLE_MAP to &database_username

/

grant select on CSSMS_METADATA_SEGMENT_MAP to &database_username

/

grant select on BATCH_RUN to &database_username

/

grant select on PR2_FILTERS to &database_username

/

grant select on PR2_TASK_FILTER to &database_username

/

grant select on PR2_TASK_FILTER_DETAIL to &database_username

/

grant select on ST_STRESS_MASTER to &database_username

/

grant select on ST_SCENARIO_MASTER to &database_username

/

grant select on ST_SHOCK_MASTER to &database_username

/

grant select on BATCH_MASTER to &database_username

/

grant select on ICC_MESSAGELOG to &database_username

/

grant select on PR2_MASTER to &database_username

/

grant select on PR2_RUN_REQUEST to &database_username

/

grant select on MF_MODEL_SCRIPT_MASTER to &database_username

/

grant select on MF_INPUT_VALUES to &database_username
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/

grant select on MF_MODEL_OUTPUT_VALUES to &database_username

/

grant select on DB_MASTER to &database_username

/

grant select on DSNMASTER to &database_username

/

grant select on pr2_rule_map to &database_username

/

grant delete on pr2_rule_map_pr to &database_username

/

grant insert on pr2_rule_map_pr to &database_username

/

grant update on pr2_rule_map_pr to &database_username

/

grant select on pr2_rule_map_pr to &database_username

/

grant delete on pr2_rule_map_pr_tmp to &database_username

/

grant insert on pr2_rule_map_pr_tmp to &database_username

/

grant update on pr2_rule_map_pr_tmp to &database_username

/

grant select on pr2_rule_map_pr_tmp to &database_username

/

grant select on pr2_rule_map_exclude to &database_username

/

grant delete on pr2_rule_map_exclude_pr to &database_username

/

grant insert on pr2_rule_map_exclude_pr to &database_username

/

grant update on pr2_rule_map_exclude_pr to &database_username

/

grant select on pr2_rule_map_exclude_pr to &database_username

/

grant delete on pr2_rule_map_exclude_pr_tmp to &database_username

/
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grant insert on pr2_rule_map_exclude_pr_tmp to &database_username

/

grant update on pr2_rule_map_exclude_pr_tmp to &database_username

/

grant select on pr2_rule_map_exclude_pr_tmp to &database_username

/

grant select on pr2_run_object to &database_username

/

grant select on pr2_run_object_member to &database_username

/

grant select on pr2_run_map to &database_username

/

grant select on pr2_run_execution_b to &database_username

/

grant select on pr2_run_execution_filter to &database_username

/

grant select on pr2_firerun_filter to &database_username

/

grant select on pr2_filters to &database_username

/

grant select on configuration to &database_username

/

grant select on batch_parameter to &database_username

/

grant select on component_master to &database_username

/

grant select on MDB_OBJECT_TYPE_ATT_LAYOUT to &database_username

/

grant select on REV_OBJECT_ATTRIBUTE_DTL to &database_username

/

grant select on FORMS_LOCALE_MASTER to &database_username

/

grant select on mdb_object_dependencies to &database_username

/

grant select on mdb_execution_details to &database_username

/

grant select on REV_STAT_DATA to &database_username
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/

grant select on REV_OBJECT_REPOSITORY_B to &database_username

/

grant select on REV_OBJECT_REPOSITORY_TL to &database_username

/

grant select on REV_OBJECT_ATTRIBUTE_DTL_MLS to &database_username

/

grant select on REV_OBJECT_APPLICATION_MAP to &database_username

/

grant select on MDB_OBJ_EXPR_DETAILS to &database_username

/

grant select on MDB_EXECUTION_DETAILS to &database_username

/

grant select on REV_OBJECT_TYPES_CD to &database_username

/

grant select on REV_OBJECT_TYPES_MLS to &database_username

/

grant select on REV_APPLICATIONS_CD to &database_username

/

grant select on REV_APPLICATIONS_MLS to &database_username

/

grant select on METADATA_BROWSER_LOCALE to &database_username

/

grant select on MDB_STAT_DATA to &database_username

/

grant select on MDB_OBJECT_TYPE_LAYOUT to &database_username

/

grant select on ofsa_md_id_ref to &database_username

/

grant select on MDB_ETL_MAPPING to &database_username

/

grant select on setupinfo to &database_username

/

grant select on LOCALEREPOSITORY to &database_username

/

grant select on MF_MODEL_MASTER to &database_username

/
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grant select on MF_SANDBOX_MASTER to &database_username

/

grant select on MF_VARIABLE_MASTER to &database_username

/

grant select on MF_TECHNIQUE_MASTER to &database_username

/

grant select on MDB_RULE_SOURCE_HEADER to &database_username

/

grant select on MDB_RULE_TARGET_HEADER to &database_username

/

grant select on MDB_RULE_TARGET_MEMBER_HEADER to &database_username

/

grant select on MDB_RULE_GRID_DATA to &database_username

/

grant select on MDB_MODEL_MAPPING to &database_username

/

grant delete on AAI_MAP_MAPPER to &database_username

/

grant insert on AAI_MAP_MAPPER to &database_username

/

grant update on AAI_MAP_MAPPER to &database_username

/

grant select on AAI_MAP_MAPPER to &database_username

/

grant select on RTI_UI_EXCLUDE_PDM_LIST  to &database_username

/

grant select on RTI_VIR_PHY_TBL_NAME  to &database_username

/

grant select on infodom_patches to &database_username

/
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This section provides detailed instructions to migrate for excel upload.

Prerequisites
The following are the prerequistes for migration.

•     "Data model in ATOMIC schemas should be same on the source and target setups

•     "OFS AAI (platform) patch level version should be same on the source and target setups.

•     "PL/SQL Developer to connect and query the database.

•     "WinSCP to connect and access server file system.

Migration for Excel Upload
To migrate, follow these steps:

1. Open PL/SQL Developer and logon to the source setup's configuration (CONFIG) schema 
by entering the appropriate username and password.

2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER. 

3. Open a new session in PL/SQL developer and logon to the target setup's configuration 
(CONFIG) schema by entering the appropriate username and password. 

4. Insert the records from Step 1 above in to this table.

5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name with 
the target infodom name.

Note: If all the mappings can work out of the single target Infodom, update 
same Infodom value across all rows. If only few mappings will work out of 
the target infodom, update the infodom value for selective records. Kindly 
note, excel upload mappings will work only if the target infodom has same 
data model entities as used in the mappings defined on source setup.

6. Update V_CREATED_BY column with the name of any user present in the target setup that 
has appropriate roles to perform Excel Upload tasks.

Note: It is mandatory to update values for V_INFODOM and V_CREATED_BY 
columns.
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7. Open WinSCP and login a new session by entering the host name, port number, user name 
and password to access the source setup. 

8. Navigate to the folder referred as FTPSHARE.

9. Copy the excel-entity mapping xml file(s) which are located in this folder according to 
their folder structure on to your desktop. For example: /ftpshare 
/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME 
column of EXCEL_MAPPING_MASTER table.

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder according to 
their folder structure on to your desktop. For example: 
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.

11. Login a new session in WinSCP by entering the host name, port number, user name and 
password to access the target setup. 

12. Copy  the xml file(s) from Step3 to the below location in the target setup. For example: 
/ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: $TARGET_INFODOM_NAME should be target setup infodom in which 
you have uploaded the appropriate data model and the name should be same 
as the V_INFODOM column value updated in EXCEL_MAPPING_MASTER table.

13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For example: 
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.
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The ojdbc<version>.jar file should be copied based on Database & Java version. Refer to 
the following table for details. 

Table K–1 JDBC Jar files version details

Oracle Datbase 
Version JDK Version Supported JDBC Jar files specific to the release

12.1 or 12cR1 JDK 6,  JDK 7, and JDK 8 ojdbc7.jar for JDK 7/JDK8

ojdbc6.jar for JDK 6

11.2 or 11gR2 JDK 6 & JDK 5

JDK 7 supported in 11.2.0.3 
and 11.2.0.4 

ojdbc6.jar for JDK 7 

ojdbc6.jar for JDK 6

ojdbc5.jar for JDK 5
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This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 
instance to Java 8. It consists of the following topics:

•     Prerequisites

•     Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8

•     Web Application Server Configurations

•     OFSAA Generic Configurations

•     OFSAA Configurations for New Web Application Server Installation

Prerequisites
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:

•     Java 8 should be installed on the OFSAA server and Web Application Server.

•     Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch 
18729264 from http://support.oracle.com for the same.

Note: IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8
To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web Application Server to Java 8. For more information, refer Configuring Web 
Application Servers.

2. Configure the OFSAA instance to Java 8. For more information, refer OFSAA Generic 
Configurations. For a newly installed Web Application Server, refer OFSAA 
Configurations for New Web Application Server Installation

3. Restart the OFSAA services. For more information, refer the Start/Stop Infrastructure 
Services section in Chapter 6, "Start and Stop of Infrastructure Services"

4. Generate the application EAR/WAR file and redeploy the application onto your configured 
web application server. For more information on generating and deploying EAR / WAR 
file, refer Appendix C.


http://support.oracle.com
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Web Application Server Configurations
This section describes the changes to be made in the Web Application Server. Following are the 
two options to perform Web Application Server Configurations which are listed as follows:

•     Upgrade the existing Web Application Server installation to Java 8

•     Install a new instance of the Web Application Server with Java 8

This section consists of the following topics:

•     Oracle WebLogic Server Updates

•     Apache Tomcat Server Updates

Oracle WebLogic Server Updates
Perform the following configurations to upgrade the existing WebLogic server instance to Java 
8:

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, 
JAVAHOME properties to the new Java path and java.vm.version to the new Java 
version. For example,

JAVA_HOME=/usr/java/jdk1.8.0_45

WLS_JAVA_HOME=/usr/java/jdk1.8.0_45

JAVAHOME=/usr/java/jdk1.8.0_45

java.vm.version=1.8.0_45

3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_
projects/domains/<domain>/bin.  Update SUN_JAVA_HOME, DEFAULT_
JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file to point to the new Java 
path.  For example, 

SUN_JAVA_HOME="/usr/java/jdk1.8.0_45"

DEFAULT_SUN_JAVA_HOME="/usr/java/jdk1.8.0_45"

JAVA_HOME="/usr/java/jdk1.8.0_45"

4. Clear the Application cache. Navigate to the following path and delete the files:

<Weblogic installation location>/domains/<Domain name>/servers/<Server 
name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps:

1. Install Oracle WebLogic Server 12.1.3.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more information 
refer Configuring Resource Reference in Weblogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be set same 
as that of the existing Domain.

Note down the new Domain path to perform OFSAA Configurations.
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Apache Tomcat Server Updates
Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 
7 to Java 8:

1. Login to the Apache Tomcat Server as a non-root user.

2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For 
Example, 

JAVA_HOME=/usr/java/jre1.8.0_45

3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application 
name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1. Install Apache Tomcat Server 8 with Java 8.

2. Perform the configurations for the newly installed Tomcat server. For more information 
refer Configuring Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in 
/apache-tomcat-8.0.21/conf/server.xml file to that of the 
existing Tomcat instance.

Note down the new deployment path to perform OFSAA Configurations.

OFSAA Generic Configurations
This section consists of the following topics:

•     User .profile Settings

•     Configurations for Java 8

User .profile Settings
Perform the following configurations:

1. Login to the OFSAA Server as a non-root user.

2. Edit the user .profile. Update the value for PATH variable  from JRE 1.7 to JRE 1.8. 
For Example,

PATH=/usr/java/jdk1.8.0_45/jre

JAVA_BIN=/usr/java/jdk1.8.0_45/jre/bin

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jdk1.8.0_
45/jre/lib/amd64/server

Configurations for Java 8
Perform the configurations explained in the section Configurations for Java 8
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OFSAA Configurations for New Web Application Server 
Installation

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or 
Apache Tomcat Server 8.0. Follow these steps:

1. Modify the following parameters in the Configuration table present in the Config Schema 
with the new Domain Path in case of WebLogic or with the new deployment path in case 
of Tomcat:

•     DeFiHome

•     REV_IMG_PATH

•     EMBEDDED_JSP_JS_PATH

2. Login to the OFSAA Server as a non-root user.

3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following 
parameters in the web.xml  file with the new Domain path in case of WebLogic or with 
the new deployment path in case of Tomcat:

•     FIC_PHYSICAL_HOME_LOC

•     FIC_HOME

•     ICC_SERVLET_LOG_FILE

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in 
case of WebLogic or with the new deployment path in case of Tomcat:

•     OFSAALogger.xml 

•     MDBLogger.xml 

•     RevLog4jConfig.xml 

•     RFDLogger.xml 

•     ExportLog4jConfig.xml 

•     RFDLogger.xml

•     PR2Logger.xml
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MAppendix

This section of the document consists of resolution to the frequently asked questions and error 
codes noticed during OFSAAI installation.

•     Frequently Asked Questions

•     Error Dictionary

OFSAAI installer performs all the pre-requisite validation check during installation. Any errors 
encountered in the process is displayed with an appropriate Error Code. You can refer to the 
Error Dictionary to find the exact cause and resolution to rectify the error.

Frequently Asked Questions
You can refer to the Frequently Asked Questions which has been developed with the interest to 
help you resolve some of the OFSAAI Installation and configuration issues. This intends to 
share the knowledge of problem resolution to a few of the known issues. This is not an official 
support document and just attempts to share the knowledge of problem resolution to a few of 
the known issues.

•     OFSAAI FAQs

•     Application Pack 8.0.0.0.0 FAQs

•     Forms Framework FAQs

OFSAAI FAQs
What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in Figure 1–2, "Components of 
OFSAAI".

What are the different modes of OFSAAI installation?

OFSAAI can be installed in two modes, Silent Mode, and GUI mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. 
By default, they will be installed on single-tier. However, OFSAA Infrastructure can be 
deployed within the n-Tier architecture where the Database, Web Server and Web Application 
Server is installed on separate tiers.

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be 
uninstalled after OFSAA installation?
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JDK is not required during  installation of OFSAA and only a run time is needed for 
details. Refer  Configurations Supported for Java 7 and Configurations Supported for Java 
8, Java Runtime Enviromen section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI 
installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA and 
cannot be uninstalled as the JRE is used by the OFSAA system to work.

How do I know what is the  Operating system, webservers and other software versions that 
OFSAA supports?

Refer to OFSAA Technology Stack Matrices.

What are the different files required to install OFSAAI?

The following files are required:

•     setup.sh.

•     envCheck.sh

•     preinstallcheck.sh

•     VerInfo.txt

•     OFSAAInfrastructure.bin

•     validatedXMLinputs.jar

•     MyResources_en_US.properties

•     log4j.xml

•     OFSAAI_PostInstallConfig.xml

•     OFSAAI_InstallConfig.xml

•     privileges_config_user.sql

•     privileges_atomic_user.sql

•     XML_Utility.jar

What should I do if I get the following error message during installation, "Execute 
Permission denied"?

Please check whether all the files provided for OFSAAI installation has execute  
permissions. 

To give execute permissions,

•     Navigate to the path OFSAAI_80000 and execute the command

chmod 755

"Graphical installers are not.."

If error resembles "Graphical installers are not supported by the VM. The console mode 
will be used instead..." then check whether any of the X-windows software has been 
installed.

Example: Hummingbird Exceed is started and configured to Graphical mode installation.

Note: Type 'xclock' from prompt and this should display clock in graphical 
mode.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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"No Java virtual machine could be…"

If the error message reads "No Java virtual machine could be found from your PATH 
environment variable. You must install a VM prior to running this program", then 

•     Check whether "java path" is set in PATH variable. See the  Table 3–1, " Prerequisite 
Information"section in this document.

•     Check whether sufficient temporary space is available.

•     Ensure that the movement of OFSAAI Installer text files to the target system is done in 
the Text mode so that setup.sh file does not contain control line feed characters 
(^M).

During the installation, what should I do if the error message shows "OracleDriver Files Not 
Found, Please Choose the Right Path To Continue"?

Check whether the provided path for Oracle Driver files is correct and whether the user has 
permissions to access the files.

During installation, what is to be done if the error always reads "User must have CREATE 
TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE SEQUENCE, 
CREATE PROCEDURE" even though the oracle schema user created has the mentioned 
privileges?

OFSAAI installer validates the database details provided during installation, so ensure:

•     Whether the oracle schema user has the required set of privileges for successful 
installation.

•     Whether the oracle schema user has been created with quota privileges on tablespace to 
create database objects.

See the  Table 3–1, " Prerequisite Information"section in this document.

Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post 
Installation steps. See Chapter 5, "Post Installation Configuration". 

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the 
Infrastructure Installation Directory. There is also another log file created in the path 
configured in Log4j.xml. The logs of any of these reported, Warnings/Non Fatal 
Errors/Fatal Errors/Exceptions should be brought to the notice of the OFSAAI Customer 
Support. It is recommended not to proceed, until the reported problems are adequately 
addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling 
OFSAA Infrastructure in the OFS AAAI Installation and Configurtion Guide Release 8.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same database 
instance.

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database 
permissions) to the new Atomic schema.

•     Log into the database as sys and connect as sysdba user.
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•     Execute the file privileges_config_user.sql available under $FIC_HOME 
directory

•     Enter the database schema for which you want to grant privileges.

When should I run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFSAAI Administration 
Guide in the OTN section.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and 
above.

On the UNIX System terminal, error message shows "Insert New Media. Please insert Disk1 
or type it's location"while executing ./setup.sh, what should be done?

1. Login as root user on the Unix machine where OFSAAI is getting installed.

2. Navigate to the path /etc/security/. 

3. Edit the file limits.conf to add/edit a row for the unix user installing OFSAA:

<Unix User> soft nofile 9216

4. After saving the changes, log in as unix user with which OFSAAI is getting installed 
and execute the command:

ulimit -n

The command should return the value 9216.

How do I verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the installation, a 
Pre-Install Check utility is available within the Install Kit archive file. This utility can also 
be obtained separately by contacting Oracle Support.

See Verifying the System Environment section for additional information. 

How do I know if  the installation is completed successfully? 

The OFSAA Infrastructure installation performs a post install health check automatically 
on successful installation of the product. To rerun the post install verification at a later 
time, perform the following steps:

1. Navigate to the path $FIC_HOME (Product Installation Directory).

2. Execute the command:

./piverify.sh

What should I do if the installation in GUI mode is not invoked?

There are set of configuration steps required to be performed during  the installation in 
GUI mode. Verify whether the steps mentioned under Configuration for GUI Mode 
Installation section are done correctly. 

What should I do if there are any exceptions or errors in installation and how to proceed?

1. Please backup the installation logs.

2. Share the backup logs with Oracle support.

On Solaris 11 system, if one gets the following error message during OFSAAI installation, 
what should be done:

"Error: OFSAAI-1108

http://docs.oracle.com/cd/E60058_01/homepage.htm
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ORA-00604: error occurred at recursive SQL level 1

ORA-01882: timezone region not found"

Or

"Time zone cannot be set as null or 'localtime' "

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set the 
environment variable TZ to a valid time zone region in the .profile file. For example, 

TZ=Asia/Calcutta

export TZ

What  happens if the installation process is abruptly terminated or aborted? What should I 
do?

If the installation is abruptly terminated, then the installation process will be incomplete. 
To recover from this, follow the below steps:

1. Drop the DB objects in the config schema created by OFSAAI installation.

2. Open the .profile and remove the entries made by the OFSAAI installation which 
are made between the comment statements, #Beginning of entries by OFSAA 
Infrastructure installation and #End of entries by OFSAA Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSAAI installer.

4. Perform the OFSAAI installation again. 

Would OFSAA support any other web server types, other than the ones stated in tech matrix 
and installation guide?

No, all the supported softwares and versions are stated in the  OFSAA Technology Stack 
Matrices. 

What should one do if the database connection from connection pool throws an error 
"java.sql.SQLRecoverableException: IO Error: Connection reset"?

This happens while running several database intensive tasks in parallel. To correct this 
error, add the line securerandom.source=file:/dev/./urandom in the 
java.security configuration file available in $JAVA_HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where the 
OFSAAI components are installed.

If the issue is not resolved even with the above settings, check the MTU(Maximum 
Transmission Unit) settings on the linux box. For details on MTU settings and updating 
them, contact your system Administrator.

When I invoke setup.sh file from my install archive, it throws syntax errors/file not found 
error messages, what should I do?

This could mostly  happen:

•     When installer was not unzipped rightly or corrupted during unzip.

•     setup.sh file which resides within the install archive was  not transferred in ASCII or 
text mode, which could have corrupted the file.

To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA 
Infrastructure components will be installed.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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2. Unzip the installer using the command:

unzip <OFSAAI_Installer>.zip

3. The corrupted setup.sh file would have introduced certain ^M characters into the 
file.  You can remove ^M characters from setup.sh file by following the below steps:

Note: To enter ^M, hold the CTRL key then press V and M in succesion.

a. Login to the server where the installer is copied.

b. Navigate to the directory OFSAAI_80000.

c. Open the setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/^M//g 

e. Save the setup.sh file by typing: wq!

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a standard 
or enterprise edition. So, OFSAAI will work with standard edition as well.

We do not recommend standard edition because it will not scale and  does not support 
partition pack, database security vault, or advanced analytics.

What should I do if I get the following error message while executing ./reveleusstartup.sh file 
on the UNIX System terminal "./reveleusstartup.sh: /java: Execute permission denied"?

•     Ensure JAVA_BIN environment variable path is set on the "unix user" terminal from 
where the reveleusstartup.sh file is invoked.

•     Ensure the .profile where the environment/ path settings are made has been 
executed successfully.

What happens when the OFSAAI Application Server does not proceed even after providing 
the system password?

Ensure that, the System Password provided when prompted should match with the "Oracle 
Configuration password" provided during installation. Also check whether the connection 
to the "configuration schema" can be established through sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers are 
started, and the application URL is accessed, it gives an error message "the page cannot be 
found or displayed" or "Could not retrieve list of languages from Server. Please contact the 
system administrator". What should I do?

Ensure OFSAAI servers have been started and are running successfully. On the server start 
up parameters options, see Starting Infrastructure Services section.

For more details on the issue, refer on to the Revappserver log in $FIC_APP_ 
HOME/common/FICServer/logs directory or the Web Server log files.

Is it necessary to provide the specified grants to the Oracle schema user before 
installation? If yes, can it be revoked after completion of installation?

The "Oracle schema" user requires the necessary grants specified before, during, and after 
the installation process. Grants provided should never be revoked as the application makes 
use of these grants all the time.

Can I have distributed OFSAAI Application Server for load balancing?



Frequently Asked Questions

                       Appendix M-133

OFSAAI Application server can be scaled out/distributed across different JVM's 
(machines) based on the various services and Information Domains, in other words, Load 
balancing could be achieved with distribution of services.

Why do I need Ftpshare? Why is it needed on all the layers? Can I have ftpshare on another 
machine other than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in 
Infrastructure are stored in the ftpshare directory. The ftpshare contains folders for each 
Information Domain, with each Information Domain folders holding Erwin, log, and 
scripts folder. The transfer of data among the Web, Application, and Database servers in 
Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers by 
providing App server's FTP/SFTP credentials to the Web server and DB server users.

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is 
installed.

Is it mandatory to provide the ftp/sftp password? 

Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare 
directory, and should be able to independently login to the unix server.

What are the permissions required for ftpshare and when should I give them?

It is recommended to provide  permissions on ftpshare in case of  installations done across 
different machines or VMs (multitier installation ).

In case of single tier installation, 770 permissions can be provided if the unix users of 
OFSAAI and web server belong to the same unix group.

And on any new file that is created in the 'ftpshare' folder of any installation layer should 
be granted specific/explicit permission.

Port Change utility could be used to have the Port number modified, which are currently 
being used by the Infrastructure application. For more information, refer  Changing IP/ 
Hostname, Ports, Deployed Paths of the OFSAA Instancesection.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup 
OFSAAI.

•     SYSADMN 

•     SYSAUTH

•     GUEST 

Does OFSAAI Application support both FTP and SFTP?

OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the 
OFSAAI.

OFSAAI Configuration: Unable to save the server details?

•     Ensure the input User ID, Password, and Share Name are correct.

•     Ensure FTP/SFTP services are enabled.

•     Have a test FTP/SFTP connection made and confirm if they are successful.
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During Information Domain creation, the message "Please create a database and then 
create the information domain" appears. What should be done?

Information Domain is mapped to only one Database; and thus before the creation of 
Information Domain, at least one database details would need to exist.

The message "ConnectToDatabase: FatalError, could not connect to the DB server" appears 
during startup of backend engine message server. What do I need to do?

•     Verify whether connection to the "configuration schema" can be established through 
sqlplus.

•     Verify "configuration schema" password is modified post installation.

•     Ensure oracle database alias name created for oracle instance and oracle service name 
are same.

•     On a multi tier Installation mode, ensure TNSNAME and SID are the same in both the 
Application and Database Layers.

The message "Fatal Error, failed to get user ID from LibSmsConnect" appears during the 
startup of backend engine message server. What has to be done?

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the Database 
components are installed.

Does OFSAAI Application support LDAP authentication?

OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?

Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is 
recommended for back-up.

What kind of security features does the OFSAAI provides?

OFSAAI provides security at:

•     Segment Level - Users can access only the segment they are mapped to.

•     Application Level - Users can perform an operation only if mapped to appropriate role 
and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which the user 
password would expire and then the user is forced to change the password after expiration 
period.

What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and Lower 
case characters and alpha-numeric strings.

Which version of Erwin Data Modeller does OFSAAI support?

OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to ERwin 
4.1, ERwin 7.1, ERwin 7.3 and ERwin 9.0 formats.

Does OFSAAI provide the mechanism to upload Business Data model?

OFSAAI provides two mechanisms for business data model upload:
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•     Easy to use GUI based Model upload mechanism to upload the Business Data Model 
through Unified Metadata Manager --> Import Model.

•     OFSAAI also provides a model upload utility "upload.sh" for uploading the business 
data model through the command line parameter by executing this shell script file 
under the path <FIC_HOME>/ficapp/common/FICServer/bin.

Refer the section Run Model Upload Utilityof the OTN for details. 

The Business Data model undergoes changes; how does this incremental change get applied 
to the existing model?

Modified data model can be uploaded into the system and OFSAAI has the ability to 
compare the changes within the data model with respect to the one already present in the 
system and enables propagation of incremental changes in a consistent manner.

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also by 
picking up the data model from the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

The OFSAAI "configuration schema" password can be modified post installation. OFSAAI 
application stores the password in the database and few configuration files, thus any 
changes to the "configuration schema" password would necessitate updating in these. 
Contact OFSAAI support for more details.

Can the OFSAAI "Atomic  Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the 
atomic schema password in the database and few configuration files , thus any change to 
the atomic schema password would necessitate updating the password.

To change the Atomic Schema password, follow the steps:

1. Login to OFSAA.

2. Navigate to System Configuration > Database Details window. Select the appropriate 
connection, provide the modified password and save.

3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > 
Define Sources window. Update the appropriate Source details.

a. If you are using Apache Tomcat as Web server:

* Update the <Context> -> Resource tag details in server.xml file from the 
$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will 
exist).

b. If you are using WebSphere as Web server:

* Login to the WebSphere Administration Console from the left side menu.

* Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side.

* Select the appropriate Data Source and edit the connection details. (In this case, 
both Config and Atomic data sources need to be modified).

c. If you are using WebLogic as Web server:

* Login to the WebLogic Administration Console from the left side menu.

* Under Domain Structure list box, expand the appropriate Domain and navigate to 
Services > JDBC >Data Sources. A list of data sources will be populated on the 
right side.

http://docs.oracle.com/cd/E60058_01/homepage.htm
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* Select the appropriate Data Source and edit the connection details. (In this case, 
both Config and Atomic data sources need to be modified).

4. Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs displays the 
message ORA-28000: the account is locked.

 Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory settings on the 
client and server machines. Java memory setting varies with the data model size and the 
available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in User 
Interface, takes longer time to load?

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is 
continuously being updated/refreshed to cache metadata. This can be observed when you 
are starting reveleusstartup.sh and if any of the log file (Ex: SMSService.log) in 
DynamicServices.xml is being continuously refreshed for longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being 
updated beyond this limit, retrospectively the preceding entries are overwritten. For 
example, the 1001th entry is overwritten by deleting the first entry. This results in the 
application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, 
depending on the currently logged count for the specific metadata.

1. Generate the Log report by executing the below query in config schema.

select count(1), t.metadata_name, m.dsn_id

from metadata_master m, metadata_type_master t 

where m.metadata_type = t.metadata_type

group by t.metadata_name, m.dsn_id

2. The above query returns a list of codes with their respective metadata count. You can 
refer to "metadata_type_master" table to identify the metadata name.

3. View the log report to identify the metadata which is being updated/refreshed beyond 
the specified cache size limit. Accordingly increase the cache size limit in 
Dynamicservices.xml depending on the currently logged count for the specific 
metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure 
reported in log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere 
application server?

The Java memory needs to be increased in ejbdeploy.sh file which is present under 
<WebSphere Install directory>/AppServer/deploytool/itp. For example, 

$JAVA_CMD \

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \
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What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified Metadata 
Manager- Import Model, you need to configure the required model size in struts.xml 
file available in the path $FIC_WEB_HOME/webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can 
approximately set the max size to 3GB (3221225472 bytes) as indicated below, in order to 
avoid size constraints during model upload.

<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and redeploy 
the application onto your configured web application server. For more information on 
generating and deploying EAR / WAR file, see Configuring Web Application Servers.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to the 
underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying 
Hierarchy has been changed. This can occur in hierarchy maintenance, where you have 
moved a member to another hierarchy branch, and that member was explicitly selected in 
the Filter and is now a child of a node which is already selected in the Filter.

Please refer to Support Note for the workaround.

How do I turn off unused information domains (infodoms) from cache?

Follow the below steps to turn off unused infodoms from cache:

Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

1. In the DynamicServices.xml file, identify the section for <Service code="20">. 

2. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

3. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and 
redeploy the application onto your configured web application server. For more 
information on generating and deploying EAR / WAR file, see Configuring Web 
Application Servers.

4. Restart the OFSAAI Services (APP and WEB). For more information, see Chapter 6, 
"Start and Stop of Infrastructure Services".

Note: This setting will cache the Infodom metadata only for the infodoms 
that get accessed upon user login. Infodoms which do not get accessed, will 
not be cached.

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" 
NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?id=1586342.1
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=448098703264718&id=1586342.1&_afrWindowMode=0&_adf.ctrl-state=154byl0wqm_4
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<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

Can I install an Application Pack on an existing Atomic schema/ Information Domain 
created manually?

No, you cannot install an Application Pack on existing Atomic schema/Information Domain 
created manually. Application Packs can be installed only on Atomic Schemas/Information 
Domain created using schema creator utility and/ or the Application Pack installer.

When trying to view the model outputs in Model Outputs screen, I get "Exception ->Local 
Path/STAGE/Output file name (No such file or directory)".

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the 
web server details screen. This folder needs to be created under the local path on every node ,in 
case of web application server clustering.

During OFSAA services startup, I get Exception in thread "main" 
java.lang.UnsatisfiedLinkError: net (Not a directory)?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to 
a physical JRE installed.

What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model upload.



Table M–1 Optimized Memory Settings for New Model Upload

Model Upload Options
Size of Data Model XML 
File

X_ARGS_APP ENV 
Variable in OFSAAI 
APP Layer

Pick from Server 106 MB "-Xms1024m 
-Xmx1024m

36 MB "-Xms2048m 
-Xmx2048m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Model Upload Utility 106 MB "-Xms1024m 
-Xmx1024m"-Xms2048m 
-Xmx2048m

336 MB "-Xms4096m 
-Xmx4096m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Save New Erwin File In 
Server

106 MB "-Xms1024m 
-Xmx1024m

336 MB "-Xms2048m 
-Xmx2048m

"-Xms4096m 
-Xmx4096m

"-Xms6144m 
-Xmx6144m
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What is the resolution if I get the error - ORA 01792 maximum number of columns in a table 
or view is 1000 during T2T execution?

You should apply the below patch set from Oracle. Applicable only for 12c.

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1 

I did not enable OFS Inline Processing Engine Application license during the installation. 
However, I have enabled it post installation, using the Manage OFSAA Product License(s) in 
the Admin UI. Are there any other additional configurations that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration 
Guide.

I get an error when I try to build an Oracle OLAP cube. What should I do? 

Execute the below grant on the appropriate ATOMIC schema  
grant olap_user to &database_username

How do I turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.

2.  In the DynamicServices.xml file, identify the section for <Service code="20">. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

4. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and 
redeploy the application onto your configured web application server. For more 
information on generating and deploying EAR / WAR file, refer to the Post Installation 
Configuration section.

5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Starting 
Infrastructure Services section.

Note: This setting will cache the Infodom metadata only for the infodoms 
that get accessed upon user login. Infodoms which do not get accessed, will 
not be cached. 

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

"While creating an Excel Mapping, after specifying the excel worksheet, the target table, and 
mapping each column in the worksheet to a target table, I click SAVE and nothing happens. 
But when I click CANCEL, a message pops up informing me that all changes will be 
discarded", what is to be done.
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Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on 
machine. If so, upgrade the JRE plug in to 1.7+.

Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.

Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.

While setting a firewall, which ports should be opened for communication between the 
Web Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the 
Web Application Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate 
properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the web 
application port should be open.

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database 
where older versions of OFSAA is Installed?

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not 
intending to use multi language support.

Can I install already installed application in a different infodom?

No, it is not possible to install the same application in two different infodoms.

I want to configure OFSAA for High Availability that is weblogic cluster on which OFSAA.ear 
is deployed and cluster OFSAAI processes (such as Reveleus etc) are runnning.

Is this a supported confuguration?

High Availability is available for WebLogic cluster and DB level as active-active, but is not 
available on the application side. OFSAA can have active-passive high availability. For more 
details, refer Configuring OFSAA in Clustered Environment Guide.

During OFSAA installation should I provide web application server's IP /Hostname and 
port or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle HTTP 
Server/ IBM HTTP Server are configured?

In case the web server is configured, you should enter the Web Server IP Address/Hostname 
and Port details during OFSAA installation. Here the Servlet port should be same as the Web 
Server port.

If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port 
is required during the installation process. Here the Servlet port should be same as the Web 
application Server port.

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.0.0.0 and higher versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a 
change in the way agentservers are managed through AGENTSTARTUP.SH & 
AGENTSHUTDOWN.SH.

What should I do when the message server process does not open and I get the following 
error message, "CI18NProvider::CI18NProvider, Error, unable to connect to the config 
database"?

This error is displayed due to the following reasons:

•     The Config Schema password is already expired.
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•     If the config schema password is going to expire soon and the message like "ORA-28002: 
the password will expire within 6 days" displays while connecting to config schema 
through sqlplus.

•     The Config schema password is Modified.

To resolve the error, re-set the config schema password to the old password. Else, if the config 
schema password is modified to something else then follow the below steps:

1. Delete the $FIC_HOME/conf/Reveleus.SEC file.

2. Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin 
./stopofsaai.sh

3. Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin 
./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through XWindows 
software using the command: ./startofsaai.sh

5. Enter System Password.

6. Enter the new Config schema password. The service starts and initializes if it is able to 
successfully connect to the DB and generates the Reveleus.SEC file.

7. Post successful startup of the service, if required, the Infrastructure server may be shut 
down and restarted in the background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs & <OFSAAI_
DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max backup 
log files (MaxBackupIndex) retained is set to 5, both of which are configurable. Increasing 
these parameters to a higher value should depend on the server HW configurations and may 
reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:

1. Navigate to $FIC_HOME/conf where OFSAA is installed.

2. Edit the following parameters in the file RevLog4jConfig.xml

•     <param name="file" : Enter the path where the Logs are to be generated.

•     <param name="MaxFileSize" : Provide the required file size.

•     <param name="MaxBackupIndex" : Provide the required number of backup files to be 
created.

Example:

<appender name="REVSERVERAPPENDER" 
class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC_
HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>

<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>
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</layout>

</appender>

To configure the Deployed area logs file, follow these steps:

1. Navigate to <EAR/WAR Deploy area>/conf folder.

2. Repeat step 2 from the above section.

Can we modify the Log file path?

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml.default log 
file path (file) is set by the installer . This can be configured to another path.

Can I point the environment with HTTP enabled to HTTPS after installation and vice 
versa?

Follow these steps:

1. Create SSL related certificates and import to respective servers.

2. Enable SSL on a desired Port ( example 9443 ) on your existing and already deployed web 
application servers.

3. Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured and in 
all the URLs specified on below files:

•     $FIC_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and $FIC_
HOME/ficweb/webroot/conf/FICWeb.cfg

•     $FIC_HOME/ficapp/icc/conf/WSMREService.properties

•     $FIC_HOME/ficweb/webroot/conf/ModelExecution.properties

•     $FIC_HOME/ficdb/conf/MDBPublishExecution.properties

•     $FIC_HOME/ficdb/conf/ObjAppMap.properties

•     $FIC_HOME/utility/Migration/conf/WSMigration.properties

•     $FIC_HOME/utility/WSExecution/conf/WSExecution.properties

•     $FIC_
HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.ws
dl

•     $FIC_
HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

•     $FIC_
HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsd
l

4. Replace XML attribute/Node values as specified on below files:

•     $FIC_HOME/ficweb/webroot/WEB-INF/web.xml

FIC_WEBSERVER_PORT=9443

•     FIC_WEBPROTOCOL=https

$FIC_HOME/conf/LookUpServices.xml and $FIC_
HOME/ficweb/webroot/conf/LookUpServices.xml

PORT="9443"   PROTOCOL="https:"

5. Login to config schema and execute below SQL command to replace protocol and SSL 
port.



Frequently Asked Questions

M-144 Oracle Insurance Performance Application Pack                  

SQL> update configuration cn set cn.paramvalue='9443' where 
cn.paramname='SERVLET_ENGINE_PORT';

SQL> update configuration cn set 
cn.paramvalue=replace(cn.paramvalue,'http:','https:') where 
cn.paramname='FormsManagerCacheReload';

SQL> update web_server_info ws set 
ws.servletport='9443',ws.servletprotocol='https';

6. Create EAR/WAR file and Re-Deploy.

What should I do if the sliced data model upload takes a long time to complete?

If the metadata cache size is set to a lower value than the actual count of each metadata type ( 
hierarchy, dataset, dimension etc), then it gets into performance degrade issues. We have to 
increase the cache size for each metadata type according to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on the 
metadata count in your environment.

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/>

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/>

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/>

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/>

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/>

Metadata count can be derived based on the following queries:

select count(1) from metadata_master where metadata_version=0 --- for all 
metadata

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=1 --- for measure

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=2 --- for Dimension

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=3 --- for HCY

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=4 --- for DATASET

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=59 --- for BP's

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=54 --- for Alias

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=5 --- for CUBES

select count(1) from metadata_master where metadata_version=0 and 
metadata_type=856 --- for Derived Entity
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For LDAP authentication , which server connects with the LDAP server, the Application 
server (where ofsaai is installed), or Web Application server (where EAR is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP server.

The LDAP server in the setup listens on secure protocol ldaps ( port 636). I have the root 
certificate of the LDAP server for SSL, and would like to know where to offload this 
certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.

How to relocate FTPSHARE folder?

You can run the PortC.jar utility. For more details, refer Changing IP/ Hostname, Ports, 
Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide available on 
OTN.

Application Pack 8.0.0.0.0 FAQs
What is an Application pack?

An Application Pack is suite of products. For more information, refer About Oracle Financial 
Services Analytical Applications (OFSAA).

Can I get a standalone installer for OFSAAI 8.0?

No. AAI is part of every application pack and installs automatically.

How does OFSAA 8.0 Application pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack? 

There is no upgrade path available. However, we will have migration kit / path for every 
product to 8.0 application pack. Further details will be available with Oracle Support.

Does OFSAA 8.0 Application pack UPGRADE's automatically existing environments?

No.  Refer Point 5.  OFSAA 8.0 application pack has to be installed in an new environment and 
subsequently migration path / migration kit needs to be run to migrate from 7.x to 8.0.  Please 
note we will have migration path only from the previously released version of OFSAA 
products.

Where can I download OFSAA 8.0 Application Pack?

You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery Cloud 
(OSDC).

What are the minimum system and software requirements for OFSAA 8.0 Application Pack?

Refer installation guide section Hardware and Software Requirements section.

Is my environment compatible with OFSAA 8.0 Application Pack? 

Environment Check utility performs the task.  It is part of install and can also be run separately.

Has OFSAA 8.0 Application Pack is supports all Operating systems?

LINUX, AIX, SOLARIS 10, 11. Refer to Technology Matrix for the technology matrix that 
OFSAA suite products are/ will be qualified on.

How can I install OFSAA 8.0 Application Pack?

Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation And 
Configuration Guide published in OTN for the application pack installers.

Does this installation require any Third party Software's? 

https://edelivery.oracle.com/osdc/faces/Home.jspx?_afrLoop=1035460249148828&_afrWindowMode=0&_adf.ctrl-state=cibegvl3s_4
http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration 
Guide published in OTN lists the third party software that needs to be installed.

What languages are supported during OFSAA 8.0 Application Pack installation?

US English is the language supported.

What mode of installations OFSAA Application Pack supports? [i.e., Silent , GUI]

OFSAA Application Packs supports both, GUI and Silent Mode.

Does OFSAA 8.0 Application Pack support Multi tier Installations?

OFSAA 8.0 does single tier installation. For more information refer to OFSAAI FAQs section.

Does this Application Pack validate all Pre-requisites required for this installation i.e., 
Memory, Disk Space etc.?

Yes.  The pre-requisite checks are done by the respective application pack installer.  

What happens if it aborts during installation of any application with in Application pack?

Customer needs to restore the system and retrigger the installation

Does this Application pack 'Rolls Back' if any of application installation fails due to errors?

Rollback of installation is not supported.

Does the Application pack installs all applications bundled?

All application pack system files are installed but there is an option to enable the licensed 
products.

Can I re-install any of the Application Packs?

You can retrigger in case of failure.

Does Application pack allow enabling / disabling any of the applications installed?

Yes.  You cannot disable once the product is enabled in an environment.

I have installed one application in a Application pack and can I install any of new 
applications within the Application pack later point of time?

No, installation is not required.  Enabling the application is an option to use it later.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP 
installations and separate associated database instances and separate Web Server installations 
on the same server as long as adequate memory is allocated for each instance and as long as 
each OFSAAI installation is installed using a separate UNIX user and profile. Care should be 
taken if running multiple OFSAAI installations on a single server. Adequate memory will be 
required for each installation as several OFSAAI processes (model upload, DEFQ services, etc) 
take significant amounts of memory. So it depends on your server memory.

Is it possible to Install OFSAA 8.0 Application pack on any one of the existing 'Infodom' 
where another  OFSAA 8.0 application is installed?

Yes. However, the Behavioral Detection Application Pack and Compliance Regulatory 
Reporting Application pack are the exceptions. They need to be installed in a different 
INFODOM.

Can I select an Infodom in Application pack during installation?

Yes. You can select or change the required infodom. 

Can I install all Application Packs in a 'Single Infodom'?

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Yes.  But Behavioural Detection Pack and Compliance Regulatory Reporting Pack are the 
exceptions. They need to be installed in a different INFODOM.

Is it possible to install applications on different Infodom within the Application pack? (That 
is if you want to install LRM & MR in two infodoms)

Applications within application pack have to be installed in the same information domain in the 
same environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0? 
Frequently Asked Questions

You can install only one infodom during installation. But after installation, you can create 
multiple infodoms.

Is the 'Data Model' bundled specific to an Application pack or to an individual application?

A merged data model for all applications within the application pack is bundled and uploaded.

Is it possible to install OFS Enterprise Modeling later?

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any 
application pack that bundles Enterprise Modeling.

Does the Application pack create sandbox automatically for the required applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Application Pack?

Maintenance Level (ML) Release / Minor Release upgrades are available across all 
applications.

Can I upgrade AAI only?

Yes, you can upgrade AAI alone.

Can I upgrade one application within the Application Pack? i.e., LRM will be upgraded in 
Treasury Application pack, but MR won't be upgraded.

No. Not possible Upgrade is applied across packs.

Is it possible to uninstall any Application from the Application pack?

No, it is not possible to uninstall any Application from the Application Pack.

Can I uninstall entire Application Pack?

No, you cannot uninstall the Application Pack.

Is it possible to uninstall only application and retain AAI in the installed environment?

No, you cannot uninstall only the application and retain AAI in the installed environment.

Does Application Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 application packs.

Can I install an Application Pack over another Application Pack (that is same infodom or 
different infodom)?

Yes, you can install an Application Pack over another Application Pack in the same information 
domain or different information domain. But Behavioural Detection Application Pack and 
Compliance Regulatory Reporting Application Pack, Asset Liability Management Application 
Pack and Profitability Application Pack are the exceptions. They need to be installed in a 
different INFODOM.

Can I use an existing manually created schema as information domain for application pack 
installation?
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No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports 
oracle 12c with some additional configurations. Refer the link 
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for 
additional configurations.

While running the schema creator utility, I get an error "HostName in input xml is not 
matching with the local hostname"?

 One possible reason could be the machine is configured for zonal partitioning. Ensure all the 
known IP Addresses of the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS AAAI Application Pack version 8.0.0.0.0?

 OFS AAAI Application Pack supports Java 1.7.x and 1.8.x.

Is OFS AAAI Application Pack version 8.0.0.0.0 supported on Java 8?

 Yes. To install this release of the OFS AAAI Application Pack version 8.0.0.0.0 on Java 8. For 
more information, refer to specific notes mentioned in the sections Installer and Installation 
Prerequisites, Configurations supported for Java 8, Executing the Schema Creator Utility, GUI 
Mode Installation, Silent Mode Installation.

Forms Framework FAQs
What should I do when I have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large volume of 
data.

How do I export the columns added to the grid by Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field  Chooser 
option.

Error Dictionary
This contents of this section has been created with the interest to help you resolve the 
installation issues if any. There is a compilation of all the possible errors that might arise during 
the installation process with the possible cause and the resolution to quickly fix the issue and 
proceed further with the installation.

Accessing Error Dictionary
Instead of scrolling through the document to find the error code, you can use the pdf search 
functionality. In the "Find" dialog available in any of the Adobe Acrobat version that you are 
using to view the pdf document, follow the below instructions to quickly find the error 
resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.

4. Press Enter. The search results are displayed and highlighted as indicated below.

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations
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Figure 8–63 Error Dictionary

View the details of the issues, its cause, and resolution specific to the error code. Repeat the 
step to find an answer to any other errors that you notice during installation. If you are not able 
to resolve the issue even after following the steps provided in resolution, you can contact 
support.oracle.com along with log files and appropriate screen shots.

Error Code Dictionary

Cause Unix shell is not "korn" shell.

Resolution Change the shell type to "korn". Use chsh unix command to change 
SHELL type.

Shell type can also be changed by specifying shell path for the Unix user in 
/etc/passwd file.

Note: chsh command is not available in Solaris OS.

Cause No proper arguments are available.

Resolution Provide proper arguments. Invoke Setup.sh using either SILENT or GUI 
mode.

Example: ./Setup.sh SILENT or ./Setup.sh GUI

Cause File .profile is not present in $HOME.

Resolution Create .profile in $HOME, i.e. in the home directory of user.

Cause File OFSAAInfrastructure.bin is not present in current folder.

Resolution Copy OFSAAInfrastructure.bin into installation kit directory.

Cause File CustReg.DAT is not present in current folder.

Resolution Copy CustReg.DAT into installation kit directory.

8Error code - OFSAAI-1001

8Error code - OFSAAI-1002

8Error code - OFSAAI-1004

8Error code - OFSAAI-1005

8Error code - OFSAAI-1006

support.oracle.com
support.oracle.com
support.oracle.com


Cause File OFSAAI_InstallConfig.xml is not present in current folder.

Resolution Copy OFSAAI_InstallConfig.xml into installation kit directory.

Cause File validateXMLInputs.jar is not present in current folder.

Resolution Copy validateXMLInputs.jar into installation kit directory.

Cause File log4j.xml is not present in current folder.

Resolution Copy log4j.xml into installation kit directory.

Cause Unknown error occurred.

Resolution Make sure to provide proper argument (SILENT or GUI) to the Setup.sh 
file.

Cause XML validation failed.

Resolution Check InfrastructurePreValidations.Log for more details.

Cause Property file with locale name does not exist.

Resolution Copy MyResources_en_US.properties to the setup kit directory and 
keep en_US in LOCALE tag of OFSAAI_InstallConfig.xml.

Cause File OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 
not found.

Resolution Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 
to the setup kit directory.

Cause XML node value is blank.

Resolution Make sure all node values except SMTPSERVER, PROXYHOST, 
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD, 
NONPROXYHOST, or RAC_URL are not blank.
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8Error code - OFSAAI-1007

8Error code - OFSAAI-1008

8Error code - OFSAAI-1009

8Error code - OFSAAI-1010

8Error code - OFSAAI-1011

8Error code - OFSAAI-1012

8Error code - OFSAAI-1013

8Error code - OFSAAI-1014



Cause XML is not well formed.

Resolution Execute the command dos2unix OFSAAI_InstallConfig.xml to 
convert plain text file from DOS/MAC format to UNIX format.

OR

Make sure that OFSAAI_InstallConfig.xml is valid. Try to open the file 
through Internet Explorer for a quick way to check validity. If it is not 
getting opened, create new OFSAAI_InstallConfig.xml using the XML_
Utility.jar.

Cause User installation directory contain blank spaces.

Resolution Provide an installation path that does not contain spaces. Check the tag 
USER_INSTALL_DIR in OFSAAI_InstallConfig.xml file. This path 
should not contain any spaces.

Cause User installation directory is invalid.

Resolution Provide a valid installation path. Check if you are able to create the 
directory mentioned in USER_INSTALL_DIR tag value of OFSAAI_
InstallConfig.xml file.
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8Error code - OFSAAI-1015

8Error code - OFSAAI-1016

8Error code - OFSAAI-1017
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